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Preface

Important Safety Warnings

WARNING! Avoid Electrical Shocks. To avoid electrical shock, do not open the power supplies. There 
are no user-serviceable parts inside. 

To avoid electrical shock and harm to your eyes by laser light, do not open the DVD laser module. The 
laser module should be serviced by service personnel only. Do not attempt to make any adjustment to 
the laser unit. Refer to the label on the DVD for power requirements and wavelength. This product is a 
class I laser product.

WARNING! Grounding your Equipment. For your safety always connect the equipment to a grounded 
wall outlet. Always use a power cord with a properly grounded plug, such as the one provided with the 
equipment, or one in compliance with your national safety standards. This equipment can be 
disconnected from the power by removing the power cord from the power outlet. This means the 
equipment must be located close to an easily accessible power outlet.

WARNING! Protecting your Ears. If your system is a multimedia model, or if you have installed a sound 
card in your system, always turn the volume down before connecting the headphones or speakers. This 
prevents discomfort from unexpected noise or static. Listening to loud sounds for prolonged periods of 
time may permanently damage your hearing. Before putting on headphones, place them around your 
neck and turn the volume down. When you put on the headphones, slowly increase the volume until you 
find a comfortable listening level. When you can hear comfortably and clearly, without distortion, leave 
the volume in that position.

WARNING! Removing and Replacing the Cover. For your safety, never remove the system side cover 
without first disconnecting the power cord from the power outlet and removing any connection to a 
telecommunications network. If a Power Protection Device is fitted to your system, you must shut down 
your computer using its on/off switch, then remove the power cord before removing the system’s side 
cover. Remove the Power Protection Device cables before any servicing operation. Always replace the 
side cover before switching the system on again.
IMPORTANT SAFETY WARNINGS IX



WARNING! Battery Safety Information. There is a danger of explosion if the battery is incorrectly 
installed. For your safety, never attempt to recharge, disassemble, or burn an old battery. Replace the 
battery with the same or equivalent type, as recommended by the manufacturer. 

The battery in this system is a lithium battery that does not contain any heavy metals. However, to 
protect the environment, do not dispose of batteries in household waste. Return used batteries either to 
the shop from which you bought them, to the dealer from whom you purchased your system, or to HP so 
that they can either be recycled or disposed of in the correct way. Returned batteries will be accepted 
free of charge.

WARNING! Metallic particulates can be especially harmful around electronic equipment. This type of 
contamination may enter the data center environment from a variety of sources, including, but not limited 
to, raised floor tiles, worn air conditioning parts, heating ducts, rotor brushes in vacuum cleaners or 
printer component wear. Because metallic particulates conduct electricity, they have an increased 
potential for creating short circuits in electronic equipment. This problem is exaggerated by the 
increasingly dense circuitry of any electronic equipment.

Over time, very fine whiskers of pure metal can form on electroplated zinc, cadmium, or tin surfaces. If 
these whiskers are disturbed, they may break off and become airborne, possibly causing failures or 
operational interruptions. For over 50 years, the electronics industry has been aware of the relatively 
rare, but possible, threat posed by metallic particulate contamination. During recent years, a growing 
concern has developed in computer rooms where these conductive contaminants are formed on the 
bottom of some raised floor tiles. 

Although this problem is relatively rare, it may be an issue within your computer room. Since metallic 
contamination can cause permanent or intermittent failures on your electronic equipment, Hewlett-
Packard strongly recommends that your site be evaluated for metallic particulate contamination before 
installation of electronic equipment. 

WARNING! Avoid Burn Injuries. Some parts inside the computer will be hot. Turn off and unplug the 
system, then wait approximately three to five minutes for them to cool down before opening the system 
access panels or touching internal components.

WARNING! if you have a modem:

Do not attempt to connect this product to the phone line during a lightning storm. Never install telephone 
jacks in wet locations unless the telephone line has been disconnected at the network interface. Never 
touch uninsulated telephone wires or terminals unless the telephone line has been disconnected at the 
network interface. Use caution when installing or modifying telephone lines. Avoid using a telephone 
(other than a cordless type) during an lightning storm. There may be a risk from lightning.

Do not use the telephone to report a gas leak in the vicinity of the leak.

Never touch or remove the communications board without first removing the connection to the telephone 
network.
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CAUTION Avoid Static Electricity. Static electricity can damage electronic components. Turn OFF all 
equipment and disconnect the power cable before installing an accessory card. Do not let your clothes 
touch any accessory card. Handle the card as little as possible and with care.

CAUTION Information on Ergonomic Issues. It is strongly recommended that you read the ergonomics 
information in the Safety and Comfort Guide on the Documentation Library CD before using your system. 
You can access more extensive ergonomics information at: http://www.hp.com/ergo.

NOTE Recycling Your System. HP has a strong commitment toward the environment. Your HP system 
has been designed to respect the environment as much as possible. HP can also take back your old 
system for recycling when it reaches the end of its useful life. HP has a product take-back program in 
several countries. The collected equipment is sent to an HP recycling facilities in Europe or the U.S.A. 
As many parts as possible are reused. The remainder is recycled. Special care is taken for batteries and 
other potential toxic substances, these are reduced into non-harmful components through special 
chemical processes. If you require more details about the HP product take-back program, contact your 
local dealer or your nearest HP Sales Office.

Updating BIOS, Drivers, and Software
HP continually strives to implement new enhancements that will increase functionality, performance, and 
reliability of your HP Workstation. To ensure that your workstation takes advantage of the latest 
enhancements, HP recommends that you install the latest BIOS, driver, and software updates on a 
regular basis. 

To download available updates from the HP Web site:

Go to www.hp.com/go/bizsupport 

Or

Click Start>Help & Support Center. Then, click the HP Software & Drivers Download icon, select 
your operating system, and review or select available updates.

Finding Information

E-Support
For online access to technical support information and tools, go to http://www.hp.com/support. Support 
resources include web-based troubleshooting tools, technical knowledge databases, driver and patch 
downloads, online communities, and proactive notification services.

The following sites are also available to you.

http://www.hp.com—Provides useful product information.

http://www.hp.com/support/workstation_manuals—Provides the latest online documentation.
UPDATING BIOS, DRIVERS, AND SOFTWARE XI
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http://welcome.hp.com/country/us/eng/wwcontact.html—Provides a listing of the worldwide 
technical support phone numbers.

Additional Documentation
Refer to the Documentation Library CD for additional product information in PDF format. The CD 
contains the following:

Getting Started (available in print and PDF on library CD)
Helps you set up hardware and factory-provided software; also includes basic troubleshooting 
information should you encounter any problems during initial startup. 

Safety and Comfort Guide (PDF on library CD)
Provides safety and ergonomic information to assist you in setting up a safe and comfortable 
workstation environment.

Safety & Regulatory Information Guide (PDF on library CD)
Provides safety and regulatory information that ensures compliance with U.S., Canadian, and various 
international regulations.

Helpful links
The following links can also be accessed for additional information:

Product Bulletin—The product bulletin contains the QuickSpecs and is available at:

http://h18000.www1.hp.com/products/quickspecs/productbulletin.html
For information about the Microsoft® Windows® operating system:
http://www.microsoft.com

For information about the Linux operating system:
http://www.redhat.com

Additional product information is available from the HP website at http://www.hp.com/go/
workstations.

Using the Documentation Library CD
To access the contents of the Documentation Library CD follow the steps that are applicable to your 
workstation.

Windows-Based Workstations

Insert the CD into the CD-ROM drive. The CD Autorun feature begins.

If there is no CD-ROM drive activity for two minutes or more, the Autorun feature might not be enabled 
on the workstation. To run the CD:

1 Click Start>Run. 

2 In the text box, enter:

X:\index.htm 

(where X is the drive letter designator for the CD-ROM drive)

3 Click OK.
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Linux-Based Workstations

If the workstation is running a Linux operating system, browse the CD and click the index.htm file to 
launch the CD interface. To view the documents on the CD, download and install Adobe® Acrobat® 
Reader for Linux from http://www.adobe.com.

Locating Regulatory Information
Refer to the Safety & Regulatory Information guide on the Documentation Library CD for product class 
information. You can also refer to the label on the rear of the chassis.

Parts and Accessories
For complete and current information on supported accessories and components, visit 
http://partsurfer.hp.com

Subscriber’s Choice
Subscriber’s Choice, an HP program, allows you to sign up to receive driver and software alerts, 
proactive change notifications (PCNs), the HP newsletter, and more. Sign up today at
http://www.hp.com/go/subscriberschoice 
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Chapter 1 Product Overview

This chapter presents an overview of the hardware components of the HP Workstation. 

“Product Features” on page 16

“Product Specifications” on page 19

“Power Supply and Cooling” on page 20

“Environmental Specification” on page 23

“PCI and PCI Express Slot Power Specifications” on page 23

“ENERGY STAR” on page 24

“Hyper-Threading Technology” on page 25
15



Product Features

Exploded View

The following image shows a typical HP Workstation xw6200. Drive configurations can vary.

For complete and current information on supported accessories and components, visit
http://partsurfer.hp.com.

Table 1-1 Exploded View

1 CPU Heatsinks 6 Front Bezel 11 Hard Drive

2 Memory Module 7 Chassis 12 Access Panel

3 Power Supply 8 System Board 13 Processors

4 Top Cover 9 System Speaker 14 System Fans

5 Optical Drive* 10 PCI-E (graphics)

*An optical drive is a CD-ROM, CD-R/RW, DVD-ROM, DVD+R/RW, or CD-RW/DVD combo drive.

21 3 4
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Front Panel Components
The following image shows a typical HP Workstation xw6200. Drive configurations can vary.

Table 1-2 Front Panel View

1 Optical Drive Eject Button 5 Power Button 9 Microphone Connector

2 5.25-Inch Drive Bay 6 Hard Drive Activity Light 10 IEEE-1394 Connector**

3 Diskette Drive (optional) 7 Universal Serial Bus (USB) 11 Optical Drive Activity Lights

4 Power On Light 8 Headphone Connector 12 Optical Drive*

*An optical drive is a CD-ROM, CD-R/RW, DVD-ROM, DVD+R/RW, or CD-RW/DVD combo drive.

**IEEE-1394 is an optional feature. If the workstation was purchased without this option, then this connector will be covered.

12
1
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4
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Rear Panel Components

Table 1-3 Rear Panel Components

1 Universal Chassis Clamp Lock Hole 9 Graphics Adapter

2 Padlock Loop 10 Cable Lock Slot

3 Access Panel Key 11 Microphone Connector (pink)

4 PS/2 Mouse Connector (green) 12 USB Ports (x6)

5 Parallel Connector (burgundy) 13 Serial Connector (teal)

6 RJ-45 Network Connector 14 PS/2 Keyboard Connector (purple)

7 Audio Line-In Connector (light blue) 15 Built-In Self Test (BIST) LED 

8 Audio Line-Out Connector (lime) 16 Power Cord Connector

NOTE: To assist you in connecting your peripheral devices, the rear panel connectors are labeled and color-coded according to 
industry standard.

11
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Serial Number and COA Label Location
Each workstation has two unique serial number labels. Systems preinstalled with Windows XP also have 
a certificate of authentication (COA) label 2. The serial number labels 1 are located on the side panel of 
the unit and on the rear panel. Keep this number available when contacting customer service for 
assistance.

Product Specifications
The following table lists the physical dimensions.

1

1

2

Table 1-4 Physical Characteristics

Weight
(typical configuration)

16kg (35 lb)

Tower Dimensions 441 mm (17.4 in.) tall
165 mm (6.5 in.) wide
440 mm (17.3 in.) deep

Rack Mount Dimensions
(top cover and foot removed)

165 mm (6.5 in.) tall <4U
425mm (16.75 in.) fits in standard 19 in. rack.
440 mm (17.3 in.) deep
PRODUCT SPECIFICATIONS 19



Power Supply and Cooling
The workstation has 8 outputs:

+3.3V—used with PCI, MCH, ICH5, PXH, LAN, SATA hard drives, and on-board logic 

+5V—used with storage (disk, optical, diskette), PCI, Audio, USB, and on-board logic

+12V-A—used with PCI, fans, input to onboard regulators that supply 1.2V, 1.5V, and 1.8V

+12V-B—used with storage (disk, optical, floppy), PCI Express x16 auxiliary connector

+12VCPU0—input to onboard regulator that supplies power for CPU0

+12VCPU1—input to onboard regulator that supplies power for CPU1

-12V—used by PCI

5VSB—used for sleep circuitry

Table 1-5 Power Supply and Cooling (Voltage)

Voltage Minimum Maximum

3.3 V 3.17 V 3.47 V

5 V 4.85 V 5.25 V

12 VCPU0 11.52 V 12.6 V

12 VCPU1 11.52 V 12.6 V

12 V-A 11.52 V 12.6 V

12 V-B 11.52 V 12.6 V

V12N -11.4 V -12.6 V

5 VSB 4.85 V 5.25 V

Table 1-6 Power Supply and Cooling (Current)

Current Minimum Operating Continuous Maximum

3.3 V 0 A 3.1 A 23 A 31.0 A

5 V 0 A 2.3 A 18 A 23.0 A

12 VCPU0 0 A 3.1 A 11.4 A 13.7 A

12 VCPU1 0 A 0 A 11.4 A 13.7 A

12 V-A 0 A 0 A 13.7 A 17.0 A

12 V-B 0 A 0 A 13.7 A 14.0 A

V12N 0 A 0 A 0.5 A 0.8 A
20 PRODUCT OVERVIEW
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WARNING! Do not exceed 110 W of a 5 V and 3.3 V power combination. 

WARNING! Do not exceed 456 W of 12 V (CPU0/CPU1/A/B) power combination. 

WARNING! Do not exceed 182.4 W of a 12 V (A and B) power combination. 

WARNING! Do not exceed 500 W of total continuous output power.

Power Supply Specifications

5 VSB 0 A 0 A 2 A 2 A

Table 1-7 Power Supply Specifications

Full Ranging Input (No Line Select Switch) Yes

Active Power Factor Correction (APFC) (Input Current is nearly 
1/2 a non-APFC PS)

Yes

Passive Power Factor Correction (PFC) No

Operating Voltage Range 90 - 264 VAC / 118 VAC

Rated Voltage Range 100 -240 VAC

Rated Line Frequency 50-60 Hz / 400Hz

Operating Line Frequency Range 47 - 66 Hz / 393 - 407Hz

Rated Input Current 9A / 9A

Maximum Rated Power 500 W

Heat Dissipation Typical 1228.9 btu/hr
Maximum 2625.4 btu/hr

Power Supply Fan 92mm variable speed

PS Size (wide x high x deep) 97.8mm x 149.9mm x168.10mm

ENERGY STAR compliant Yes

FEMP Standby Power Compliant(<2W in S5 - Power Off) No

Table 1-6 Power Supply and Cooling (Current)

Current Minimum Operating Continuous Maximum
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Power Consumption and Cooling 
The following table shows the power consumption for a typical configuration (based on primary power 
consumptions):

Two processors (2x3.6GHz Xeon)

1 GB memory (2x512 MB)

Two hard drives (2xSATA 40 GB)

DVD-ROM drive

PCI Express graphics card (FX1300)

Diskette drive

One monitor

a. Approximate values

NOTE When you turn off your workstation with the power button on the front panel, the power 
consumption falls below 10 W. To reach zero power consumption, either unplug the workstation from the 
power outlet or use a power strip with a switch. 

For additional information on power-saving features, refer to your operating system documentation.

System Fans and Airflow
The workstation includes two rear system fans, one CPU heatsink fan for each processor (CPU), plus 
optional front system fans.

BIST LED Yes

Surge Tolerant Full Ranging Power Supply Withstands power surges up to 2000V

Table 1-8 Power Consumption and Cooling

Input Power Consumptiona @ 120Vac/60Hz

Typical operating mode 360 W = 1228.9 btu/hr

Windows XP Idle 201 W = 685.9 btu/hr

Hibernate mode (S4) 6.4 W = 21.84 btu/hr

Power Off (S5) 6.4 W = 21.84 btu/hr

Table 1-7 Power Supply Specifications
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Resetting the Power Supply
If an overload triggers the power supply overload protection, all power is immediately cut. To reset the 
power supply unit:

1 Disconnect the power cord.

2 Determine what caused the overload and fix the problem.

3 Reconnect the power cord and reboot the workstation.

When you power down the workstation through the operating system, power consumption falls below the 
low power consumption but does not reach zero. This on/off feature extends the life of the power supply.

Environmental Specification 

PCI and PCI Express Slot Power Specifications

The following table describes the slots, card types, and maximum slot power.

Table 1-9 Environmental Specifications

Temperature (operating) 40° to 95° F (5° to 35° C)

Temperature (non-operating) -40° to 140° F (-40° to 60° C)

Humidity (operating) 8% to 85% RH, non-condensing

Humidity (non-operating) 8% to 90% RH, non-condensing

Shock (operating) 1/2-sine: 40G, 2–3ms

Shock (non-operating) 1/2-sine: 160 cm/s, 2–3ms, (~100g)
square: 20G, 422 cm/s

Vibration (operating) Operating random: 0.5G(RMS), 5–300Hz

Vibration (non-operating) Random: 2.0g(RMS), 10–500Hz

Maximum Altitude (operating) 0–10,000 ft (3,048 m)

Maximum Altitude (non-operating) 0–30,000 ft (9,144 m)

Table 1-10 PCI and PCI Express Slot Power Specifications

Slot# Slot Type Slot Power (Maximum)

1 PCI Express x16 graphics 150 W**

2 PCI 25 W*

3 PCI 25 W*
ENVIRONMENTAL SPECIFICATION 23



NOTE If a graphics card requiring more than 75W is installed, HP recommends not using slot 2, which is 
the PCI slot adjacent to the graphics slot. In addition to these slot power specifications, the overall power 
consumption of the system (including I/O cards, processors, memory, drives) must not exceed the 
maximum ratings of the system power supply.

For hardware specifications of other system components, such as graphics cards or optical drives, refer 
to the website of the specific manufacturer.

ENERGY STAR
The ENERGY STAR® program, a government-backed initiative, promotes energy efficiency by 
identifying ways to reduce energy consumption. Select HP workstations participate in the ENERGY 
STAR program.

NOTE ENERGY STAR is not supported on Linux-based workstations.

For those workstations that support ENERGY STAR and have it enabled, the power management 
features will be set as follows:

Monitor—goes into sleep mode after 20 minutes of inactivity.

System—goes into Hibernate mode after 25 minutes of inactivity.

Hard Drive—goes into power savings mode after the system goes into Hibernate mode.

NOTE If you have to restore the operating system, reset the ENERGY STAR settings (if applicable) after 
the restore.

To verify the factory default power settings for your product, select Start>Control Panel and double-click 
Power Options.

ENERGY STAR Compliance
HP products purchased with the ENERGY STAR configuration are compliant with the U.S. 
Environmental Protection Agency (EPA) ENERGY STAR Computers Program. The EPA ENERGY STAR 

4 PCI 25 W*

5 PCI 25 W*

6 PCI Express x8’ (x4 performance) 25 W*

* In addition to these slot power specifications, the overall power consumption of the system (including I/O 
cards, processor, and memory) must not exceed the maximum ratings of the system power supply.
** Includes 75W maximum from the system board connector, and 75W maximum from the auxiliary graphics 
power connector.

Table 1-10 PCI and PCI Express Slot Power Specifications

Slot# Slot Type Slot Power (Maximum)
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configuration does not imply endorsement by the EPA. As an ENERGY STAR Partner, HP has 
determined that products with the ENERGY STAR configuration meet the ENERGY STAR guidelines 
for energy efficiency.

The ENERGY STAR Computers Program was created by the EPA to promote energy efficiency and 
reduce air pollution through more energy-efficient equipment in homes, offices, and factories. HP 
products achieve this by reducing the power consumption when not being used.

ENERGY STAR on HP Workstations uses ACPI power management. The system can wake as a result 
of a user action (keyboard or mouse) or from the network or a modem.

The Power Management feature, when used in conjunction with an external ENERGY STAR-compliant 
monitor, will support the power-down features of the monitor. The Power Management feature allows an 
external monitor to go into low-power mode when the energy save timeout occurs.

CAUTION Using the Energy Save Monitor feature with non-ENERGY STAR-compliant monitors might 
cause video distortion when the Energy Save timeout occurs.

Hyper-Threading Technology
Hyper-Threading Technology, developed by Intel®, enables a single processor to execute multiple 
threads of instructions simultaneously. Hyper-Threading Technology enables the processor to utilize its 
execution resources more efficiently, delivering performance increases and improving user productivity. 
Not all systems benefit from the Hyper-Threading Technology.

To see if Hyper-Threading Technology can benefit you, test your system by turning the feature on. To do 
this, run Computer Setup (F10) during the boot process and select Advanced>Processors>Hyper-
Threading, and enable the Hyper-Threading Technology.

NOTE The Hyper-Threading Technology is recommended for use with Windows XP systems. This 
technology is detected by the system and is turned on in the operating system after it is enabled in the 
system BIOS.

NOTE The Hyper-Threading Technology is not recommended for use with Windows 2000-based 
workstations.

NOTE With the release of Red Hat Enterprise Linux WS 3.0, Hyper-Threading Technology is compatible 
with Linux-based systems. Before this technology can be enabled, an SMP kernel must be installed on 
your system.

For more information about the Hyper-Threading Technology, visit the Intel website at 
http://www.intel.com.
HYPER-THREADING TECHNOLOGY 25

www.intel.com


26 PRODUCT OVERVIEW



C
ha

pt
er

 2
Chapter 2 Installing or Restoring the 
Operating System

This chapter describes the installation and restoration of the operating system. 

“Installing the Operating System and Software” on page 28

“Restoring the Operating System” on page 31

“Protecting the Software” on page 31

“Ordering Backup Software” on page 32

If the workstation was shipped with a preinstalled OS, it is configured automatically the first time the 
workstation is turned on.

CAUTION Adding optional hardware devices to your workstation before the operating system 
successfully installs can cause errors and prevent the operating system from installing properly.

CAUTION After the automatic installation has begun, DO NOT TURN OFF THE WORKSTATION UNTIL 
THIS PROCESS COMPLETES. Turning off the workstation during the installation process might 
damage the software that runs the system.
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Installing the Operating System and Software
The following section discusses the operating system and HP software installation procedures.

Microsoft Windows XP Professional
The first time you turn on your workstation, you are prompted to select a language for the operating 
system. After selecting the language, read and follow the instructions on the screen to complete the 
installation of the operating system. This takes approximately 10 minutes, depending on the system 
hardware configuration. During the process, do not turn off your workstation unless you are directed to 
do so.

Installing or Upgrading Device Drivers

To install hardware devices, such as a printer, a display adapter, or network adapter after the operating 
system installation is completed, the operating system needs access to the appropriate software drivers 
for the devices. Device drivers are usually provided on a CD supplied with the peripheral device.

Some existing peripheral devices might not have been shipped with drivers developed for Windows XP. 
To locate the most current device drivers, visit http://www.hp.com/go/workstationsupport.

Creating a Restore Diskette

To create a restore diskette for Windows XP, select Start>Programs>Accessories>System 
Tools>System Restore and follow the on-screen instructions.

Linux-Preinstalled Workstations
If you have a Linux-preinstalled workstation, follow the instructions in this section to set up your OS and 
software.

After the boot process completes, you can view additional HP Linux documentation by opening your 
Internet browser (the browser is automatically set to use the local HP documentation page as its default). 
You can also access Linux Web links for Red Hat (Internet access required) by using your Internet 
browser.

NOTE For additional information concerning the setup of Linux-preinstalled or Linux-enabled 
workstations, refer to the HP User Manual for Linux, which is located at http://www.hp.com/support/
linux_user_manual.

For more information about HP and Linux, visit http://www.hp.com/linux.

Starting Up the Linux Operating System

The first time the workstation is booted, the Red Hat First Boot utility displays. This program enables you 
to enter your password, network, graphics, time, and keyboard settings for your workstation.

CAUTION After the automatic installation has begun, DO NOT TURN OFF THE WORKSTATION UNTIL 
THE PROCESS IS COMPLETE. Turning off the workstation during the installation process might 
damage the software that runs the workstation or prevent its proper installation.
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NOTE When you enable the YPBind feature in the Network tab of the Linux Setup Tool, you might get a 
blank screen for about 15–30 seconds after you have selected and saved all of your settings and have 
exited the utility. This is normal. The boot process continues its execution after the screen returns.

Restoring the Linux Operating System

NOTE To restore the Linux OS, the HP Driver CD and Red Hat box set are required.

Download the latest HP Driver CD to get any new enhancements.

NOTE Linux does not support mixed drive types for a manufacturing preload. When restoring the 
operating system, mixed drive types can be handled with the restoring media.

DOWNLOADING THE LATEST HP DRIVER CD

To download the latest HP Driver CD:

1 Download the ISO image to a local hard drive from the HP support website for the appropriate 
workstation platform (such as http://www.hp.com/support/xw6200).

a Click the download drivers and software link.

b Select the Linux OS that matches your box set.

c Select the latest version from the Utility Tools section.

d Download and unpack it (tar zxvf filename.tgz).

2 Copy the ISO image to CD-R bootable media. On another Linux workstation, use the cdrecord utility. 
Identify the device address for the CD burner (cdrecord --scanbus).
The default is usually 2, 0, 0.

Example:
cdrecord -v -eject dev=2,0,0 CD0_golden.iso

INSTALLING WITH THE HP DRIVER CD

To install with the HP Driver CD:

1 Boot the workstation from the Red Hat box set Binary CD 1.

2 Insert the Linux operating system CDs from the Red Hat box set as prompted.

3 Continue following the prompts until the operating system is successfully installed.

4 Configure the X server to start on reboot.

5 Reboot the workstation.

6 Follow the prompts to set up your system with the Red Hat First Boot utility.

7 When prompted in First Boot to add additional CDs, insert the HP Driver CD into the CD-ROM tray of 
the workstation.
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8 Click Install next to “Additional CDs.”
The HP Driver CD window opens.

9 Click Press to begin install...

10 When the install is done, you will have two options, “Reboot now...” on the left side and “Press to 
continue, reboot later...” on the right side.

11 Click Reboot now...

Upgrading Device Drivers

If you must upgrade a Linux device driver, visit the HP website at http://www.hp.com/go/
workstationsupport.

Linux-Enabled Workstations
Linux-enabled workstations are not preinstalled with Linux. They require the HP Installer Kit for Linux 
and the purchase of a Red Hat box set. The Installer kit includes the HP CDs necessary to complete the 
installation of all versions of the Red Hat box set that have been verified to work on HP workstation 
hardware.

Verifying Hardware Compatibility

To see which Linux versions have been verified to work on HP workstation hardware:

1 Go to http://www.hp.com/support/workstation_manuals.

2 Select your HP workstation model.

3 Click the Hardware Support Matrix for Linux link.

Installing the Linux Operating System

To install the Linux operating system on your Linux-enabled system:

1 Follow the instructions for “Restoring the Linux Operating System” in the previous section.

2 Follow the instructions for “Starting Up the Linux Operating System” in the previous section.

NOTE For more information concerning the setup of Linux-preinstalled or Linux-enabled workstations, 
refer to the HP User Manual for Linux, which is located at http://www.hp.com/support/
linux_user_manual.

For more information about HP and Linux, visit http://www.hp.com/linux.

Upgrading Device Drivers

If you must upgrade a Linux device driver, visit the HP website at http://www.hp.com/go/
workstationsupport.
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HP Software
The following HP software will also be installed the first time the workstation is turned on:

Computer Setup (F10) Utilities and diagnostic features

HP Support Software including device drivers

HP Client Manager Software (available for download from http://www.hp.com/go/EasyDeploy)

System Software Manager (available for download from http://www.hp.com/go/ssm)

Power Management Setup with energy saver features (not supported for Linux)

Security Management tools

Software Support Management tools

Certain drivers and utilities are available only in selected languages. You can obtain the latest version of 
these files, in English and selected other languages, in one of four ways:

Support Software CD

HP website at http://www.hp.com

Restore Plus! CD, which is supplied with Windows-based workstations

HP Workstations Red Hat Linux with HP Additions CD, which is supplied with Linux-based 
workstations

NOTE Additional HP software might be required in certain situations.

Restoring the Operating System
Restore the original Microsoft Windows XP Professional operating and factory-installed software by 
using the Restore Plus! CD and the OS CD that came with the workstation. Carefully read and follow the 
instructions provided with the Restore Plus! CD.

For more information about restoring the Linux OS or software, see “Restoring the Linux Operating 
System” in this chapter.

Protecting the Software
To protect software from loss or damage, keep a backup copy of all system software, applications, and 
related files stored on the hard drive. See the operating system or backup utility documentation for 
instructions on making backup copies of data files.
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Ordering Backup Software
All software that shipped with the workstation, including the Restore Plus! CD, can be ordered from HP 
as a single set, or you can order the various software packages separately.

NOTE Before calling HP to order the software, be sure to have the serial number of the workstation 
available. See the “Serial Number and COA Label Location” section on page 19.
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Chapter 3 System Management

This section describes the various tools and utilities that allow for the system management of the 
workstation.

“Computer Setup (F10)” section on page 34

“Desktop Management” section on page 42
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Computer Setup (F10)
The Computer Setup (F10) utilities enable you to:

Change factory default settings and set or change the system configuration, which might be 
necessary when you add or remove hardware.

Determine if all of the devices installed on the workstation are recognized by the system and 
functioning properly.

Determine information about the operating environment of the workstation.

Solve system configuration errors detected but not automatically fixed during the Power-On Self-Test 
(POST).

Establish and manage passwords and other security features.

Establish and manage energy-saving timeouts (not supported for Linux platforms).

Modify or restore factory default settings.

Set the system date and time.

Set, view, change, or verify the system configuration, including settings for processor, graphics, 
memory, audio, storage, communications, and input devices.

Modify the boot order of bootable devices, such as hard drives, diskette drives, optical drives, or LS-
120 drives.

Configure the boot priority of SATA, IDE (ATA), and SCSI hard drive controllers.

Enable Quick Boot, which is faster than Full Boot but does not run all of the diagnostic tests run 
during a Full Boot. You can set your system to:

always Quick Boot (default)

periodically Full Boot (from every 1 to 30 days)

always Full Boot

Enable or disable Network Server Mode, which enables the workstation to boot the operating system 
when the power-on password is enabled with or without a keyboard or mouse attached. When 
attached to the system, the keyboard and mouse remain locked until the power-on password is 
entered.

Select POST Messages Enabled or Disabled to change the display status of POST messages. POST 
Messages Disabled suppresses most POST messages, such as memory count, product name, and 
other non-error text messages. If a POST error occurs, the error is displayed regardless of the mode 
selected. To manually switch to POST Messages Enabled during POST, press any key (except F1 
through F12).

Establish an Ownership Tag, the text of which is displayed each time the system is turned on or 
restarted.

Enter the Asset Tag or property identification number assigned by your company to this workstation.

Enable power-on password prompting during system restarts (warm boots) as well as during power-
on.

Secure the integrated I/O functionality, including the serial, USB, or parallel ports, audio, or 
embedded NIC, so that the I/O functionality cannot be used until they are unsecured.

Enable or disable Master Boot Record (MBR) Security.
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Enable or disable removable media boot ability.

Enable or disable removable media write ability (when supported by hardware).

Solve system configuration errors detected, but not automatically fixed, during the POST.

Replicate your system setup by saving system configuration information on diskette and restoring it 
on one or more workstations.

Execute self-tests on specified SATA and IDE (ATA) hard drives (when supported by the drive).

BIOS ROM
The Basic Input/Output System (BIOS) of the computer is a collection of machine language programs 
stored as firmware in read-only memory (ROM). The BIOS ROM includes such functions as POST, PCI 
device initialization, Plug 'n Play support, power management activities, and the Setup utility. The 
firmware contained in the BIOS ROM supports the following systems and specifications:

Microsoft WHQL

Alert-On-LAN (AOL) and Wake-On-LAN (WOL)

ACPI 1.0 and 2.0 and OnNow

SMBIOS 2.3.5

PC98/99/00 and NetPC

Intel PXE boot ROM for the integrated LAN controller

BIOS Boot Specification 1.01

Enhanced Disk Drive Specification 3.0

“El Torito” Bootable CD-ROM Format Specification 1.0

ATAPI Removable Media Device BIOS Specification 1.0

MPS Specification 1.4 (for booting Linux SMP)

The BIOS ROM is a 1-MB Intel Firmware Hub (or Firmware Hub-compatible) part. The runtime portion of 
the BIOS resides in a 128-K block from EA000h to FFFFFh (approximation).

Using Computer Setup (F10)
You can only open Computer Setup by turning on the workstation or restarting the system. To access the 
Computer Setup Utilities menu:

1 Turn on or restart the workstation. 

2 Press the F10 key as soon as the monitor light turns green.

NOTE If you do not press the F10 key at the appropriate time, you must try again. Turn the workstation 
off, then on again, and press the F10 key again to access the utility.

3 Select your language from the list and press Enter. In the Computer Setup Utilities menu, four 
headings are displayed: File, Storage, Security, and Advanced.

4 Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and down) 
keys to select the option you want, then press Enter.
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5 To apply and save changes, select File>Save Changes and Exit.

If you have made changes that you do not want applied, select Ignore Changes and Exit.

To reset to factory settings, select Set Defaults and Exit. This option restores the original factory 
system defaults.

CAUTION Do NOT turn the workstation power OFF while the ROM is saving your Computer Setup F10 
changes because the CMOS could become corrupted. After you exit the F10 Setup screen, it is safe to 
turn off all power to the workstation.
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Computer Setup Menu

NOTE The following content is subject to change with new firmware releases, so your menu may be 
different than shown below.

Table 3-1 Computer Setup Menu Descriptions

Heading Option Description

File System 
Information

Lists product name, processor type/speed/stepping, cache size (L1/L2), system ROM family and 
version, installed memory size, chassis serial number, integrated MAC for enabled or embedded 
NIC (if applicable), and asset tracking number.

About Displays copyright information.

Set Time and 
Date

Enables you to set system time and date.

Save to 
Diskette

Saves system configuration, including CMOS, to a formatted, blank 1.44-MB diskette in the 
CPQsetup.txt file. Save/Restore for is supported.

Restore from 
Diskette

Restores system configuration from a diskette. 

Set Defaults 
and Exit

Restores factory default settings, which includes clearing any established passwords.

Ignore 
Changes and 
Exit

Exits Computer Setup without applying or saving any changes.

Save Changes 
and Exit

Saves changes to system configuration and exits Computer Setup.
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Storage Device 
Configuration

Lists all installed non-SCSI storage devices.
SCSI storage drives will not be listed in Computer Setup (F10).
When a device is selected, detailed information and options are displayed. The following options 
might be presented:

Hard Disk
Identifies the hard disk drives on the system.

CD-ROM
Identifies the hard disk drives on the system.

Diskette Type (for legacy diskette drives only)
Identifies the highest capacity media type accepted by the diskette drive. Options are 3.5" 1.44 
MB, 5.25" 1.2 MB, and Not Installed.

Default Values

Multisector Transfers (IDE disks only)
Specifies how many sectors are transferred per multi-sector PIO operation. Options (subject to 
device capabilities) are Disabled, 8, and 16.

Transfer Mode (IDE devices only)
Specifies the active data transfer mode. Options (subject to device capabilities) are PIO 0, Max 
PIO, Enhanced DMA, Ultra DMA 0, and Max UDMA.

Translation Mode (IDE disks only)
Lets you select the translation mode to be used for the device. This enables the BIOS to access 
disks partitioned and formatted on other systems and may be necessary for users of older 
versions of UNIX (for example, SCO UNIX version 3.2). Options are Bit-Shift, LBA Assisted, User, 
and None.

CAUTION: A new Automatic option has been added to allow for BIOS to automatically determine 
the translation mode used to configure a previously formatted IDE, SATA, or USB mass storage 
device. This prevents you from having to know how the mass storage device was previously 
formatted.

Ordinarily, the translation mode selected automatically by the BIOS should not be changed. If the 
selected translation mode is not compatible with the translation mode that was active when the 
disk was partitioned and formatted, the data on the disk will be inaccessible.

Options Removable Media Boot
Enables/disables ability to boot the system from removable media.

Removal Media Diskette Write
Enables/disables ability to write data to removable media.

BIOS DMA Data Transfers
Allows you to enable or disable the BIOS use of DMA for IDE data transfers.

SATA Configuration
Add as separate controller and replace separate controller.

Primary IDE Controller
Enables/disables primary IDE controller.

Secondary IDE Controller
Enables/disables secondary IDE controller.

Table 3-1 Computer Setup Menu Descriptions

Heading Option Description
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Boot Order
Allows you to configure the boot, diskette drive, and hard drive orders by physically reordering the 
menu entries. Each device on the list can be individually excluded from or included for 
consideration as a bootable operating system source.
NOTE: MS-DOS drive lettering assignments might not apply after a non-MS-DOS operating 
system has started.
Shortcut to Temporarily Override Boot Order
To boot one time from a device other than the default device specified in Boot Order, restart the 
workstation and press F9 when the F10=Setup message appears on the screen. After POST is 
completed, a list of bootable devices is displayed. Use the arrow keys to select the preferred 
bootable device and press Enter. The workstation then boots from the selected non-default device 
for this one time.

Controller Order
Allows you to specify the order of the attached hard drive controllers. The first hard drive controller 
in the order will have priority in the boot sequence and will be recognized as drive C (if any 
devices are attached).
NOTE: The selection will not appear if all hard drives are attached to the embedded IDE 
controllers.

Security Setup 
Password

Allows you to set and enable setup (administrator) password.

NOTE If the setup password is set, it is required to change Computer Setup options, flash the 
ROM, and make changes to certain plug and play settings under Windows.

Power-On 
Password

Allows you to set and enable power-on password.

Smart Cover Allows you to disable cover removal sensor or to notify user if sensor has been activated.

System IDs Allows you to set:

Asset tag (16-byte identifier) and ownership tag (80-byte identifier displayed during POST).

Chassis serial number or Universal Unique Identifier (UUID) number. The UUID can only be 
updated if the current chassis serial number is invalid. (These ID numbers are normally set in 
the factory and are used to uniquely identify the system.)

Keyboard locale setting (for example, English or German) for System ID entry.

Monitor tracking

Master Boot 
Record 
Security

Enables you to enable or disable MBR Security.
When enabled, the BIOS rejects all requests to write to the MBR on the current bootable disk. 
Each time the computer is powered on or rebooted, the BIOS compares the MBR of the current 
bootable disk to the previously saved MBR. If changes are detected, you are given the option of 
saving the MBR on the current bootable disk, restoring the previously saved MBR, or disabling 
MBR Security. You must know the setup password, if one is set.

NOTE Disable MBR Security before intentionally changing the formatting or partitioning of the 
current bootable disk. Several disk utilities (such as FDISK and FORMAT) attempt to update the 
MBR. If MBR Security is enabled and disk accesses are being serviced by the BIOS, write 
requests to the MBR are rejected, causing the utilities to report errors. If MBR Security is enabled 
and disk accesses are being serviced by the operating system, any MBR change will be detected 
by the BIOS during the next reboot, and an MBR Security warning message will be displayed.

Table 3-1 Computer Setup Menu Descriptions

Heading Option Description
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Advanced** Boot Allows you to set:

POST mode (QuickBoot, FullBoot, or FullBoot every 1–30 days).

POST messages (enable/disable).

Safe POST (enable/disable). Enabling this features allows a watchdog timer to operate during 
Option ROM execution. If an option ROM hangs and the user cycles the power on the system, 
POST detects that an error occurred during the last boot, and displays a message. The 
offending option ROM code is skipped.

NOTE This setting might need to be disabled if an option ROM takes a long time to execute. The 
watchdog timer might expire on a normally executing option ROM and skip it on the next boot.

F9 prompt (enable/disable). Enabling this feature will display the text F9=Boot Menu during 
POST. Disabling this feature prevents the text from being displayed. However, pressing the 
F9 key will still access the Shortcut Boot [Order] Menu screen.

F10 prompt (enable/disable). Enabling this feature displays the text F10=Setup during 
POST. Disabling this feature prevents the text from being displayed but pressing F10 
still accesses the Setup screen.

F12 prompt (enable/disable). Enabling this feature displays the text F12=Network Service 
Boot during POST. Disabling this feature prevents the text from being displayed but pressing 
F12 still forces the system to attempt booting from the network.

Option ROM* prompt (enable/disable). Enabling this feature causes the system to display a 
message before loading options ROMs. 

POST Delay (in seconds) (enable/disable). Enabling this feature adds a user-specified delay 
to the POST process. This delay is sometimes needed for hard disks on some PCI cards that 
spin up slowly—so slowly that they are not ready to boot by the time POST is finished. The 
POST delay also gives you more time to select F10 to enter Computer Setup (F10).

Num Lock State at Power-On (enable/disable). Enabling this feature automatically turns on 
Num Lock at startup.

Power/Sleep/
Wake

Options:

Remote Wakeup Boot Source

After Power Loss (on/off).

S5 wake on LAN (enable/disable).

Unique Sleep State Blink Rates (enable/disable). Allows you to choose an LED blink pattern 
that uniquely identifies each sleep state.

Processors Enable/disable processor cache, Hyper-Threading Technology, and power management features.

NOTE Enabling Power Management turns on Demand-Based Switching, a feature which reduces 
processor frequency and voltage (thus, power) when usage is low (but the system is still in S0/
working state). 

Chipset/
Memory

ECC support enables hardware-based error correction for ECC-capable memories.

Memory scrubbing (enable/disable)

Memory remapping (enable/disable)

PCI SERR# generation (enable/disable)

PCI VGA palette snooping (enable/disable), which sets the VGA palette snooping bit in PCI 
configuration space; only needed when more than one graphics controller is installed. 

Table 3-1 Computer Setup Menu Descriptions

Heading Option Description
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Onboard 
Devices

Enables you to set resources for or disable onboard system devices (serial ports, parallel ports, 
diskette controllers, and so on).

Device Options Allows you to set the Printer Mode to EPP+ECP, Output-Only or Bi-directional.

NOTE These settings are included for backward compatibility. Many older printers cannot use 
newer protocols like EPP+ECP.

Allows you to enable/disable:

Number Lock state at power-on or off during POST

PME Wakeup Events, such as a wake on LAN magic packet to bring the machine out of 
Hibernate.

Processor Cache. Enabling this turns on the processors L1 and L2 cache and disabling turns 
off the processors L1 and L2 cache, which is one way to slow the processor down.

SATA RAID Option ROM

SCSI Option ROM

Network Controller Option

Standby wake events

NOTE This setting might need to be disabled if older PCI cards do not use the PME signal 
correctly and keep turning on the system.

Slot 1 (PCI) Enables you to configure control, power management, option ROM, and interrupt.

Slot 2 (PCI 
Express x 16)

Enables you to configure control, power management, option ROM, and interrupt.

Slot 3 (PCI) Enables you to configure control, option ROM, and latency timer.

Slot 4 (PCI 
Express x 16)

Enables you to configure control, option ROM, and latency timer.

Slot 5 (PCI-X 
133)

Enables you to configure control, speed, option ROM, and latency timer.

Slot 6 (PCI-X 
133)

Enables you to configure control, speed, option ROM, and latency timer.

Slot 7 (PCI-X 
133)

Enables you to configure control, speed, option ROM, and latency timer.

*Available on select models.
**These options should be used by advanced users only.

Table 3-1 Computer Setup Menu Descriptions

Heading Option Description
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Desktop Management
HP Client Management Solutions (available for download from http://www.hp.com/go/EasyDeploy) 
provides standards-based solutions for managing and controlling workstations in a networked 
environment. This section summarizes the capabilities and features of the key components of desktop 
management:

Initial Configuration and Deployment

Remote System Installation

Software Updating and Management

ROM Flash

Asset Tracking and Security

Fault Notification and Recovery

NOTE Support for specific features described in this guide might vary by model or software version.

Initial Configuration and Deployment
The workstation comes with a preinstalled system software image. After a brief software “unbundling” 
process, the workstation is ready to use.

You may prefer to replace the preinstalled software image with a customized set of system and 
application software. There are several methods for deploying a customized software image. They 
include:

Installing additional software applications after unbundling the preinstalled software image.

Using software deployment tools, such as Altiris Deployment Solutions™, to replace the preinstalled 
software with a customized software image.

Using a disk cloning process to copy the contents from one hard drive to another.

The best deployment method depends on your information technology environment and processes. The 
PC Deployment section of the HP Lifecycle Solutions Web site (http://whp-sp-orig.extweb.hp.com/
country/us/en/solutions.html) provides information to help you select the best deployment method.

The Restore Plus! CD, ROM-based setup, and ACPI hardware provide further assistance with recovery 
of system software, configuration management and troubleshooting, and power management.

Remote System Installation
Remote System Installation lets you start and set up your system using the software and configuration 
information located on a network server. This feature is usually used as a system setup and 
configuration tool, and can be used for the following tasks:

Deploying a software image on one or more new PCs

Formatting a hard drive

Installing application software or drivers

Updating the operating system, application software, or drivers
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To initiate Remote System Installation, press F12 when the F12=Network Service Boot message 
appears in the lower-right corner of the HP logo screen. Follow the on-screen instructions to continue the 
process. The default boot order is a BIOS configuration setting that can be changed to always attempt to 
PXE boot.

HP and Altiris have partnered to provide tools designed to make the task of corporate PC deployment 
and management easier and less time-consuming, ultimately lowering the total cost of ownership and 
making HP PCs the most manageable client PCs in the enterprise environment.

Software Updating and Management
HP provides several tools for managing and updating software on desktops and workstations—HP Client 
Manager Software, Altiris Client Management Solutions, System Software Manager; Proactive Change 
Notification; and Subscriber’s Choice.

HP Client Manager Software

HP Client Manager Software (HP CMS) assists HP customers in managing the hardware aspects of their 
client workstations with features that include:

Detailed views of hardware inventory for asset management

PC health check monitoring and diagnostics

Proactive notification of changes in the hardware environment

Web-accessible reporting of business critical details such as machines with thermal warnings, 
memory alerts, and more

Remote updating of system software such as device drivers and ROM BIOS

Remote changing of boot order

Configuring the system BIOS settings

For more information on the HP Client Manager, visit http://www.hp.com/go/im.

Altiris Client Management Solutions

HP and Altiris have partnered to provide comprehensive, tightly integrated systems management 
solutions to reduce the cost of owning HP client PCs. HP Client Manager Software is the foundation for 
additional Altiris Client Management Solutions that address:

Inventory and Asset Management

SW license compliance

PC tracking and reporting

Lease contract, fixing asset tracking

Deployment and Migration

Microsoft Windows XP Professional or Home Edition migration

System deployment

Personality migrations

Help Desk and Problem Resolution

Managing help desk tickets
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Remote troubleshooting

Remote problem resolution

Client disaster recovery

Software and Operations Management

Ongoing desktop management

HP system SW deployment

Application self-healing

For more information and details on how to download a fully-functional 30-day evaluation version of the 
Altiris solutions, visit http://h18000.www1.hp.com/im/prodinfo.html#deploy.

For more information, visit http://www.hp.com/go/EasyDisplay.

System Software Manager

System Software Manager (SSM) is a utility that lets you update system-level software on multiple 
systems simultaneously. When executed on a PC client system, SSM detects both hardware and 
software versions, then updates the appropriate software from a central repository, also known as a file 
store. Driver versions that are supported by SSM are denoted with a special icon on the software, the 
driver download Web site, and on the Support Software CD. To download the utility or to obtain more 
information on SSM, visit http://www.hp.com/go/ssm.

Proactive Change Notification

The Proactive Change Notification program uses the Subscriber's Choice Web site in order to 
proactively and automatically:

Send you Proactive Change Notification (PCN) e-mails informing you of hardware and software 
changes to most commercial workstations and servers, up to 60 days in advance.

Send you e-mail containing Customer Bulletins, Customer Advisories, Customer Notes, Security 
Bulletins, and Driver alerts for most commercial workstations and servers.

You create your own profile to ensure that you only receive the information relevant to a specific IT 
environment. To learn more about the Proactive Change Notification program and create a custom 
profile, visit http://www.hp.com/go/pcn.

Subscriber’s Choice

Subscriber’s Choice is a client-based service from HP. Based on your profile, HP will supply you with 
personalized product tips, feature articles, and/or driver and support alerts/notifications. Subscriber’s 
Choice Driver and Support Alerts/Notifications will deliver e-mails notifying you that the information you 
subscribed to in your profile is available for review and retrieval. To learn more about Subscriber’s 
Choice and create a custom profile, visit http://www.hp.com/go/pcn.

ROM Flash
The workstation comes with a programmable flash ROM (read only memory). By establishing a setup 
password in the Computer Setup (F10) Utility, you can protect the ROM from being unintentionally 
updated or overwritten. This is important to ensure the operating integrity of the workstation. Should you 
need or want to upgrade the ROM, you may:

Order an upgraded ROMPaq diskette from HP.
44 SYSTEM MANAGEMENT

h18000.www1.hp.com/im/prodinfo.html#deploy
www.hp.com/go/im
www.hp.com/go/ssm
www.hp.com/go/pcn
www.hp.com/go/pcn


C
ha

pt
er

 3
Download the latest ROMPaq images from HP driver and support page, http://www.hp.com/support/
files.

CAUTION For maximum ROM protection, be sure to establish a setup password. The setup password 
prevents unauthorized ROM upgrades. System Software Manager allows the system administrator to set 
the setup password on one or more PCs simultaneously. For more information, visit http://www.hp.com/
go/ssm.

Remote ROM Flash

Remote ROM Flash allows the system administrator to safely upgrade the ROM on remote HP 
workstations directly from the centralized network management console. Enabling the system 
administrator to perform this task remotely, on multiple workstations and personal computers, results in a 
consistent deployment of and greater control over HP PC ROM images over the network. It also results 
in greater productivity and lower total cost of ownership.

The workstation must be powered on, or turned on through Remote Wakeup, to take advantage of 
Remote ROM Flash.

For more information on Remote ROM Flash, see the HP Client Manager Software or System Software 
Manager at http://h18000.www1.hp.com/im/prodinfo.html.

HPQFlash

The HPQFlash utility is used to locally update or restore the system ROM on individual PCs through a 
Windows operating system.

For more information on HPQFlash, visit http://www.hp.com/support/files and enter the name of the 
workstation when prompted.

FailSafe Boot Block ROM

The FailSafe Boot Block ROM allows for system recovery in the unlikely event of a ROM flash failure, for 
example, if a power failure were to occur during a ROM upgrade. The Boot Block is a flash-protected 
section of the ROM that checks for a valid system ROM flash when power to the system is turned on.

If the system ROM is valid, the system starts normally.

If the system ROM fails the validation check, the FailSafe Boot Block ROM provides enough support 
to start the system from a ROMPaq diskette, which will program the system ROM with a valid image.

NOTE Some models also support recovery from a ROMPaq CD. ISO ROMPaq images are included 
with selected models in the downloadable ROM softpaqs.

When the boot block detects an invalid system ROM, the System Power LED blinks RED 8 times, one 
every second, followed by a 2-second pause. Also, eight simultaneous beeps will be heard. A Boot Block 
recovery mode message is displayed on the screen (some models).

To recover the system after it enters Boot Block recovery mode:

1 If there is a diskette in the diskette drive or a CD in the CD drive, remove the diskette and CD and 
turn off the power.

2 Insert a ROMPaq diskette into the diskette drive or, if permitted on this workstation, a ROMPaq CD 
into the CD drive.
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3 Turn on the workstation.

If no ROMPaq diskette or ROMPaq CD is found, you will be prompted to insert one and restart the 
workstation.

If a setup password has been established, the Caps Lock light will turn on and you will be prompted 
to enter the password.

4 Enter the setup password.

If the system successfully starts from the diskette and successfully reprograms the ROM, then the 
three keyboard lights will turn on. A rising tone series of beeps also signals successful completion.

5 Remove the diskette or CD and turn the power off.

6 Turn the power on again to restart the workstation.

The following table lists the various keyboard light combinations used by the Boot Block ROM (when a 
PS/2 keyboard is attached to the workstation), and explains the meaning and action associated with 
each combination.

Replicating the Setup

The following procedures give an administrator the ability to easily copy one setup configuration to other 
workstations of the same model. This allows for faster, more consistent configuration of multiple 
workstations.

NOTE Both procedures require a diskette drive.

NOTE To collect and replicate BIOS settings on multiple computers, use System Software Manager or 
HP Client Manager Software. For more information, visit http://www.hp.com/go/easydeploy.

Table 3-2 Keyboard Light Combinations Used by Boot Black ROM

FailSafe Boot
Block Mode

Keyboard LED Activity State/Message

Num Lock On ROMPaq diskette or ROMPaq CD not present, is bad, or drive not ready.

Caps Lock On Enter password.

Num, Caps, 
Scroll Lock

Blink On in sequence, 
one at a time–N,C, SL

Keyboard locked in network mode.

Num, Caps, 
Scroll Lock

On Boot Block ROM Flash successful. Turn power off, then on to reboot.

NOTE: Diagnostic lights do not flash on USB keyboards
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COPYING TO A SINGLE WORKSTATION

CAUTION A setup configuration is model-specific. File system corruption may result if source and target 
workstations are not the same model. For example, do not copy the setup configuration from a dc7100 
Ultra-Slim Desktop to a dx6100 Slim Tower.

1 Select a setup configuration to copy. Turn off the workstation. If you are in Windows, click Start>Shut 
Down>Shut Down.

2 Turn on the workstation.

3 As soon as the workstation is turned on, press and hold the F10 key until you enter Computer Setup. 
Press Enter to bypass the title screen, if necessary.

NOTE If you do not press the F10 key at the appropriate time, you must restart the workstation and 
press and hold the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

4 If you are using a a diskette, insert it now.

5 Click File>Replicated Setup>Save to Removable Media. Follow the instructions on the screen to 
create the configuration diskette.

6 Turn off the workstation to be configured and insert the configuration diskette.This procedure gives 
an administrator the ability to easily copy one setup configuration to other workstations of the same 
model. This allows for faster, more consistent configuration of multiple workstations.

7 Turn on the workstation to be configured.

8 As soon as the workstation is turned on, press and hold the F10 key until you enter Computer Setup. 
Press Enter to bypass the title screen, if necessary.

9 Click File>Replicated Setup>Retore from Removable Media, and follow the instructions on the 
screen.

10 Restart the workstation when the configuration is complete.

COPYING TO MULTIPLE WORKSTATIONS

CAUTION A setup configuration is model-specific. File system corruption may result if source and target 
workstations are not the same model. For example, do not copy the setup configuration from a HP 
Workstation xw4200 to HP Workstation xw8200.

This method takes a little longer to prepare the configuration diskette, but copying the configuration to 
target workstations is significantly faster.
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NOTE A bootable diskette is required for this procedure. If Windows XP is not available to use to create 
a bootable diskette, use the method for copying to a single workstation instead (see “Copying to A Single 
Workstation” section on page 47).

1 Create a bootable diskette. 

2 Select a setup configuration to copy. Turn off the workstation. If you are in Windows, click Start>Shut 
Down>Shut Down.

3 Turn on the workstation.

4 As soon as the workstation is turned on, press and hold the F10 key until you enter Computer Setup. 
Press Enter to bypass the title screen, if necessary.

NOTE If you do not press the F10 key at the appropriate time, you must restart the workstation and 
press and hold the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

5 If you are using a a diskette, insert it now.

6 Click File>Replicated Setup>Save to Removable Media. Follow the instructions on the screen to 
create the configuration diskette.

7 Download a BIOS utility for replicating setup (repset.exe) and copy it onto the configuration diskette. 
To obtain this utility, go to http://welcome.hp.com/support/files and enter the model number of the 
workstation.

8 On the configuration diskette, create an autoexec.bat file containing the following command: 
repset.exe.

9 Turn off the workstation to be configured. Insert the configuration diskette and turn the workstation 
on. The configuration utility will run automatically.

10 Restart the workstation when the configuration is complete.

Dual-State Power Button

With Advanced Configuration and Power Interface (ACPI) enabled, the power button can function either 
as an on/off switch or as a hibernate button. The Hibernate feature does not completely turn off power, 
but instead causes the workstation to enter a low-power standby state. This allows you to power down 
quickly without closing applications and to return quickly to the same operational state without any data 
loss.

To change the power button configuration:

1 Left click on the Start button, then select Control Panel>Power Options.

2 In the Power Options Properties, select the Advanced tab.

3 In the Power Button section, select Hibernate. (Hibernate must be enabled in the Hibernate tab.)

After configuring the power button to function as a hibernate button, press the power button to put the 
system in a very low power state (Hibernate). Press the button again to quickly bring the system out of 
hibernate to full power status. To completely turn off all power to the system, press and hold the power 
button for four seconds.
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CAUTION Do not use the power button to turn off the workstation unless the system is not responding; 
turning off the power without operating system interaction could cause damage to or loss of data on the 
hard drive.

World Wide Web Site

HP engineers rigorously test and debug software developed by HP and third-party suppliers, and 
develop operating system specific support software, to ensure performance, compatibility, and reliability 
for HP workstations.

When making the transition to new or revised operating systems, it is important to implement the support 
software designed for that operating system. If you plan to run a version of Microsoft Windows that is 
different from the version included with the workstation, you must install corresponding device drivers 
and utilities to ensure that all features are supported and functioning properly.

HP has made the task of locating, accessing, evaluating, and installing the latest support software 
easier. You can download the software from http://www.hp.com/support.

The Web site contains the latest device drivers, utilities, and flashable ROM images needed to run the 
latest Microsoft Windows operating system on the HP workstation.

Building Blocks and Partners

HP management solutions integrate with other systems management applications, and are based on 
industry standards, such as:

Web-Based Enterprise Management (WBEM)

Windows Management Interface (WMI)

Wake on LAN Technology

ACPI

SMBIOS

Pre-boot Execution (PXE) support

Asset Tracking and Security
Asset tracking features incorporated into the workstation provide key asset tracking data that can be 
managed using HP Systems Insight Manager, HP Client Manager Software or other system 
management applications. Seamless, automatic integration between asset tracking features and these 
products enables you to choose the management tool that is best suited to the environment and to 
leverage the investment in existing tools.

HP also offers several solutions for controlling access to valuable components and information. 
ProtectTools Embedded Security, if installed, prevents unauthorized access to data and checks system 
integrity and authenticates third-party users attempting system access. Security features such as 
ProtectTools, the Hood Sensor (Smart Cover Sensor) and the Hood Lock (Smart Cover Lock), available 
on select models, help to prevent unauthorized access to the internal components of the workstation. By 
disabling parallel, serial, or USB ports, or by disabling removable media boot capability, you can protect 
valuable data assets. Memory Change and Hood Sensor (Smart Cover Sensor) alerts can be 
automatically forwarded to system management applications to deliver proactive notification of 
tampering with a workstation’s internal components.
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NOTE ProtectTools, the Hood Sensor (Smart Cover Sensor), and the Hood Lock (Smart Cover Lock) 
are available as options on select systems.

Use the following utilities to manage security settings on the HP workstation:

Locally, using the Computer Setup Utilities. 

Remotely, using HP Client Manager Software or System Software Manager. This software enables 
the secure, consistent deployment and control of security settings from a simple command-line utility.

The following table and sections refer to managing security features of the workstation locally through 
the Computer Setup (F10) Utilities.

Table 3-3 Security Features Overview

Feature Purpose How It Is Established

Removable Media Boot Control Prevents booting from the removable media 
drives.

From the Setup Utilities menu.

Serial, Parallel, USB, or Infrared 
Interface Control

Prevents transfer of data through the 
integrated serial, parallel, USB, or infrared 
interface.

From the Setup Utilities menu.

Power-On Password Prevents use of the workstation until the 
password is entered. This can apply to both 
initial system startup and restarts.

From the Setup Utilities menu.

Setup Password Prevents reconfiguration of the workstation 
(use of the Setup Utilities) until the password 
is entered.

From the Setup Utilities menu.

Network Server Mode Provides unique security features for 
workstations being used as servers.

From the Setup Utilities menu.

DriveLock Prevents unauthorized access to the data on 
specific hard drives.

From the Setup Utilities menu.

Master Boot Record Security Might prevent unintentional or 
malicious changes to the MBR of the current 
bootable disk and provides a means of 
recovering the “last known good” MBR.

From the Setup Utilities menu.

Ownership Tag Displays ownership information, as defined 
by the system administrator, during system 
startup (protected by setup password).

From the Setup Utilities menu.

Kensington Cable Lock 
Provision

Prevents entire system theft only. Install a Kensington cable lock to 
secure the workstation to a fixed 
object.

Padlock Loop Prevents access panel from being removed. 
This loop can also be used to secure the unit 
to a fixed object.

Install a padlock.

Access Panel Key Lock 
(Standard)

Prevents removal of the access panel and all 
internal components including optical and 
floppy drives

Lock the access panel. 
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Password Security

The power-on password prevents unauthorized use of the workstation by requiring entry of a password 
to access applications or data each time the workstation is turned on or restarted. The setup password 
specifically prevents unauthorized access to Computer Setup, and can also be used as an override to 
the power-on password. That is, when prompted for the power-on password, entering the setup 
password instead will allow access to the workstation.

A network-wide setup password can be established to enable the system administrator to log in to all 
network systems to perform maintenance without having to know the power-on password.

NOTE System Software Manager and HP Client Manager Software allow remote management of Setup 
Passwords and other BIOS settings in a networked environment. For more information, visit http://
www.hp.com/go/EasyDeploy.

ESTABLISHING A SETUP PASSWORD USING COMPUTER SETUP

Establishing a setup password through Computer Setup prevents reconfiguration of the workstation (use 
of the Computer Setup (F10) utility) until the password is entered.

To establish a setup password using workstation setup:

1 Turn on or restart the workstation. If you are in Windows, click Start>Turn off>Restart.

2 As soon as the computer is turned on, press and hold the F10 until you enter Computer Setup. Press 
Enter to bypass the title screen, if necessary.

NOTE If you do not press the F10 key at the appropriate time, you must restart the workstation and 
press and hold the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3 Select Security>Setup Password and follow the on-screen instructions.

Hood Lock (Smart Cover Lock) 
(Optional)

Prevents removal of the access panel and all 
internal components including optical and 
floppy drives. Eliminates the need for a 
physical key by enabling password-protected 
locking & unlocking by a local or remote user.

Install a hood lock.

Universal Chassis Clamp Lock 
(Optional)

The version without a cable discourages 
access panel removal and prevents theft of IO 
devices. The version with a cable additionally 
prevents entire system theft and allows 
multiple systems to be secured with a single 
cable.

Install a chassis clamp lock.

Hood Sensor (Optional) Notifies a local or remote user when the 
chassis access panel has been opened. 

Install an intrusion sensor.

For more information about Computer Setup, refer to “Computer Setup Menu” section on page 37.

Table 3-3 Security Features Overview (Continued)

Feature Purpose How It Is Established
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4 Before exiting, select File>Save Changes and Exit.

ESTABLISHING A POWER-ON PASSWORD USING WORKSTATION SETUP

Establishing a power-on password through Computer Setup prevents access to the workstation when 
power is turned on, unless the password is entered. When a power-on password is set, Computer Setup 
presents Password Options under the Security menu. The password options include Network Server 
Mode and Password Prompt on Warm Boot.

When Network Server Mode is disabled, the password must be entered each time the workstation is 
turned on when the key icon appears on the monitor. When Password Prompt on Warm Boot is enabled, 
the password must also be entered each time the workstation is rebooted. When Network Server Mode 
is enabled, the password prompt is not presented during POST, but any attached PS/2 keyboard will 
remain locked until the user enters the power-on password.

To establish a power-on password through workstation setup:

1 Turn on or restart the workstation. If you are in Windows, click Start>Shut Down>Restart.

2 As soon as the computer is turned on, press and hold the F10 until you enter Computer Setup. Press 
Enter to bypass the title screen, if necessary.

NOTE If you do not press the F10 key at the appropriate time, you must restart the workstation and 
press and hold the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3 Select Security>Power-On Password and follow the on-screen instructions.

4 Before exiting, select File>Save Changes and Exit.

ENTERING A POWER-ON PASSWORD

To enter a power-on password:

1 Turn on or restart the workstation. If you are in Windows, click Start>Shut Down>Restart the 
Computer.

2 When the key icon appears on the monitor, enter the current password, then press Enter.

NOTE Type carefully. For security reasons, the characters you enter do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful 
tries, you must turn off the workstation, then turn it on again before you can continue.

ENTERING A SETUP PASSWORD

If a setup password has been established on the workstation, you will be prompted to enter it each time 
you run Computer Setup.

To enter a setup password:

1 Turn on or restart the workstation. If you are in Windows, click Start>Shut Down>Restart the 
Computer.
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2 As soon as the workstation is turned on, press and hold the F10 key until you enter Computer Setup. 
Press Enter to bypass the title screen, if necessary.

NOTE If you do not press the F10 key at the appropriate time, you must restart the workstation and 
press and hold the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3 When the key icon appears on the monitor, enter the setup password, then press Enter.

NOTE Type carefully. For security reasons, the characters you enter do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful 
tries, you must turn off the workstation, then turn it on again before you can continue.

CHANGING A POWER-ON OR SETUP PASSWORD

To change a power-on or setup password:

1 Turn on or restart the workstation. If you are in Windows, click Start>Shut Down>Restart the 
Computer. To change the setup password, run Computer Setup.

2 To change the Power-On password, go to step 3.

To change the Setup password, as soon as the workstation is turned on, press and hold the F10 
key until you enter Computer Setup. Press Enter to bypass the title screen, if necessary.

NOTE If you do not press the F10 key at the appropriate time, you must restart the workstation and 
press and hold the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3 When the key icon appears, type the current password, a slash (/) or alternate delimiter character, 
your new password, another slash (/) or alternate delimiter character, and your new password again 
as shown:

current password/new password/new password

NOTE Type carefully. For security reasons, the characters you enter do not appear on the screen.

4 Press Enter.

The new password takes effect the next time you turn on the workstation.
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NOTE See the “National Keyboard Delimiter Characters” section on page 54 for information about the 
alternate delimiter characters. The power-on password and setup password can also be changed using 
the Security options in Computer Setup.

Deleting a Power-On or Setup Password

To delete a power-on or setup password:

1 Turn on or restart the workstation. If you are in Windows, click Start>Shut Down>Restart the 
Computer.

2 To delete the Power-On password, go to Step 3.

To delete the Setup Password, as soon as the workstation is turned on, press and hold the F10 key 
until you enter Computer Setup. Press Enter to bypass the title screen, if necessary.

NOTE If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility.

Use the appropriate operating system shutdown process. To delete the setup password, run Computer 
Setup.

3 When the key icon appears, enter your current password followed by a slash (/) or alternate delimiter 
character as shown:

current password/

4 Press Enter.

NOTE See the “National Keyboard Delimiter Characters” section on page 54 section for information 
about the alternate delimiter characters. The power-on password and setup password can also be 
changed using the Security options in Computer Setup.

NATIONAL KEYBOARD DELIMITER CHARACTERS

Each keyboard is designed to meet country-specific requirements. The syntax and keys that you use for 
changing or deleting your password depend on the keyboard that came with your workstation.

Table 3-4 National Keyboard Delimiter Characters

Arabic / Greek - Russian /

Belgian = Hebrew . Slovakian -

BHCSY* - Hungarian - Spanish -

Brazilian / Italian - Swedish/Finnish /

Chinese / Japanese / Swiss -

Czech - Korean / Taiwanese /

Danish - Latin American - Thai /
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CLEARING PASSWORDS

If you forget your password, you cannot access the workstation. See Appendix H, “Additional Password 
Security and Resetting CMOS” for instructions on clearing passwords.

DriveLock

DriveLock prevents unauthorized access to the data on MultiBay hard drives. DriveLock has been 
implemented as an extension to Computer Setup. It is only available when DriveLock-capable hard 
drives are detected.

DriveLock employs a two-password security scheme. One password is intended to be set and used by a 
system administrator while the other is typically set and used by the end-user. There is no “back-door” 
that can be used to unlock the drive if both passwords are lost. Therefore, DriveLock is most safely used 
when the data contained on the hard drive is replicated on a corporate information system or is regularly 
backed-up.

CAUTION If both DriveLock passwords are lost, the hard drive is rendered unusable.

USING DRIVELOCK

The DriveLock option appears under the Security menu in Computer Setup. The user is presented with 
options to set the master password or to enable DriveLock. A user password must be provided to enable 
DriveLock. Since the initial configuration of DriveLock is typically performed by a system administrator, a 
master password should be set first. HP encourages system administrators to set a master password 
whether they plan to enable DriveLock or keep it disabled. This will give the administrator the ability to 
modify DriveLock settings if the drive is locked in the future. Once the master password is set, the 
system administrator can enable DriveLock or choose to keep it disabled.

If a locked hard drive is present, POST will require a password to unlock the device. If a power-on 
password is set and it matches the user password of the device, POST will not prompt the user to re-
enter the password. Otherwise, the user will be prompted to enter a DriveLock password. Either the 
master or the user password can be used. Users will have two attempts to enter a correct password. If 
neither attempt succeeds, POST will continue but the data on the drive will remain inaccessible.

DRIVELOCK APPLICATIONS

The most practical use of the DriveLock security feature is in a corporate environment where a system 
administrator provides users with multibay hard drives for use in some desktop workstations. The system 
administrator would be responsible for configuring the MultiBay hard drive which would involve, among 
other things, setting the DriveLock master password. In the event that the user forgets the user password 
or the equipment is passed on to another employee, the master password can always be used to reset 
the user password and regain access to the hard drive.

French ! Norwegian - Turkish .

French Canadian é Polish - U.K. English /

German - Portuguese - U.S. English /

*For Bosnia-Herzegovina, Croatia, Slovenia, and Yugoslavia

Table 3-4 National Keyboard Delimiter Characters

Arabic / Greek - Russian /
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HP recommends that corporate system administrators who choose to enable DriveLock also establish a 
corporate policy for setting and maintaining master passwords. This should be done to prevent a 
situation where an employee intentionally or unintentionally sets both DriveLock passwords before 
leaving the company. In such a scenario, the hard drive would be rendered unusable and require 
replacement. Likewise, by not setting a master password, system administrators might find themselves 
locked out of a hard drive and unable to perform routine checks for unauthorized software, other asset 
control functions and support.

For users with less stringent security requirements, HP does not recommend enabling DriveLock. Users 
in this category include personal users or users who do not maintain sensitive data on their hard drives 
as a common practice. For these users, the potential loss of a hard drive resulting from forgetting both 
passwords is much greater than the value of the data DriveLock has been designed to protect. Access to 
Computer Setup and DriveLock can be restricted through the Setup password. By specifying a Setup 
password and not giving it to end users, system administrators are able to restrict users from enabling 
DriveLock. 

Hood Sensor (Smart Cover Sensor)

The hood sensor is an optional feature that is a combination of hardware and software technology that 
can alert you when the workstation side access panel has been removed.This option is available as a kit 
that includes the Hood Lock (Smart Cover Lock) (see the following section). There are three levels of 
protection, as described in the following table.

SETTING THE HOOD SENSOR PROTECTION LEVEL 

To set the hood sensor protection level:

1 Turn on or restart the workstation. If you are in Windows, click Start>Shut Down>Restart.

2 As soon as the workstation is turned on, press and hold the F10 key until you enter Computer Setup. 
Press Enter to bypass the title screen, if necessary.

NOTE If you do not press the F10 key at the appropriate time, you must restart the computer and press 
and hold the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3 Select Security>Smart Cover>Cover Removal Sensor, then side access panel, and follow the on-
screen instructions.

Table 3-5 Hood Sensor Protection Levels

Level Setting Description

Level 0 Disabled Hood sensor is disabled (default).

Level 1 Notify User When the workstation is restarted, the screen displays 
a message indicating that the workstation side access 
panel has been removed.

Level 2 Setup Password When the workstation is restarted, the screen displays 
a message indicating that the workstation side access 
panel has been removed. You must enter the setup 
password to continue.

NOTE: These settings can be changed using Computer Setup. 
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4 Before exiting, click File>Save Changes and Exit.

Hood Lock (Smart Cover Lock)

When installed, the hood lock can prevent unauthorized access to the internal components

CAUTION For maximum cover lock security, be sure to establish a setup password. The setup 
password prevents unauthorized access to the Computer Setup utility.

LOCKING THE SOLENOID LOCK

To activate and lock the solenoid lock:

1 Turn on or restart the workstation. If you are in Windows, click Start>Shut Down>Restart.

2 As soon as the workstation is turned on, press and hold the F10 key until you enter Computer Setup. 
Press Enter to bypass the title screen, if necessary.

NOTE If you do not press the F10 key at the appropriate time, you must restart the workstation and 
press and hold the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3 Select Security>Smart Cover>Cover Lock>Lock option.

4 Before exiting, select File>Save Changes and Exit.

UNLOCKING THE SOLENOID LOCK

To unlock the solenoid lock:

1 Turn on or restart the workstation. If you are in Windows, click Start>Shut Down>Restart.

2 As soon as the workstation is turned on, press and hold the F10 key until you enter Computer Setup. 
Press Enter to bypass the title screen, if necessary.

NOTE If you do not press the F10 key at the appropriate time, you must restart the workstation and 
press and hold the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3 Select Security>Smart Cover>Cover Lock>Unlock.

4 Before exiting, select File>Save Changes and Exit.

USING THE FAILSAFE KEY

If you enable the hood lock and cannot enter your password to disable the lock, you will need a FailSafe 
Key to open the workstation side access panel. You will need the key in any of the following 
circumstances:
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Power outage

Startup failure

PC component failure (such as processor or power supply)

Forgotten password

CAUTION The side access panel FailSafe Key is a specialized tool available from HP. Be prepared; 
order this key before you need one.

To obtain the FailSafe Key, complete any one of the following tasks:

Contact your authorized HP reseller or service provider.

Visit the HP Web site (http://www.hp.com) for ordering information.

Visit the Contact HP Worldwide Web site (http://welcome.hp.com/country/us/en/wwcontact.html) for 
contact information.

Master Boot Record Security

The MBR contains information needed to successfully boot from a disk and to access the data stored on 
the disk. Master Boot Record Security detects and reports unintentional or malicious changes to the 
MBR, such as those caused by some workstation viruses or by the incorrect use of certain disk utilities. It 
also allows you to recover the “last known good” MBR, should changes to the MBR be detected when 
the system is restarted.

To enable MBR Security:

1 Turn on or restart the workstation. If you are in Windows, click Start>Shut Down>Restart.

2 As soon as the workstation is turned on, press and hold the F10 key until you enter Computer Setup. 
Press Enter to bypass the title screen, if necessary.

NOTE If you do not press the F10 key at the appropriate time, you must restart the workstation and 
press and hold the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3 Select Security>Master Boot Record Security>Enabled.

4 Select Security>Save Master Boot Record.

5 Before exiting, click File>Save Changes and Exit.

When MBR Security is enabled, the BIOS prevents any changes being made to the MBR of the current 
bootable disk while in MS-DOS or Windows Safe Mode.

NOTE Most operating systems control access to the MBR of the current bootable disk; the BIOS cannot 
prevent changes that might occur while the operating system is running.
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Each time the workstation is turned on or restarted, the BIOS compares the MBR of the current bootable 
disk to the previously saved MBR. If changes are detected and if the current bootable disk is the same 
disk from which the MBR was previously saved, the following message is displayed:

1999 - Master Boot Record has changed.
Press any key to enter Setup to configure MBR Security.

Upon entering Computer Setup, you must perform one of the following tasks:

Save the MBR of the current bootable disk

Restore the previously saved MBR

Disable the MBR Security feature

You must know the setup password, if one exists.

If changes are detected and if the current bootable disk is not the same disk from which the MBR was 
previously saved, the following message is displayed:

2000 - Master Boot Record Hard Drive has changed.
Press any key to enter Setup to configure MBR Security.

Upon entering Computer Setup, you must perform one of the following tasks:

Save the MBR of the current bootable disk

Disable the MBR Security feature

You must know the setup password, if one exists.

In the unlikely event that the previously saved MBR has been corrupted, the following message is 
displayed:

1998 - Master Boot Record has been lost.
Press any key to enter Setup to configure MBR Security.

Upon entering Computer Setup, you must perform one of the following tasks:

Save the MBR of the current bootable disk

Disable the MBR Security feature

You must know the setup password, if one exists.

Before You Partition or Format the Current Bootable Disk

Before you partition or format the current bootable disk, ensure that MBR Security is disabled before you 
change partitioning or formatting of the current bootable disk. Some disk utilities, such as FDISK and 
FORMAT, attempt to update the MBR. If MBR Security is enabled when you change partitioning or 
formatting of the disk, you might receive error messages from the disk utility or a warning from MBR 
Security the next time the workstation is turned on or restarted.

To disable MBR Security:

1 Turn on or restart the workstation. If you are in Windows, click Start>Shut Down>Restart the 
Computer.

2 As soon as the workstation is turned on, press and hold the F10 key until you enter Computer Setup. 
Press Enter to bypass the title screen, if necessary.
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NOTE If you do not press F10 key at the appropriate time, you must restart the workstation and press 
and hold the F10 key again to access the utility.

If you are using a PS/2 keyboard, you may see a Keyboard Error message—disregard it.

3 Select Security>Master Boot Record Security>Disabled.

4 Before exiting, click File>Save Changes and Exit.

Cable Lock Provision (Optional)

The rear panel of the chassis can accommodate a cable lock accessory that allows the workstation to be 
physically secured to a work area.

Security Lock (Optional)

Prevents entire system theft and discourages access panel removal.

Universal Chassis Clamp Lock (Optional)

The version without a cable discourages access panel removal and prevents theft of IO devices. The 
version with a cable also prevents entire system theft and allows multiple systems to be secured with a 
single cable.

Hood Lock (Smart Cover Lock) (Optional)

Prevents removal of the access panel and all internal components including optical and diskette 
drives.This lock eliminates the need for a physical key by enabling password-protected locking and 
locking by a local or a remote user.

Hood Sensor (Smart Cover Sensor) (Optional)

This sensor is set in the Computer Setup utility. You can set this to notify a user if the access panel has 
been removed.

Access Panel Key Lock

This lock prevents removal of the access panel and all internal components. The key is shipped on the 
rear of the workstation.

Fault Notification and Recovery
Fault Notification and Recovery features combine innovative hardware and software technology to 
prevent the loss of critical data and minimize unplanned downtime.

If the workstation is connected to a network managed by HP Client Manager Software, the computer 
sends a fault notice to the network management application. With HP Client Manager Software, you can 
also remotely schedule diagnostics to automatically run on all managed PCs and create a summary 
report of failed tests.

Drive Protection System

The DPS is a diagnostic tool built into the hard drives installed in select HP workstations. DPS is 
designed to help diagnose problems that might result in unwarranted hard drive replacement.

When HP workstations are built, each installed hard drive is tested using DPS, and a permanent record 
of key information is written onto the drive. Each time DPS is run, test results are written to the hard 
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drive. Each time DPS is run, test results are written to the hard drive. The service provider can use this 
information to help diagnose conditions that caused you to run the DPS software. 

Ultra ATA Integrity Monitoring

Ultra ATA Integrity Monitoring monitors the integrity of data as it is transferred between an Ultra ATA hard 
drive and the system’s core logic. If the workstation detects an abnormal number of transmission errors, 
the workstation displays a Local Alert message with recommended actions.

ECC Fault Prediction and Prefailure Warranty

When the workstation encounters an excessive number of error checking and correcting (ECC) memory 
errors, the workstation displays a Local Alert message. This message contains detailed information 
about the errant memory module, allowing you to take action before you experience non-correctable 
memory errors. The Prefailure Warranty for ECC memory modules allows you to replace these modules, 
free of charge, before the modules actually fail. ECC memory modules are optional on selected HP 
systems.

NOTE To use this feature, you must replace the standard DIMMs with HP ECC DIMMs.

Surge-Tolerant Power Supply

An integrated surge-tolerant power supply provides greater reliability when the workstation is hit with an 
unpredictable power surge. This power supply is rated to withstand a power surge of up to 2000 V (Line 
to PE or Neutral to PE) and 1000 V (Line to Line) without any data loss or system downtime.

Thermal Sensor

The thermal sensor is a hardware and software feature that tracks the internal temperature of the 
workstation. When combined with HP Client Manager Software, this features notifies the network 
administrator when the normal range is exceeded.

The thermal sensor monitors the processor temperature and if the temperature gets too hot, the 
processor clock automatically begins to throttle. If the temperature does not go down, then the system 
eventually shuts down.
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Chapter 4 Removal and Replacement 
Procedures

This chapter describes removal and replacement procedures of most internal components.

“Service Considerations” on page 64

“Pre-Disassembly Procedures” on page 68

“System Board Components” on page 69

“Removal and Replacement of Components” on page 71
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Service Considerations
The following sections discuss service considerations that should be reviewed and practiced before 
removing and replacing any system components.

WARNING! When lifting or moving the workstation, do not use the front bezel as a handle or lifting point. 
Lifting the workstation from the front bezel or lifting it incorrectly can cause the unit to fall and harm the 
user and damage the workstation. To properly and safely lift the workstation, lift it from the bottom of the 
unit.

Read Cautions, Warnings and Safety Precautions
For your safety, you must review the “Important Safety Warnings” on page ix before accessing the 
components of the workstation. Also, review the Safety and Regulatory Guide that came with your 
workstation for more information.

WARNING! Avoid Burn Injuries. Some parts inside the computer will be hot. Turn off and unplug the 
system, then wait approximately three to five minutes for them to cool down before opening the system 
access panels or touching internal components.

Electrostatic Discharge Information
A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive 
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic 
device exposed to electrostatic discharge (ESD) might not appear to be affected at all and can work 
perfectly throughout a normal cycle. The device can function normally for a while, but it has been 
degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the discharge 
contains enough power to alter device parameters or melt silicon junctions.

Generating Static

The following table shows that:

Different activities generate different amounts of static electricity.

Static electricity increases as humidity decreases.

Table 4-1 Static Electricity

Relative Humidity

Event 55% 40% 10%

Walking across carpet
Walking across vinyl floor
Motions of bench worker

7,500 V
3,000 V
400 V

15,000 V
5,000 V
800 V

35,000 V
12,000 V
6,000 V

Removing bubble pack from PCB
Packing PCBs in foam-lined box

7,000 V
5,000 V

20,000 V
11,000 V

26,500 V
21,000 V
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Preventing Electrostatic Damage to Equipment

Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree 
of sensitivity. The following packaging and grounding precautions are necessary to prevent damage to 
electric components and accessories.

Transport products in static-safe containers, such as tubes, bags, or boxes to avoid hand contact.

Protect all electrostatic parts and assemblies with conductive or approved containers or packaging.

Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

Place items on a grounded surface before removing them from their container.

When handling or touching a sensitive component or assembly, ground yourself by touching the 
chassis.

Avoid contact with pins, leads, or circuitry.

Place reusable electrostatic-sensitive parts from assemblies in protective packaging or conductive 
foam.

Personal Grounding Methods and Equipment

Use the following equipment to prevent static electricity damage to equipment:

Wrist straps are flexible straps with a maximum of one-megohm ± 10% resistance in the ground 
cords. To provide a proper ground, wear the strap against bare skin. The ground cord must be 
connected and fit snugly into the banana plug connector on the grounding mat or workstation.

Heel straps, toe straps, and boot straps can be used at standing workstations and are compatible 
with most types of shoes or boots. On conductive floors or dissipative floor mats, use them on both 
feet with a maximum of one-megohm ± 10% resistance between the operator and ground.

Grounding the Work Area

To prevent static damage at the work area:

Cover the work surface with approved static-dissipative material. Provide a wrist strap connected to 
the work surface and properly grounded tools and equipment.

Use static-dissipative mats, foot straps, or air ionizers to give added protection.

NOTE 700 volts can degrade a product.

Table 4-2 Static Shielding Protection Levels

Method Voltage

Antistatic plastic
Carbon-loaded plastic
Metallized laminate

1,500
7,500
15,000

Table 4-1 Static Electricity
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Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate. 
Handle them only at static-free work areas.

Turn off power and input signals before inserting and removing connectors or test equipment.

Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.

Keep work area free of nonconductive materials, such as ordinary plastic assembly aids and 
Styrofoam.

Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended Materials and Equipment

Materials and equipment that are recommended for use in preventing static electricity include:

Antistatic tape

Antistatic smocks, aprons, or sleeve protectors

Conductive bins and other assembly or soldering aids

Conductive foam

Conductive tabletop workstations with ground cord of one-megohm ± 10% resistance

Static-dissipative table or floor mats with hard tie to ground

Field service kits

Static awareness labels

Wrist straps and footwear straps providing one-megohm ± 10% resistance

Material handling packages

Conductive plastic bags

Conductive plastic tubes

Conductive tote boxes

Opaque shielding bags

Transparent metallized shielding bags

Transparent shielding tubes

Tools and Software Requirements
Torx T-15 screwdriver or Flat-bladed screwdriver (can be used in place of the Torx screwdriver)

Diagnostics software

Screws
The screws used in the workstation are not interchangeable. They might have standard or metric threads 
and might be of different lengths. If an incorrect screw is used during the reassembly process, it can 
damage the unit. HP strongly recommends that all screws removed during disassembly be kept with the 
removed part, then returned to their proper locations.
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Special Handling of Components
The following components require special handling when servicing the workstation.

Cables and Connectors

Cables must be handled with care to avoid damage. Apply only the tension required to seat or unseat the 
cables during insertion or removal from the connector. Handle cables by the connector or pull strap 
whenever possible. In all cases, avoid bending or twisting the cables, and be sure that the cables are 
routed in such a way that they cannot be caught or snagged by parts being removed or replaced.

CAUTION When servicing this workstation, be sure that cables are placed in their proper location during 
the reassembly process. Improper cable placement can damage the workstation.

Hard Drives

Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This 
applies to failed drives as well as replacement spares.

If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective 
packaging and label the package “Fragile: Handle With Care.”

Do not remove hard drives from the shipping package for storage. Keep hard drives in their protective 
packaging until they are actually mounted in the workstation.

Avoid dropping drives from any height onto any surface.

If you are inserting or removing a hard drive, turn off the workstation. Do not remove a hard drive 
while the workstation is on or in Hibernate mode.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive, 
avoid touching the connector. For more information about preventing electrostatic damage, refer to 
“Electrostatic Discharge Information” on page 64.

Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields 
such as monitors or speakers.

Lithium Coin Cell Battery

The battery that comes with the workstation provides power to the real-time clock and has a minimum 
lifetime of about three years.

For instructions on battery removal and replacement, see the “Battery” section on page 94.

WARNING! This workstation contains a lithium battery. There is a risk of fire and chemical burn if the 
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in 
water or fire, or expose it to temperatures higher than 140 F (60 C).

CAUTION Batteries, battery packs, and accumulators should not be disposed of together with the 
general household waste.

Batterij niet
weggooien,

maar inleveren
als KCA.
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Pre-Disassembly Procedures
Perform the following steps before servicing the workstation:

1 Remove/disengage any security devices that prohibit opening the workstation. 

2 Close any open software applications.

3 Remove any diskette or compact disc from the workstation.

4 Exit the operating system.

5 Turn off the workstation and any peripheral devices that are connected to it.

6 Remove/disengage any security devices that prohibit opening the workstation. 

CAUTION Turn off the workstation before disconnecting any cables.

CAUTION The cooling fan is off only when the workstation is turned off or the power cable has been 
disconnected. The cooling fan is always on when the workstation is in the “On” or “Standby” modes. You 
must disconnect the power cord from the power source before opening the workstation to prevent 
system board or component damage.

7 Disconnect the power cord from the electrical outlet and then from the workstation.

8 Disconnect all peripheral device cables from the workstation.
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System Board Components
The following image shows the system board connectors and sockets on the HP Workstation xw6200.
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Table 4-3 System Board Components

1 MultiBay 10 Battery 19 Serial ATA 28 Rear chassis fans

2 Memory module pairs 11 Clear CMOS button 20 Serial ATA (primary) 29 Audio

3 Auxiliary power 12 Secondary IDE* 21 Trusted Platform 
Module

30 USB/network

4 Main power 13 Diskette drive 22 Front audio 31 USB

5 Processor power 14 Primary IDE** 23 Auxiliary audio 32 Serial

6 Processor 1 15 Password header 24 CD-ROM audio 33 Parallel

7 Processor 2 16 Front chassis fan 25 PCI Express x8 prime 34 PS2 Keyboard/mouse

8 Processor 1 fan 17 Front control panel 26 PCI 35 Hood lock (Smart Cover lock)

9 Processor 2 fan 18 Front USB 27 PCI Express x 16 
(graphics)

*The Secondary IDE connector is generally used for optical drives.
**The Primary IDE connector is generally used for hard drives
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System Board Architecture

The following image shows the HP Workstation xw6200 block diagram.
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Removal and Replacement of Components
This section discusses the procedures necessary to remove and install various hardware components 
on your workstation. Review the safety and precautions and the “Service Considerations” on page 64, as 
well as the Safety and Regulatory Guide, before servicing or upgrading your system.

1 Read all safety information and precautions.

2 Locate and clear a suitable work area.

3 Shut down the system and remove power from the unit.

4 Gather your tools.

5 Service your unit.

6 Restore power to your unit.

Disassembly Order
Use the following table to determine the sequence in which to remove the major components.

Pre-Disassembly (page 68)

Locks (page 72)1

Access Panel (page 74)

Hood Sensor (page 82)

Top Cover (page 76)2

Hood Lock (page 77)

Front Bezel (page 75)

Front Panel I/O Device Assembly 
(page 78)

Power Button and Front 
Speaker (page 79)

Optical Drive (page 96)

Diskette Drive (page 98)

Bezel Blanks (page 75)

System Fan Assembly 
(page 80)

Power Supply (page 81)

Memory (page 82)

Front Fan Removal 
(Optional) (page 93)

Battery (page 94)

Hard Drive (page 100)

CPU Heatsink (page 105)

Processor (page 108)

PCI Card Support (page 87)

PCI Retainer (page 88)

PCI or PCI Express card (page 90)

CPU Heatsink (page 105)

Processor (page 108)

System Board (page 110)

1. Some locks do not need to be removed before proceeding to the next step. For example, you only need to unlock 
the lock on the access panel before opening it.
2. The top cover can be removed anytime, but you must remove it after removing the access panel when removing 
the hood lock.
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Security Lock (Optional)
If a security padlock is installed, remove it before servicing the unit. To remove the padlock, unlock it and 
slide it out of the padlock loop as shown in the following image.

Cable Lock (Optional)
If a cable lock is installed, remove it before servicing the unit. To remove the cable lock, unlock it and pull 
it out of the cable lock slot as shown in the following image.
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Universal Chassis Clamp Lock (Optional)
If a universal chassis clamp lock is installed, remove it before servicing the unit. 

To remove the lock:

1 Unlock the device and remove the locking mechanism.

2 Remove the screw attaching the lock to the chassis.
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Access Panel
Before accessing the internal components of the workstation, the access panel must be removed. 

To remove the access panel:

WARNING! Before removing the workstation access panel, be sure that the workstation is turned off 
and that the power cord is disconnected from the electrical outlet.

1 Disconnect power from the system (page 68).

2 If necessary, unlock the access panel (page 72 or page 72). 

3 Pull up on the handle and lift off the cover.

To replace the access panel, slide the cover back on until it snaps into place.
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Front Bezel
To remove the bezel:

1 Lift up on the two 1 tabs located on the front bezel.

2 Rotate the front bezel away 2 from the chassis and remove the bezel.

Bezel Blanks
To remove the bezel blanks:

1 Disconnect power from the system (page 68) and remove the front bezel (page 75).

2 Remove the bezel blanks by squeezing in on the tabs and pushing the bezel blanks out.

1

2
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Top Cover

NOTE It is unnecessary to remove the top cover for most removal or replacement procedures.

1 Disconnect power from the system (page 68), remove the access panel (page 74), and remove the 
front bezel (page 75).

2 Push a flat screw driver into tab 1 on the rear of the chassis and gently pry the cover upward.

3 Push the top cover toward the back of the chassis and lift up.

Hood Sensor (Smart Cover Sensor) (Optional)
To remove the hood sensor:

1 Disconnect power from the system (page 68), remove the access panel (page 74), and lay the 
workstation on its side with the system board facing up.

2 Disconnect the white 1x3 hood sensor connector from the inline connector attached to the front panel 
harness.

3 Slide the hood sensor forward.

CAUTION Be careful when sliding the hood sensor forward. The hood sensor bracket and the chassis 
contain sharp edges that present a safety hazard.
76 REMOVAL AND REPLACEMENT PROCEDURES



C
ha

pt
er

 4
4 Push the hood sensor down and remove it from the chassis.

To replace the hood sensor, reverse the previous steps.

Hood Lock (Smart Cover Lock) (Optional)
To remove the hood lock:

1 Disconnect power from the system (page 68), remove the access panel (page 74), remove the top 
cover (page 76) and lay the workstation on its side with the system board facing up.

2 Using the FailSafe Key (included with the kit), remove the two tamper-resistant screws that secure 
hood lock to the chassis.

 

3 Disconnect the hood lock cable from the system board and remove the lock assembly. 

To install the hood lock, reverse the previous steps. 
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Front Panel I/O Device Assembly
1 Disconnect power from the system (page 68), remove the access panel (page 74), and remove the 

front bezel (page 75).

2 Unlatch the plastic snap that secures the cables inside the chassis and disconnect the front panel I/O 
device assembly cables from the system board.

3 Remove the screws that hold the front panel I/O device assembly and bracket to the chassis and 
remove the screws that hold the front panel I/O device assembly to the bracket.

4 Pull the front panel I/O device assemblyout about two inches away from the chassis.

5 Separate the bracket away from the front panel I/O device assembly.

WARNING! The next step requires the removal of cables through the chassis. Some edges on the 
chassis might be sharp. Be careful when removing these cables.

6 Slide the front panel cables through the chassis and out the front of the unit.

To replace the front panel I/O device assembly, reverse the previous steps.
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Power Button Assembly and System Speaker
The power button and the system speaker are part of the same assembly.

To remove the power button:

1 Disconnect power from the system (page 68), remove the access panel (page 74), remove the front 
bezel (page 75), and remove the front panel I/O device assembly (page 78).

2 Disconnect the power button assembly cable from the system board.

3 Disconnect the speaker wire and the hood sensor (if installed) from the in-line connectors on the 
power button assembly cable.

4 Remove the screw that secures the power button assembly to the chassis.

5 Pull the power button assembly away from the chassis.

6 Slide the power button assembly out from the front of the chassis.

To remove the speaker:

1 Disconnect the speaker cable from the in-line front panel I/O device assembly cable, if you have not 
already done so.

2 Slide the speaker away from the three flanges and remove it from the chassis.
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System Fan Assembly
To remove the system fan assembly:

1 Disconnect power from the system (page 68), remove the access panel (page 74), and lay the 
workstation on its side with the system board facing up.

2 Disconnect the fan plugs 1 from the system board.

3 Press in on the ribbed portion of the fan housing 2, rotate the fan housing down 3, and lift it out of the 
chassis.

This illustration shows the system fan with an airflow duct installed. This duct is only required on 
some systems. Refer to the next section for more information. 

To replace a system fan assembly, reverse the previous steps.

Airflow Duct

The airflow duct ships with certain DIMM configurations on this workstation. If your system did not ship 
with the duct from the factory, the duct is not required. 

CAUTION HP only ships DIMMs that are electrically and thermally compatible with this product. 
Because third-party DIMMs might not be electrically or thermally compatible, they are not supported by 
HP.

To install the airflow duct (if separated from the system fan assembly):

1 Install the duct by pushing the duct toward the fan and snapping it into place. The duct must be 
installed on the fan that is closest to the power supply. See the previous image for proper orientation.

1

2

1

3
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2 Reinstall the system fan assembly (page 80).

Power Supply
1 Disconnect power from the system (page 68), remove the access panel (page 74), remove the 

system fan assembly (page 80), and lay the workstation on its side with the system board facing up.

2 Disconnect the power supply from the system board.

3 Disconnect the optical drives, diskette drive, hard drives, and graphics card (select models only) from 
the power supply.

CAUTION Be sure you can differentiate which power cable was disconnected from the PCI Express x16 
graphics card and which power cable was disconnected from the system board. These two cables look 
very similar. The PCI Express power cable has a black connector and the power cable has a white 
connector. When power is present, you must NEVER connect the PCI Express power cable to the 
system board. If you do so, the system board may be damaged and your warranty voided. To see a 
picture of the PCI Express cable and where it must be connected, refer to the “PCI or PCI Express 
Installation” section on page 91.

4 Remove the four screws 1 from the back panel.

5 Slide the power supply toward the front and lift up 2 to remove it from the chassis.

To install the power supply, reverse the previous steps.

1

2
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Memory

Memory Module Features 

4 memory slots for DIMMS

256-MB, 512-MB, 1-GB and 2-GB pairs

8 GB maximum configuration (4 GB maximum on Windows and 16 GB maximum on Linux)

Supports single-channel or dual-channel DIMMs

Supports DDR2-400

No support for mirroring, no spare DIMM support

Standard ECC (72-bit ECC)

Enhanced ECC (x4 SDDC or 144-bit ECC) in dual-channel mode when all DIMMs are x4

DED retry

Memory Module Requirements

Use only industry-standard, registered, PC2-3200 DIMMs

Match DIMM pairs by size and type

No support for unbuffered memory

Removing Memory Module

1 Disconnect power from the system (page 68), remove the access panel (page 74), lay the 
workstation on its side with the system board facing up. If an airflow duct is installed, remove the 
system fan assembly (page 80) to gain access to the DIMMs. 

CAUTION To ensure that memory modules are not damaged during removal or installation, power off 
the workstation and unplug the power cord from the AC power outlet. Wait until the LED on the back of 
the power supply turns off before removing memory. If you do not unplug the power cord while installing 
memory, your memory modules might be damaged and the system will not recognize the memory 
changes.

2 Gently push outwards on the socket levers.
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3 Lift the DIMM straight up and remove it from the unit.

NOTE DIMMs and the DIMM sockets are keyed for proper installation. Be sure these guides line up 
when installing a DIMM.

Installing Memory Module

CAUTION HP only ships DIMMs that are electrically and thermally compatible with this product. 
Because third-party DIMMs might not be electrically or thermally compatible, they are not supported by 
HP.

You must load memory modules in valid configurations: 

Load DDR SDRAM as matched pairs. For example, if you place a memory module of 1 GB in slot 1, 
you must also insert a 1-GB module in slot 2.

Load the memory module pairs in order of size, from smallest to largest, beginning with memory 
module pair A (closest to serial port). For example, if you have 1.5 GB of memory composed of two 
256-MB modules and two 512-MB modules, load the 256-MB modules in memory module pair A and 
the 512-MB modules in pair B.

Install the DIMM in socket 1 if only installing one DIMM.

Install the first matched DIMM pair in socket set A.

Install subsequent matched DIMM pairs in set B (farthest from serial port).

1
2A

3
4 B

SIDE CLOSEST TO SERIAL PORT
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The BIOS generates warnings/errors on invalid memory configurations.

In DDR2 mode, dual-rank DIMMs are placed farther from the Memory Controller Hub (MCH) than 
single-rank DIMMs.

If there is no way to obtain a valid memory configuration by disabling some of the plugged-in memory, 
the BIOS will halt with a diagnostics 2004 code for memory error (4 beeps/blinks).

If the BIOS can find a valid memory configuration by disabling some of the plugged-in memory, it will 
do so and will report a warning during POST (“215-mismatched memory”). The system can still be 
booted in this condition.

To install a DIMM:

1 Disconnect power from the system (page 68), remove the access panel (page 74), lay the 
workstation on its side with the system board facing up. If an airflow duct is installed, remove the 
system fan assembly (page 80) to gain access to the DIMMs. 

2 Gently push outwards on the socket levers.

3 Lower the DIMM straight down and be sure the socket levers secure the module into place.
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Peripheral Component Interconnect (PCI) Slots

Table 4-4 PCI Slot Types

Slot Type Ref

1 PCI Express x16 J41

2 PCI J23

3 PCI J20

4 PCI J21

5 PCI J22

6 PCI Express x4 J31

Table 4-5 PCI Device List

Device Bus# Dev# Fn#

MCH 0 0 0

MCH Errors 0 0 1

MCH EXP A (Slot 1) 0 2 0

MCH EXP A1 (NIC) 0 3 0

MCH EXP B (Slot 2) 0 4 0

MCH Test Overflow 0 8 0

ICH5 USB #1 0 29 0

ICH5 USB #2 0 29 1

ICH5 USB #3 0 29 2

ICH5 USB #4 0 29 3

ICH5 USB 2.0 0 29 7

1 2 3 4 5 6
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ICH5 PPB (PCI slots) 0 30 0

ICH5 LPC 0 31 0

ICH5 IDE 0 31 1

ICH5 SATA 0 31 2

ICH5 SMBus (1) 0 31 3

ICH5 Audio 0 31 5

ICH5 Modem (2) 0 31 6

Broadcom PCI Express NIC 1 0 0

Slot 3 (PCI) 2 4 0

Slot 4 (PCI) 2 9 0

Slot 5 (PCI) 2 10 0

Slot 2 (PCI) 2 11 0

Slot 6 (PCI Express x4 EXP A) 32 0 0

Slot 1 (PCI Express x16 EXP B) 64 0 0

Table 4-5 PCI Device List

Device Bus# Dev# Fn#
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PCI Card Support

For added protection, some cards have PCI holders installed to prevent movement during shipping.

REMOVING CARD SUPPORT

1 Disconnect power from the system (page 68), remove the access panel (page 74), and lay the 
workstation on its side with the system board facing up.

2 For short or tall PCI cards, press down on the holder arm 1 while lifting up on the other side of the 
arm 2.

INSTALLING CARD SUPPORT

1 Disconnect power from the system (page 68), remove the access panel (page 74), and lay the 
workstation on its side with the system board facing up.

2 Attach the card support arm on different sides of the chassis slots depending on if supporting a short 
or tall card. Use the following images as a guide and also the imprint on the card support arm.

For short cards, attach the lip of the support arm over the chassis slot 1 and pull the lower part of 
the arm over the PCI retainer 2.

For tall cards, attach the lip of the support arm under the chassis slot 1 and pull the lower part of 
the arm over the PCI retainer 2.

1
1

2

2

1

1

2

2
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PCI Retainer

1 Disconnect power from the system (page 68), remove the access panel (page 74), and lay the 
workstation on its side with the system board facing up.

2 Open the PCI retainer by pressing down on the two green clips at the ends of the retainer and 
rotating the retainer towards the back of the system.
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PCI Express

PCI Express is a new hardware interconnect standard (for example, I/O slots). PCI Express is a point-to-
point architecture and uses a serial data transmission protocol. A single PCI Express lane consists of 4 
wires and is capable of transmitting 250 MB/sec in a single direction or 500 MB/sec in both directions 
simultaneously. This bandwidth is not affected by what is happening on other PCI Express buses or 
legacy PCI/PCI-X buses (provided that total bandwidth can be handled by the CPU and the memory 
subsystem.) The transmission protocol is somewhat similar to that used for a LAN connection and 
contains error correction and detection, packet addressing and other network features. 

PCI Express improves system attributes. PCI Express enables a low-power, scalable, high-bandwidth 
communication path with a small number of connections (wires) compared to traditional parallel 
interfaces (e.g. PCI).

The PCI Express IO slots can support other PCI Express cards with lesser bus bandwidth than what is 
physically defined for the slot. Use the following table to determine compatibility.

For example, a PCI Express x8 card does not work in a PCI Express x1 slot, but a PCI Express x1 card 
works in a PCI Express x8 slot.

NOTE The HP Workstation xw6200 contains one PCI Express x8 slot that supports x4 bandwidth. If a 
PCI Express x8 card is plugged into the PCI Express x8 slot, the card runs at x4 bandwidth.

Table 4-6 PCI Express Compatibility Matrix for xw6200

PCI Express x1 Slot 
(not available)

PCI Express x4 Slot
(not available)

PCI Express x8 Slot PCI Express x16 Slot

PCI Express x1 
Card

Y Y Y Y

PCI Express x4 
Card

N Y Y N

PCI Express x8 
Card

N N Y N

PCI Express 
x16 Card

N N N Y
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PCI or PCI Express Removal

1 Disconnect power from the system (page 68), remove the access panel (page 74), lay the 
workstation on its side with the system board facing up, remove the PCI retainer (page 88), and 
remove PCI card support (page 87), if necessary.

2 Lift the PCI levers by first pressing down on them and then out.

3 Lift the PCI card out of the chassis. If removing a PCI Express card, remove the power supply cable 
(not illustrated), if required, and move the “hockey stick” lever to release the card and lift it out of the 
chassis. Store the card in an anti-static bag.

4 Close the PCI levers.

Figure 4-1 PCI Removal Figure 4-1 PCI Express Removal
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PCI or PCI Express Installation

1 Disconnect power from the system (page 68), remove the access panel (page 74), lay the 
workstation on its side with the system board facing up, and remove the PCI retainer (page 88).

2 Lift the PCI levers 1 by first pressing down on them and then out.

3 Remove the PCI slot cover 2.

4 Lower the PCI 3 or PCI Express 3 card into the chassis. Verify that the keyed components of the card 
align with the socket. If installing a PCI Express card, plug in the power supply cable, required.

5 Close the PCI levers. If the PCI levers do not close, be sure all cards are properly seated and then try 
again.

6 If installing a PCI Express card, plug in the power supply cable, if required.

Figure 4-2 PCI Installation Figure 4-2 PCI Express Installation

1 2

3
3

4

4

5

1

2
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IEEE-1394 (Optional)
To install an optional IEEE-1394 adapter:

1 Disconnect power from the system (page 68), remove the access panel (page 74), and lay the 
workstation on its side with the system board facing up.

2 Install the IEEE-1394 card into the PCI socket.

3 Close the PCI levers 1.

4 Connect the power cable 2 into the card.

5 Connect the front panel IEEE-1394 cable 3 into to the card.

13

2
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Front Fan Removal (Optional)
1 Disconnect power from the system (page 68), remove the access panel (page 74), and lay the 

workstation on its side with the system board facing up.

2 Disconnect the connector 1 from the header on the system board.

3 Unsnap the fan housing from the chassis and lift it out of the workstation.

4 Remove the fan from the fan housing by applying outward pressure on the fan housing while lifting 
the fan away.

To install the front fan, reverse the previous steps. When installing the fan, it must blow toward the rear of 
the chassis, so be sure that the airflow direction arrow on the side of the fan housing faces the rear of the 
chassis. 
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Battery

CAUTION Before removing the battery, be sure your CMOS settings are backed up as all CMOS 
settings are lost when the battery is removed. To back up the CMOS settings, use Computer Setup and 
run the Save to Diskette option from the File menu.

1 Disconnect power from the system (page 68), remove the access panel (page 74), and lay the 
workstation on its side with the system board facing up.

2 On the system board, press on the release tab of the battery holder.

3 Rotate the battery enough to get beyond the latch and lift it straight up.

To install the battery slide the battery back in until it snaps back into place.
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Power Connections to Drives
For help in identifying power cables, refer to the following information. Route or tie cables so that there is 
no possible way for them to interfere with the CPU heatsink fans. 

CAUTION Be sure you can differentiate which power cable connects to the PCI Express x16 graphics 
card and which power cable connects to the system board. These two cables look very similar. The PCI 
Express power cable has a black connector and the power cable has a white connector. When power is 
present, you must NEVER connect the PCI Express power cable to the system board. If you do so, the 
system board may be damaged and your warranty voided. To see a picture of the PCI Express cable and 
where it must be connected, refer to the “PCI or PCI Express Installation” section on page 91.
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Optical Drive 
1 Disconnect power from the system (page 68), remove the access panel (page 74), and remove the 

front bezel (page 75).

2 Disconnect the power, drive, and audio cables from the drive. The connector colors may be different 
than illustrated.

NOTE The audio cable is only required for Linux-based systems. 

3 Lift the green drivelock release lever and gently slide the drive out of the chassis.
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To replace an optical drive:

1 Lift the green drivelock release lever while sliding the optical drive into the bay. When the optical drive 
is partially inserted, release the drivelock release lever and slide the drive completely into the bay 
until the drive is secured. 

CAUTION Ensure that the optical drive is secure. Failure to do so can cause damage to the drive when 
moving the workstation.

2 Connect the power, drive, and audio (if required) cables to the drive and workstation.

NOTE The audio cable is only required for Linux-based systems. 

If you are installing more than one optical drive, route the cable as in the following image.

NOTE The optical drive cable is routed under the system board.

Replacing Optical Drive Cable

The optical IDE cable is routed behind the system board.

1 Disconnect power from the system (page 68), remove the access panel (page 74), lay the 
workstation on its side with the system board facing up, remove all expansion boards and graphics 
cards (page 90), remove the CPU heatsinks (page 105), disconnect the optical IDE cable from the 
system board, and remove the system board (page 110).

2 Remove the plastic ties and tape from the IDE cable, then remove the IDE cable

3 Replace the cable and cable ties. Refer to the previous image for cable routing information.
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Diskette Drive (Optional)
To remove a diskette drive:

1 Disconnect power from the system (page 68), remove the access panel (page 74), and remove the 
front bezel (page 75).

2 Disconnect the cables from the back of the diskette drive.

3 While lifting the green drivelock release tab, slide the drive forward out of the chassis. 
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To replace an optional diskette drive:

1 While lifting the green drivelock release tab, slide the drive forward into the chassis. 

2 Route the diskette drive data cable between the system board and the hard drive cage. Your cable 
might look different than the one shown.

CAUTION The cable must stay between the system board and the hard drive cage. It might be 
necessary to push the cable down so that it catches on the system board. This routing method is 
important because you do not want to interfere with the CPU heatsink fans or block airflow.

3 Connect the cables from the back of the diskette drive.
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Hard Drive
For more information on SATA hard drives and the SATA RAID configuration, see Appendix B, “SATA 
Devices,” on page 155.

Removing a Hard Drive

1 Disconnect power from the system (page 68) and remove the access panel (page 74).

2 Disconnect the cables from the back of the hard drive.

3 Push in on the green drivelock release tabs and slide the hard drive out of the chassis.

Installing a Hard Drive

This section describes how to install SCSI and SATA hard drives.

“Installing a SCSI hard drive” section on page 100

“intalling a SATA hard drive” section on page 103

INSTALLING A SCSI HARD DRIVE

For more information on SCSI hard drives, see Appendix B, “SCSI Devices,” on page 151.

Before installing a SCSI hard drive on your system, you must give the hard drive a unique SCSI ID.

All SCSI controllers require a unique SCSI ID (0–15) for each SCSI device that is installed. The reserved 
and available SCSI ID numbers are displayed in the following list:

0 is reserved for the primary hard drive (not reserved for the primary hard drive on Linux).

7 is reserved for the SCSI controller.

1 through 6 and 8 through 15 are available for all other SCSI devices.

When 0 is used for the primary hard drive, set the second hard drive to 1, the third to 2, and so on.

To set the SCSI ID on a drive, see the instructions on top/back of the hard drive for the correct jumper 
settings. The drive probably displays a diagram of the jumper block. This diagram shows you which 
blocks to cover with your jumper to get the desired ID.
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For example, if the drive must be set to 3, the drive might show that the 4 ID bits are at the far left of the 
connector (ID0, ID1, ID2, and ID3), then using the jumpers provided, cover each block to set the SCSI 
ID.

After you have given the hard drive a unique SCSI ID, you can install the hard drive into your system.

1 Select a drive bay in which to install the drive. If installing more than one hard drive, use the hard 
drive order in the following image.

If installing the hard drive into the 5.25-inch bay, you must install the optional bracket (page 104).

2 Simultaneously disengage the green tabs of the rail assembly and slide the rails out of the empty bay. 

3 Attach the rails to the hard drive by first inserting the hard drive rail assembly pins into one side of the 
hard drive screw holes. Next, gently flex open the opposite side of the hard drive rail assembly and 
insert the remaining pins into the holes in the hard drive. If installing the hard drive into the 5.25-inch 
bay, skip this step.

3

2

1
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4 Push the drive into the selected bay until it snaps into place. Then attach the power and SCSI cable 
to the drive.

5 Insert the SCSI controller card into an available PCI expansion slot (page 91).

6 Connect the SCSI cable to the SCSI controller card.

7 Connect the hard drive LED cable to the SCSI card and to the system board. The LED header 
location is available on the system board image on the access panel. 

The hard drive cable might have extra connectors for other hard drives, but for clarity those 
connectors have been omitted in the following image.
102 REMOVAL AND REPLACEMENT PROCEDURES



C
ha

pt
er

 4
INTALLING A SATA HARD DRIVE

For more information on SATA hard drives and the SATA RAID configuration, see Appendix B, “SATA 
Devices,” on page 155.

1 Select a drive bay in which to install the drive. Squeeze the green tabs and slide the rails out of the 
empty bay.

2 Attach the rails to the hard drive by aligning the notches with the holes and squeezing it into place 
(see image on page 101).

3 Push the drive into the selected bay until it snaps into place. 

4 Attach the power cable and data cable to the drive.

5 Connect the data cable to the serial ATA port.
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Installing a Hard Drive into the 5.25-Inch Bay (Optional)

If you want to install a hard drive into a 5.25-inch bay, you must install an optional bracket.

1 Lower the hard drive into the bracket and secure the drive by inserting four #6-32 screws (shipped 
with this kit) through the holes in the sides of the bracket and into the threaded holes in the hard 
drive. 

2 Insert the hard drive into the 5.25-inch optical drive bay.

3 After inserting the hard drive into the bay, secure the hard drive to the chassis by inserting one M3 
screw (shipped with the bracket kit) into the available opening on the side of the optical drive bay.

4 To complete the installation, follow the instructions for installing your type of hard drive (page 100 or 
page 103).
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Processor Heatsink

Removing the CPU Heatsink

NOTE The following illustrated CPU heatsink is typical of what you might have in your workstation. Be 
aware that different variations of the CPU heatsinks exist, but the overall procedures listed are sufficient 
to assist you in removing the CPU heatsink.

1 Turn on the workstation and enter Computer Setup (F10) (page 35). Let the workstation run in this 
mode for five minutes. 

This action warms the thermal interface material between the CPU heatsink and processor so that 
the thermal bond loosens and can more easily be broken. 

CAUTION If you remove the CPU heatsink while the thermal pad is cold, you could lift the processor out 
of the socket, even if the socket is closed. This could damage the processor and the processor socket. 

NOTE Windows in idle state does not provide sufficient heat to warm the compound.

2 After warming the thermal interface, quickly shut down the system, disconnect power from the 
system (page 68), remove the access panel (page 74), and lay the workstation on its side with the 
system board facing up.

3 Remove the four processor screws slowly, making sure to loosen all the screws evenly. Loosen one 
pair of diagonally opposite screws 1 until the screw shanks disengage from the system board, then 
loosen the remaining pair 2. Do not fully loosen one screw, then move on to the next. Loosen all of 
the screws a little at a time, making sure the processor remains level.

4 Disconnect the CPU heatsink fan connector 3 from the system board.

1

12

2
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5 Before lifting the heatsink, carefully break the adhesive compound between the CPU heatsink and 
processor by rotating the heatsink back and forth.

6 Use alcohol and a soft cloth to clean all of the thermal interface material residue from the CPU 
heatsink and processor.

CAUTION Allow the alcohol on the processor and CPU heatsink to dry completely.

Replacing the CPU Heatsink

1 Disconnect power from the system (page 68), remove the access panel (page 74), and remove the 
CPU heatsink (page 105).

2 Use alcohol and a soft cloth to clean all of the thermal interface material residue from the CPU 
heatsink and processor.

CAUTION Allow the alcohol on the processor and CPU heatsink to dry completely.

3 Apply the thermal grease to center of the processor. 

4 Place the CPU heatsink on top of the processor and align the four mounting screws with the holes 1 
in the system board.

NOTE If both CPU heatsinks were removed, be sure all system board standoffs engage with the 
keyholes in the chassis, be sure the system board connectors engage correctly with the rear I/O panel, 

3
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and push back on the system board while engaging the CPU heatsink screws with the chassis standoffs. 
You only need to push back when trying to engage the first screw. 

5 Screw in the four CPU heatsink screws. First, tighten all of the screws partially so that the CPU 
heatsink remains level. Next, fully tighten one pair of diagonally opposite screws 1 then fully tighten 
the remaining pair 2. Tighten firmly to a torque setting of 6 in-lbs.

6 Connect the CPU heatsink fan connector to the system board.

1
Step 6

1

12

2
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Processor

Removing the Processor

1 Disconnect power from the system (page 68), remove the access panel (page 74), and remove the 
CPU heatsink (page 105).

2 Raise the processor socket handle fully (the full swing angle of the lever is approximately 135 
degrees).

3 Pull the processor straight out of the socket.

CAUTION Handle the processor carefully. To avoid bending the processor pins, keep the processor 
perfectly flat when removing and storing it.
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NOTE Store the processor in a safe place where it will not be damaged.If you are permanently removing 
a second processor, check your OS documentation to determine if you should change any OS settings to 
disable multiprocessor support or enable Hyper-Threading support. 

Replacing the Processor

1 Disconnect power from the system (page 68), remove the access panel (page 74), remove the CPU 
heatsink (page 105), and remove the processor (page 108).

2 Raise the processor socket handle fully (the full swing angle of the lever is approximately 135 
degrees).

CAUTION Processor pins are delicate and bend easily. Use extreme care when placing the processor in 
the socket.

3 Line up the triangle on the top of the processor with the triangle on the corner of the processor socket 
and install the processor into the socket. Ensure that the underside of the processor is level with the 
top of the processor socket. Lightly press down on the top of the processor while closing the socket 
lever.

 

4 Check for proper processor seating in the socket by carefully trying to lift the processor out of the 
socket with your fingers. A properly seated processor does not lift out of the socket.
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System Board
To remove the system board:

1 Disconnect power from the system (page 68), remove the access panel (page 74), lay the 
workstation on its side with the system board facing up, remove all expansion boards and graphics 
cards (page 90), remove the CPU heatsink (page 105), and if an airflow duct is installed, remove the 
system fan assembly (page 80).

2 Disconnect all cabling from the system board.

CAUTION Be sure you can differentiate which power cable was disconnected from the PCI Express x16 
graphics card and which power cable was disconnected from the system board. These two cables look 
very similar. The PCI Express power cable has a black connector and the power cable has a white 
connector. When power is present, you must NEVER connect the PCI Express power cable to the 
system board. If you do so, the system board may be damaged and your warranty voided. To see a 
picture of the PCI Express cable and where it must be connected, refer to the “PCI or PCI Express 
Installation” section on page 91.

NOTE Make note of the cable connections before disconnecting them from the system board. Refer to 
“Power Connections to Drives” section on page 95 for more information.

3 Slide the system board forward 1 to disengage the plastic mounting standoffs from the chassis.

4 Lift the system board out 2 of the chassis, being careful not to damage the cables and rear panel 
connectors.

To replace the system board:

1 Insert straight down and make sure all system board standoffs engage with the keyholes in the 
chassis.

NOTE Be sure the system board connectors engage correctly with the rear I/O panel.

1

2
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2 Push back while maintaining downward pressure on the board, so all standoffs remain engaged.

NOTE You only need to push back while engaging the first screw.

WARNING! The system board is not secure until the CPU heatsinks are installed. 

3 Install the heatsink (page 106).
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Chapter 5 System Diagnostics and 
Troubleshooting

This chapter discusses the tools available for diagnosing and troubleshooting system issues.

“E-Support” on page 114

“Troubleshooting Checklist” on page 114

“LED Color Definitions” on page 115

“HP Insight Diagnostics Offline Edition” on page 115

“Diagnostic Error Codes” on page 121

“Troubleshooting Scenarios and Solutions” on page 123

“Power On Self Test (POST) and Error Messages” on page 143
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E-Support

Help & Support Center (HSC) and E-Support
HSC provides online access to technical support information, software updates and downloads, 
diagnostic tools, and HP support contact information.

To open HSC from your desktop, click Start>Help and Support.

HSC contains four sections:

HP Product Information (requires Internet access)—Links to the HP Technical Support Website for 
your product. You can access all related documentation, downloads and updates, tools, and more.

HP Software & Driver Downloads (requires Internet access)—Links to HP-specific software 
downloads and updates.

HP Support Tools (requires Internet access)—Links to self-help tools and diagnostics offered by HP 
Instant Support Professional Edition.

Contact HP for Support (option available that does not require Internet access)—Provides two 
different options:

Chat with an expert online (requires Internet access)—Provides a tool to communicate with a 
support specialist online through Active Chat.

Call a support agent—Provides hardware details about the workstation and HP support contact 
phone number worldwide.

Troubleshooting Checklist
Before running any of the diagnostic utilities, go through the following checklist to find possible solutions 
for workstation or software problems.

Are the workstation and monitor connected to a working electrical outlet?

Is the workstation turned on?

Is the green power light illuminated?

Is the monitor turned on?

Is the green monitor light illuminated?

Turn up the monitor brightness and contrast controls if the monitor is dim.

Press and hold any key. If the system beeps, then the keyboard is operating correctly.

Check all cables for loose or incorrect connections.

Reconfigure the workstation after installing a non-PnP expansion board or other option, such as a 
diskette drive.

Are all of the necessary device drivers installed?

Have all printer drivers been installed for each application?

Remove all diskettes and CDs from the drives before you turn on the system.

Are you running the latest BIOS version, drivers, and/or software updates?
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LED Color Definitions
An LED light exists on the front panel of your workstation. The following table describes what each color 
signifies. 

HP Insight Diagnostics Offline Edition
The diagnostics utility enables you to perform testing and to view critical computer hardware and 
software configuration information from various sources. This utility allows you to:

Run diagnostics.

View the hardware configuration of the system.

Key Features and Benefits
HP Insight Diagnostics simplifies the process of effectively identifying, diagnosing, and isolating the 
hardware issues.

In addition to robust management tools, service tools can be invaluable in quickly resolving system 
problems. To streamline the service process and resolve problems quickly, it is necessary to have the 
right information available at the time that a service call is placed. The primary information requirement, 
which is also the one that provides the greatest insight into potential system issues, is the configuration 
of the system. Insight Diagnostics helps provide higher system availability. Typical uses of the Insight 
Diagnostics are:

Testing and diagnosing apparent hardware failures

Documenting system configurations for upgrade planning, standardization, inventory tracking, 
disaster recovery, and maintenance

Sending configuration information to another location for more in-depth analysis

Theory of Operation
Insight Diagnostics Offline Edition operates in offline mode only. The operating system is not running and 
software information from the system is not available to the diagnostics.

Offline Survey is available to display the current system configuration.

The Insight Diagnostics Test feature provides the capability to test functionality of all the major hardware 
components in the system. The Test feature is designed to be flexible to enable the user to customize 
test selections by providing different modes and types of testing.

Table 5-1 LED color definitions

LED State LED Color System Status

Solid Green System is on.

Blinking Green System is in Standby.

Solid or Blinking Red System has error. Refer to “Diagnostic 
Light Codes” on page 121

None No light System is in Hibernate or it is off.
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A Quick Test provides a predetermined script where a sample of each hardware component is exercised 
and requires no user intervention.

A Complete Test provides a predetermined script where each hardware component is fully tested. You 
can select Interactive or Unattended tests. This will change the devices tested during the Complete Test. 
There are more tests available in the interactive mode, but these require user intervention.

A Custom Test provides the most flexibility in controlling the testing of a system. The Custom Test mode 
enables the user to specifically select which devices, tests, and test parameters are run. Users are 
provided the ability to select tests that do not require any user interaction through the Interactive and 
Unattended tests modes.

Diagnostic Utility on CD
HP Insight Diagnostics is available on the Documentation Library CD that was shipped with your 
workstation.

To start the diagnostic utility on the Documentation Library CD:

1 Turn on your workstation and press the F10 key during the initial boot process to enter the Computer 
Setup (F10) Utility (page 35).

2 Select your language from the list and press the Enter key. In the Computer Setup Utilities menu, 
four headings are displayed: File, Storage, Security, and Advanced.

3 Use the right arrow key to select Storage. Use the down arrow key to select Boot Order, then press 
Enter.

4 Select CD-ROM Drive and enable it as a bootable device by pressing the F5 key (if not already 
enabled, pressing the F5 key again disables the device).

5 Set the CD-ROM Drive to the top of the boot order. To do this, select CD-ROM, press the Enter key, 
and use the up arrow to move it to the top of the boot order.

6 To apply and save changes, press the F10 key, and select File>Save Changes and Exit.

7 Insert the Documentation Library CD into the workstation.

8 Restart your system and HP Insight Diagnostics launches automatically.

Download the ISO Image
To download the latest diagnostic utility:

1 Visit http://www.hp.com.

2 Click the Support & Drivers link.

3 Click the Download driver and software radio button.

4 Enter your product number (for example, xw6200) in the text box and press the Enter key.

5 Select your OS.

6 Click the Diagnostic link.

7 Locate HP Insight Diagnostics and click Download.
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User Interface

NAVIGATION

The Insight Diagnostics home page contains the following tabs: Survey, Test, Status, Log, and Help. 
These tabs separate the major functions of Insight Diagnostics.

SURVEY TAB

When the Survey tab is selected, the Survey menu displays and enables you to view important system 
configuration information. The Summary view limits the amount of data displayed, while the Advanced 
view shows all the data in the selected category. Regardless of whether you choose Advanced or 
Summary, the following categories of information are available on the Survey menu:

Overview—The Overview view gives you a listing of general information about the computer.

All—The All view gives a listing of all information about the computer.

Architecture—The Architecture view shows the type of bus the computer uses. In addition, if the bus is 
PCI, information about the PCI configuration is displayed.

Asset Control—The Asset Control view shows the serial number of the computer (system identification 
number).

Communication—The Communication view shows information about the computer parallel (LPT) and 
serial (COM) port settings, USB, and network controller information.

Graphics—The Graphics view shows information about the graphics subsystem of the computer. This 
includes information about the graphics card, mode, and ROM.

Input Devices—The Input Devices view shows information about the type of keyboard, mouse, and 
other input devices connected to the computer.

Internal Conditions—The Internal Conditions view shows information about the health of the computer. 
This includes fan, temperature, and power-supply information.

Memory—The Memory view shows information about all memory in the computer. This includes 
memory on the board and any memory modules installed.

Miscellaneous—The Miscellaneous view shows information obtained from the computers configuration 
memory (CMOS), BIOS data area, Interrupt Vector table, and diagnostics component information.

Multimedia—The Multimedia view shows information about all multimedia devices in the computer. This 
includes audio devices installed.

Resources—The Resources view shows the system device resource usage information. This includes 
information about I/O, memory, IRQ, slot, and bus usage.

Storage—The Storage view shows information about storage media connected to the computer. This list 
includes all fixed disks, floppy drives, and CD-ROM drives.

System—The System view shows product type, processor type and speed, and coprocessor 
information. Also shown in this display is information about all ROMs in the computer.

TEST TAB

The Insight Diagnostics utility provides the capability to test all the major pieces of hardware in the 
system. You can select from several types of tests: 

Quick Test—Provides a predetermined script where a sample of each hardware component is exercised 
and requires no user intervention.
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Complete Test—Provides a predetermined script where each hardware component is fully tested. You 
can select Interactive or Unattended tests. This will change the devices tested during the Complete 
Test. There are more tests available in the interactive mode, but these require user intervention.

Custom Test—Provides the most flexibility in controlling the testing of a system. The Custom Test mode 
allows the user to specifically select which devices, tests, and test parameters are run. Users are 
provided the ability to select tests that do not require any user interaction through the Interactive and 
Unattended test modes.

To begin testing:

1 Select the Test tab. 

2 Select the Type of Test to perform and then select the Test Mode, either Interactive or Unattended. 

3 Choose how you want the test to be executed, either Number of Loops or Total Test Time.

When choosing to run the test over a specified number of loops, enter the number of loops to 
perform. If you desire to have the diagnostic test for a specified time period, enter the amount of time 
in minutes.

NOTE Testing will automatically stop, if one test loop has been completed, when the elapsed test time 
has reached the specified time limit.

4 Click Begin Testing to start the test.

While tests are being performed, the user can monitor the progress by viewing the Status tab. Any 
errors that are detected are summarized in the Error Log. Select the Print button to print or save the 
report. 

If the diagnostics utility detects an error during a test, the user can mouse-over the failed text in the 
Status tab to display additional information for the type of error and the error code. 

To view all test failure information, select the Error Log. To view the status of all testing that has been 
performed, select the Log tab.

STATUS TAB

The Status tab displays the status of the selected tests. The type of test executed (for example, Quick, 
Complete, Custom) is displayed. The main progress bar displays the percent complete of the current 
set of tests. While testing is in progress a Cancel testing button, which will cancel the test job, is 
displayed.

After testing has completed the Cancel testing button is replaced with two buttons, Select New Tests 
and Retest. The Select New Tests button allows you to go back to the previous test selection page to 
select a new set of tests. The Retest button will retest the last set of tests executed. This enables you to 
re-run the set of tests without having to go back to the test selection page. 

The Status page also shows:

The devices being tested.

The tests that are running.

The overall elapsed time.

The individual elapsed test times.

The condition status of each test.
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LOG TAB

The Log tab consists of three views.

Test Log—Displays all tests that have been executed, number of times of execution, number of times 
the test failed, and the time it took to complete the test. The Clear Test Log button will clear the contents 
of the Test Log.

Error Log—Displays the tests that have failed during the diagnostic testing. Besides displaying the 
device and test this section might also include error details. The description section describes the error 
that the diagnostic test found. The Recommended Repair will give a recommended action that should be 
performed to resolve the failed hardware. The error count is the number of times the test has failed. The 
Clear Error Log button will clear the contents of the Error Log.

TEST COMPONENTS

Hardware and software tests can be performed on the following components:

Audio—Identifies all audio devices installed in a system, captures any associated configuration 
information, and provides the ability to verify proper operation of these devices.

CPU—Identifies all processors installed in a system, captures any associated configuration 
information, and provides the ability to verify proper operation of these devices.

Inspect—Captures general system configuration information.

Keyboard—Identifies the keyboard installed in a system and provides the ability to verify proper 
operation of this device.

Memory—Identifies all memory modules installed in a system, captures any associated configuration 
information, and provides the ability to verify proper operation of these modules.

Modem—Identifies all modem devices installed in a system, captures any associated configuration 
information, and provides the ability to verify the proper operation of these devices.

Mouse—Identifies the mouse installed in a system and provides the ability to verify proper operation 
of this device.

Network—Identifies all network devices installed in a system, captures any associated configuration 
information, and provides the ability to verify proper operation of these devices. NIC testing is only 
performed if drivers are installed during discovery.

Parallel Port—Identifies all parallel devices installed in a system and captures any associated 
configuration information. If the parallel port is properly configured and the information is available to 
the operating system, the associated DMA, IRQ, and I/O ports are reported. This test component also 
provides the ability to verify proper operation of these devices.

PCI Bus—Identifies all PCI devices installed in a system and provides the ability to verify proper PCI 
I/O operation to the devices.

Serial Port—Identifies all serial devices installed in a system, captures any associated configuration 
information, and provides the ability to verify proper operation of these devices.

Storage—Identifies storage devices connected to a system through IDE, USB, SCSI, or a Fibre 
Channel network. Supported devices include:

IDE hard disk drives

USB disk drives

SATA disk drives
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SCSI disk drives

SCSI tape drives

SCSI controllers

RAID controllers

Controllers can be connected to the host through PCI, I2C, or serial port. The component also 
captures any associated configuration information, and provides the ability to verify proper operation 
of these devices.

Stress—Provides a solution for stress testing hardware in a system.

USB—Identifies all USB devices installed in a system, captures any associated configuration 
information, and provides the ability to verify proper operation of these devices.

Graphics—Identifies all graphic devices installed in a system, captures any associated configuration 
information, such as the ASIC and monitor types, and provides the ability to verify proper operation of 
these devices.

A list of available tests for each test component and a list of error codes can be accessed through the 
Test Component and Error Codes menu selections on the Help tab menu bar.
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Diagnostic Error Codes
This sections provides an overview of the diagnostic lights and error codes that are related to your 
workstation.

Diagnostic Light Codes

NOTE The beeps are heard through the on-board piezo speaker and not the chassis speaker. The 
blinking lights and beeps repeat for five cycles. After that, only the blinking lights repeat.

Table 5-2 Diagnostic Light Codes

Chassis Indicator Lights

Power LED and Sound 
Activity

Diagnosis and Service Action

None System does not power on
Press power button. If HDD LED = GREEN, then:

1 Remove expansion cards one at a time.

2 Replace the system board.

OR

Press power button. If HDD LED does not illuminate, then:

1 Check that the unit is plugged into a working AC outlet.

2 Open access panel and check that the power button harness is properly 
connected to the in-line front panel I/O device assembly connector.

3 Check that the power supply cables are properly connected to the system board.

4 Check the power supply functionality.

a Disconnect AC power.

b Remove all internal power supply cables from the system board.

c Plug in AC power.

If the power supply fan spins and the BIST LED lights, then the power 
supply is good. Replace the system board.

If the power supply fan does not spin or the BIST LED does not light, 
replace the power supply.

Blinks RED 2 times, once per 
second, then 2 second pause, 
2 beeps

Thermal Shutdown:

1 Ensure the workstation air vents are not blocked and cooling fan is running.

2 Open hood, press power button, and see if processor fan spins. If not spinning, 
ensure fan cable is plugged into the system board. Ensure fan is fully/properly 
seated.

3 If fan is plugged in and seated but not spinning, then replace processor fan.

4 Reseat CPU heatsink and verify fan assembly properly attached.
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Blinks RED 3 times, once per 
second, then 2-second pause, 
3 beeps

CPU not installed:

1 Install CPU.

2 Reseat CPU.

Blinks RED 4 times, once per 
second, then 2 second pause, 
4 beeps

Power supply failure:

1 Open the access panel and be sure the four-wire power supply cable is properly 
connected to the system board.

2 Locate faulty device by removing all devices and then reinstalling one at a time 
until workstation fails. Replace the device causing the failure. Continue adding 
devices to ensure all are functioning properly.

3 Check the power supply functionality.

a Disconnect AC power.

b Remove all internal power supply cables from the system board.

c Plug in AC power.

If the power supply fan spins and the BIST LED lights, then the power 
supply is good. Replace the system board.

If the power supply fan does not spin or the BIST LED does not light, 
replace the power supply.

Blinks RED 5 times, once per 
second, then 2 second pause, 
5 beeps

Pre-video memory error.

1 Reseat memory modules.

2 Replace memory modules one at a time to find the faulty module.

3 Replace third-party modules with HP memory.

4 Replace system board.

Blinks RED 6 times, once per 
second, then 2 second pause, 
6 beeps

Pre-video graphics card error.
For systems with integrated graphics, replace system board.
For systems with graphic cards, 

1 Reseat the graphics card. Power on the system.

2 Replace the graphics card.

3 Replace the system board. 

Blinks RED 7 times, once per 
second, then 2 second pause, 
7 beeps.

System board failure (ROM detected failure before video).
Replace system board.

Blinks RED 8 times, once per 
second, then 2 second pause, 
8 beeps

Invalid ROM based on bad checksum.

1 Reflash ROM.

2 Replace system board.

Blinks RED 9 times, once per 
second, then 2 second pause, 
9 beeps

System powers on but is unable to boot.

1 Replace the system board.

2 Replace the processor.

Table 5-2 Diagnostic Light Codes (Continued)

Chassis Indicator Lights (Continued)

Power LED and Sound 
Activity

Diagnosis and Service Action
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Troubleshooting Scenarios and Solutions
This section presents an extensive overview of various troubleshooting scenarios and includes possible 
solutions for each.

Solving Minor Problems

Table 5-3 Minor Problems

Problem Cause Possible Solution

Workstation appears locked up 
and will not turn off when the 
power button is pressed.

Software control of the power 
switch is not functional.

1 Press and hold the power button for at least four 
seconds until the workstation turns off.

2 Disconnect electrical plug from outlet.

Workstation seems to be 
locked up.

Program in use has stopped 
responding to commands.

1 Attempt the normal Windows “Shut Down” procedure. 

2 Press the power button for four or more seconds to turn 
off the power. 

3 Restart the workstation using the power button.

Workstation date and time 
display is incorrect.

Real-time clock (RTC) battery 
might need to be replaced. 

1 Reset the date and time under Control Panel. 

2 Replace the RTC battery.

Workstation appears to pause 
periodically.

Network driver is loaded and no 
network connection is 
established.

Establish a network connection, or use Computer Setup or 
Microsoft Windows Device Manager to disable the network 
controller.

Cursor will not move using the 
arrow keys on the keypad.

The Num Lock key might be on. Press the Num Lock key. The Num Lock key can be 
disabled (or enabled) in Computer Setup.

Cannot remove access panel. Hood lock (Smart Cover Lock), 
featured on some workstations, is 
locked.

1 Unlock the hood lock using Computer Setup.

2 Use the access panel FailSafe Key in case of forgotten 
password, power loss, or workstation malfunction.

Poor performance is 
experienced.

Processor is hot. 1 Be sure airflow to the workstation is not blocked.

2 Be sure the fans are connected and working properly 
(some fans only operate when needed).

3 Be sure the CPU heatsink is installed properly.

Hard drive is full. Transfer data from the hard drive to create more space on 
the hard drive.

Workstation powered off 
automatically and the Power 
LED flashes Red two times, 
once every second, followed 
by a two-second pause, and 
two simultaneous beeps are 
heard.

Processor thermal protection 
activated:
A fan might be blocked or not 
turning.
OR 
The CPU heatsink is not properly 
attached to the processor.

1 Be sure workstation air vents are not blocked and the 
cooling fan is running.

2 Open hood, press power button, and see if the 
processor fan spins. If not spinning, be sure the fan’s 
cable is plugged onto the system board header. Be sure 
the fan is fully/properly seated or installed.

3 Replace the processor fan.

4 Reseat CPU heatsink and verify that the fan assembly 
is properly attached.
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System does not power on and 
the LEDs on the front of the 
workstation are not flashing.

System unable to power on. Press and hold the power button for less than four seconds. 
If the hard drive LED turns green, then:

1 Remove the expansion cards.

2 Replace the system board.

OR
Press and hold the power button for less than four seconds. 
If HDD LED does not illuminate, then:

1 Check that the unit is plugged into a working AC outlet.

2 Open access panel and check that the power button 
harness is properly connected to the in-line front panel 
I/O device assembly connector.

3 Check that the power supply cables are properly 
connected to the system board.

4 Check the power supply functionality.

a Disconnect AC power.

b Remove all internal power supply cables from the 
system board.

c Plug in AC power.

If the power supply fan spins and the BIST LED 
lights, then the power supply is good. Replace 
the system board.

If the power supply fan does not spin or the 
BIST LED does not light, replace the power 
supply.

Table 5-3 Minor Problems (Continued)

Problem Cause Possible Solution
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Solving Power Supply Problems

Testing Power Supply

Before replacing the power supply, use the Built-In Self-Test (BIST) feature to learn if the power supply 
still works.

To test the power supply:

1 Disconnect all internal power supply cables.

2 Plug in AC power.

a If the green BIST LED 1 on the rear of the workstation is lit AND the fan is spinning, the power 
supply is functional.

b If the green BIST LED is not lit OR the fan is not spinning, replace the power supply.

Table 5-4 Power Supply Problems

Problem Cause Solution

Power supply shuts down 
intermittently.

Power supply fault. Replace the power supply.

Workstation powered off 
automatically and the Power LED 
flashes Red two times, once every 
second, followed by a two-second 
pause.

Processor thermal protection 
activated:
A fan might be blocked or not 
turning.
OR 
The CPU heatsink fan 
assembly is not properly 
attached to the processor.

1 Be sure that the workstation air vents are not blocked 
and the cooling fan is running.

2 Open the access panel, press the power button, and 
see if the processor fan spins. If the processor fan is 
not spinning, be sure the fan’s cable is plugged onto 
the system board header. Be sure the fan is fully/
properly seated or installed.

3 Replace the processor fan.

4 Reseat CPU heatsink and verify that the fan assembly 
is properly attached.

1
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Power LED flashes Red, once 
every two seconds.

Power failure (power supply is 
overloaded).

1 Check if a device is causing the problem by removing 
ALL attached devices). Power on the system. If the 
system enters the POST, then power off and replace 
one device at a time and repeat this procedure until 
failure occurs. Replace the device causing the failure. 
Continue adding devices one at a time to ensure all 
devices are functioning properly.

2 Check the power supply functionality.

a Disconnect AC power.

b Remove all internal power supply cables from the 
system board.

c Plug in AC power.

If the power supply fan spins and the BIST 
LED lights, then the power supply is good. 
Replace the system board.

If the power supply fan does not spin or the 
BIST LED does not light, replace the power 
supply.

Table 5-4 Power Supply Problems (Continued)

Problem Cause Solution
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Solving Diskette Problems

Table 5-5 Diskette Problems

Problem Cause Solution

Diskette drive light stays on. Diskette is damaged. In Microsoft Windows 2000 and Microsoft Windows XP, 
right-click Start, click Explore, and select a drive. Select 
File>Properties>Tools. Under Error-checking, click 
Check Now.

Diskette is incorrectly inserted. Remove diskette and reinsert.

Files on diskette are damaged. Check the program diskettes.

Drive cable is not properly 
connected.

Reconnect power cable. Be sure that all four pins are 
connected.

Drive not found. Cable is loose. Reseat diskette drive data and power cables.

Removable drive is not seated 
properly.

Reseat the drive.

Diskette drive cannot write to a 
diskette.

Diskette is not formatted. Format the diskette.

Diskette is write-protected. Use another diskette or remove the write protection.

Writing to the wrong drive. Check the drive letter in the path statement.

Not enough space is left on the 
diskette.

Use another diskette.

Diskette write control is 
enabled.

Use Computer Setup to check the storage security 
feature disabled settings.

Diskette is damaged. Replace the damaged disk.
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Solving Hard Drive Problems

Cannot format diskette. Invalid media reported. When formatting a disk in MS-DOS, you might need to 
specify diskette capacity. For example, to format a 1.44-
MB diskette, enter the following command at the MS-
DOS prompt:
FORMAT A: /F:1440

A problem has occurred with a disk 
transaction.

The directory structure is bad, 
or there is a problem with a file.

In Windows 2000 and Windows XP, right-click Start, click 
Explore, and select a drive. Select 
File>Properties>Tools. Under Error-checking, click 
Check Now.

Diskette drive cannot read 
a diskette.

Diskette is not formatted. Format the diskette.

You are using the wrong 
diskette type for the drive type.

Check the type of drive that you are using and use the 
correct diskette type.

You are reading the wrong 
drive.

Check the drive letter in the path statement.

Diskette is damaged. Replace the diskette with a new one.

“Invalid system disk” message is 
displayed.

A diskette that does not contain 
the system files needed to start 
the workstation has been 
inserted in the drive.

When drive activity stops, remove the diskette and press 
the Spacebar. The workstation should start up.

Diskette error has occurred. Restart the workstation by pressing the power button.

Cannot Boot to Diskette. Diskette is not bootable. Replace with a bootable diskette.

Diskette boot has been 
disabled in Computer Setup.

Run Computer Setup and enable diskette boot in 
Storage>Boot Order.

Removable media boot has 
been disabled in Computer 
Setup.

Run Computer Setup and enable Removable Media 
Boot in Storage>Storage Options.

Diskette MBR validation is 
enabled.

Run Computer Setup and disable Diskette MBR 
Validation in Storage>Storage Options.

Table 5-6 Hard Drive Problems

Problem Cause Solution

Hard drive error occurs. Hard disk has bad sectors or 
has failed.

Use a utility to locate and block usage of bad sectors. If 
necessary, reformat the hard disk.

Disk transaction problem. Either the directory structure is 
bad or there is a problem with 
a file.

In Windows 2000 and Windows XP, right-click Start, click 
Explore, and select a drive. Select File>Properties>Tools. 
Under Error-checking, click Check Now.

Drive not found (identified). Loose cable. Check cable connections.

Table 5-5 Diskette Problems (Continued)

Problem Cause Solution
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The system might not have 
automatically recognized a 
newly installed device.

1 Run Computer Setup.

2 If the system still does not recognize the new device, 
check to see if the device is listed within Computer 
Setup. If it is listed, the probable cause is a driver 
problem. If it is not listed, the probable cause is a 
hardware problem.

3 If this is a newly installed drive, enter Setup and try 
adding a POST delay under Advanced>Power-On.

Drive jumper settings might be 
incorrect.

If the drive is a secondary drive that has just been installed 
on the same cable as the primary drive, verify that the 
jumpers for both drives are set correctly.

Drive’s IDE (ATA) controller is 
disabled in Computer Setup.

Run Computer Setup and enable the Primary and 
Secondary IDE (ATA) controllers in Storage>Storage 
Options. 

Drive responds slowly 
immediately after power-up.

Run Computer Setup and increase the POST Delay in 
Advanced>Power-On Options.

Nonsystem disk/NTLDR missing 
message.

System is trying to start from a 
non-bootable diskette.

Remove the diskette from the diskette drive.

Nonsystem disk/NTLDR missing 
message. 

System is trying to start from a 
damaged hard drive.

1 Insert a bootable diskette into the diskette drive and 
restart the workstation.

2 If the hard drive is still inaccessible and MBR Security 
is enabled, try restoring the previously saved 
MBR image by entering Setup and selecting 
Security>Restore Master Boot Record.

System files missing or not 
properly installed.

1 Insert a bootable system diskette and restart.

2 Verify hard drive is partitioned and formatted. 

3 Install system files for the appropriate operating 
system if necessary.

Hard drive boot disabled in 
Computer Setup.

Run Computer Setup and enable the hard drive entry in 
the Storage>Boot Order list.

Second Ultra ATA hard drive does 
not perform optimally.

Using the wrong cable for the 
drive type.

Reinstall the second Ultra ATA hard drive using an 80-
conductor cable (standard on select models.)

Both slow and fast UATA 
devices are on the same data 
cable.

Connect slower UATA devices to a separate data cable 
connected to the secondary IDE (ATA) controller.

Workstation will not start. Hard drive is damaged. Observe the beeps and LED lights on the front of the 
workstation. Refer to “Power On Self Test (POST) and 
Error Messages” on page 143.

Table 5-6 Hard Drive Problems (Continued)

Problem Cause Solution
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Solving Display Problems

Table 5-7 Display Problems

Problem Cause Solution

Blank screen (no video). The cable connections are not 
correct.

Check the cable connections from the monitor to the 
workstation and to a working electrical outlet.

The monitor is turned off. Switch the monitor to on (LED is on). You might need to 
refer to the monitor manual for an explanation of the LED 
signals.

Screen blanking utility installed 
or energy saver features 
enabled.

Press any key or click the mouse button and, if set, enter 
your password.

System ROM is bad; system is 
running in FailSafe Boot Block 
mode (indicated by eight 
beeps).

Reflash the ROM using a ROMPaq diskette.

Fixed-sync monitor will not 
sync at the resolution chosen.

Be sure that the monitor can accept the same horizontal 
scan rate as the resolution chosen.

Computer is in Hibernate 
mode.

Press the power button to resume from Hibernate mode.

Monitor settings in the 
workstation are not compatible 
with the monitor.

1 Restart the workstation and press F8 during startup 
when you see “Press F8” in the bottom-right corner of 
the screen.

2 Using the keyboard arrow keys, select Enable VGA 
Mode and press Enter.

3 In Windows Control Panel, double-click the Display 
icon and select the Settings tab.

4 Use the sliding control to reset the resolution.

The display works properly during 
the POST but goes blank when the 
OS starts.

The display settings in the OS 
are incompatible with your 
graphics card and monitor.

1 Restart your workstation in VGA mode.

2 After the OS starts, change the display settings to 
match those supported by your graphics card and 
monitor. 

3 Refer to your OS and graphics card documentation for 
information on changing display settings.

Power LED flashes Red six times, 
once every second, followed by a 
two second pause, and the 
workstation beeps six times.

Pre-video graphics error. For systems with a graphics card:

1 Reseat the graphics card. 

2 Replace the graphics card.

3 Replace the system board.

Monitor does not function properly 
when used with energy saver 
features.

Monitor without energy saver 
capabilities is being used with 
energy saver features enabled.

Disable monitor energy saver feature.

Dim characters. The brightness and contrast 
controls are not set properly.

Adjust the monitor brightness and contrast controls.

Cables are not properly 
connected.

Check that the graphics cable is securely connected to the 
graphics card and the monitor.
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Solving Audio Problems

Blurry video or requested 
resolution cannot be set.

If the graphics controller was 
upgraded, the correct video 
drivers might not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of 
displaying requested 
resolution.

Change requested resolution.

The picture is broken up, rolls, 
jitters, or flashes.

The monitor connections might 
be incomplete or the monitor 
might be incorrectly adjusted.

1 Be sure the monitor cable is securely connected to the 
workstation.

2 In a two-monitor system or if another monitor is in 
close proximity, be sure the monitors are not 
interfering with each other’s electromagnetic field by 
moving them apart.

3 Fluorescent lights or fans might be too close to the 
monitor.

Monitor needs to be 
degaussed.

Degauss the monitor. 

Vibrating or rattling noise coming 
from inside a CRT monitor when 
powered on.

Monitor degaussing coil has 
been activated.

None. It is normal for the degaussing coil to be activated 
when the monitor is powered on.

Clicking noise coming from inside a 
CRT monitor.

Electronic relays have been 
activated inside the monitor.

None. It is normal for some monitors to make a clicking 
noise when turned on and off, when going in and out of 
Standby mode, and when changing resolutions.

High pitched noise coming from 
inside a flat panel monitor.

Brightness and contrast 
settings are too high.

Lower brightness and contrast settings.

Fuzzy focus; streaking, ghosting, 
or shadowing effects; horizontal 
scrolling lines; faint vertical bars; or 
unable to center the picture on the 
screen. (Flat panel monitors using 
an analog VGA input connection 
only.)

Flat panel monitor’s internal 
digital conversion circuits 
might be unable to correctly 
interpret the output 
synchronization of the graphics 
card.

1 Select the monitor’s Auto-Adjustment option in the 
monitor’s on-screen display menu.

2 Manually synchronize the Clock and Clock Phase on-
screen display functions. Download SoftPaq SP20930 
or SP22333, depending on the monitor, to assist with 
the synchronization.

Certain typed symbols do not 
appear correct.

The font you are using does 
not support that particular 
symbol.

Use the Character Map to locate the and select the 
appropriate symbol. Click Start>All Programs> 
Accessories>System Tools>Character Map. You can copy 
the symbol from the Character Map into a document.

Table 5-8 Audio Problems

Problem Cause Solution

Sound does not come out of the 
speaker or headphones.

Software volume control is 
turned down.

Double-click the Speaker icon on the taskbar and use the 
volume slider to adjust the volume.

The external speakers are not 
turned on.

Turn on the external speakers.

Table 5-7 Display Problems (Continued)

Problem Cause Solution
TROUBLESHOOTING SCENARIOS AND SOLUTIONS 131



External speakers plugged into 
the wrong audio jack.

See the sound card documentation for proper speaker 
connection.

Audio cable not connected. Connect audio cable between CD or DVD-ROM drive and 
the system board.

Digital CD audio is 
not enabled.

Enable digital CD audio:

1 From the Control Panel, select System.

2 On the Hardware tab, click the Device Manager 
button.

3 Right-click the CD/DVD device and select Properties.

4 On the Properties tab, be sure “Enable digital CD 
audio for this CD-ROM device” is checked.

Headphones or devices 
connected to the line-out 
connector mute the internal 
speaker.

Turn on and use headphones or external speakers, if 
connected, or disconnect headphones or external 
speakers.

Volume is muted. 1 From the Control Panel program, click Sound, Speech 
and Audio Devices, then click Sounds and Audio 
Devices.

2 Click the Mute checkbox to remove the check mark 
from the box.

Computer is in Hibernate 
mode.

Press the power button to resume from Hibernate mode.

Noise or no sound comes out of 
the speakers or headphones.

1 If using digital speakers that have a stereo jack and 
want the system to auto-switch to digital, use a stereo-
to-mono adapter to properly engage the auto-sense 
feature or use the multimedia device properties 
to manually switch the audio signal from analog to 
digital.

2 If the headphones have a mono jack, use the 
multimedia device properties to switch the system to 
analog out.

NOTE If you set digital as the Output Mode, the internal speaker and external analog speakers will no longer output audio until 
you switch back to an auto-sense or analog mode.

If you set analog as the Output Mode, external digital speakers will not function until you change the output mode back to an 
auto-sense or digital mode.

Sound cuts in and out. Processor resources are being 
used by other open 
applications.

Shut down all open processor-intensive applications.

Workstation appears to be locked 
up while recording audio.

The hard disk might be full. 1 Before recording, be sure there is enough free space 
on the hard disk. 

2 Try recording the audio file in a compressed format.

Table 5-8 Audio Problems (Continued)

Problem Cause Solution
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Solving Printer Problems

Solving Keyboard and Mouse Problems

Table 5-9 Printer Problems

Problem Cause Solution

Printer does not print. Printer is not turned on and 
online.

Turn the printer on and be sure it is online.

The correct printer driver for 
the application are not 
installed.

1 Install the correct printer driver for the application.

2 Try printing using the MS-DOS command:

DIR C:\ > [printer port]

where [printer port] is the address of the printer 
being used. If the printer works, reload the printer 
driver.

If you are on a network, you 
might not have made the 
connection to the printer.

Make the proper network connections to the printer.

Printer might have failed. Run printer self-test.

Printer does not turn on. The cables might not be 
connected properly.

Reconnect all cables.

Printer prints garbled information. The correct printer driver is not 
installed.

Install the correct printer driver for the application.

The cables might not be 
connected properly.

Reconnect all cables.

Printer memory might be 
overloaded.

Reset the printer by turning it off for one minute, then turn 
it back on.

Printer is offline. The printer might be out of 
paper.

1 Check the paper tray and refill it if it is empty. 

2 Select online.

Table 5-10 Keyboard and Mouse Problems

Problem Cause Solution

Keyboard commands and typing 
are not recognized by the 
workstation.

Keyboard connector is not 
properly connected.

1 Turn off the workstation.

2 Reconnect the keyboard to the back of the workstation 
and restart the workstation.

Program in use has stopped 
responding to commands.

Shut down the workstation using the mouse and then 
restart the workstation.

Keyboard needs repairs. Replace the keyboard.

Keyboard key is stuck down. Remove any debris from the keyboard.

Workstation is in Hibernate 
mode.

Press the power button to resume from Hibernate mode.
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Solving Front Panel Component Problems
If you are experiencing problems with one of the front panel ports, you might be able to try your device in 
the corresponding port on the back side of the computer. If this does not fix the problem, or you must use 
the front panel ports, continue troubleshooting. 

Some problems in this section are also discussed in other troubleshooting suggestions in this chapter.

Cursor will not move using the 
arrow keys on the keypad.

The Num Lock key might be 
on.

Press the Num Lock key. The Num Lock light should not 
be on if you want to use the arrow keys. The Num Lock 
key can be disabled (or enabled) in Computer Setup.

Mouse does not respond to 
movement or is too slow.

Mouse connector is 
not properly plugged into the 
back of the workstation.

1 Shut down the workstation using the keyboard.

2 Plug the mouse connector into the PS/2 mouse 
connector slot in the workstation and restart the 
workstation.

Program in use has stopped 
responding to commands.

Shut down the workstation using the keyboard and then 
restart the workstation.

Mouse needs repairs. Replace the mouse.

Workstation is in Hibernate 
mode.

Press the power button to resume from Hibernate mode.

Mouse will only move vertically or 
horizontally, or movement is jerky.

Mouse roller ball is dirty. Remove roller ball cover from the bottom of the mouse 
and clean it.

Table 5-11 Front Panel Component Problems

Problem Cause Solution

If a USB device, headphone, or 
microphone is not recognized by 
the workstation.

It is not properly connected. 1 Turn off the workstation.

2 Reconnect the device to the front of the workstation 
and restart the workstation.

The device does not have 
power.

If the USB device requires AC power, be sure one end is 
connected to the device and one end is connected to a live 
outlet.

The correct device driver is not 
installed.

1 Install the correct driver for the device.

2 You might need to reboot the workstation.

The cable from the device to 
the computer does not work.

1 If possible, replace the cable.

2 Restart the workstation.

The device is not working. 1 Replace the device.

2 Restart the workstation.

If a USB, audio, and IEEE-1394 
devices are not working. 

The internal cables might not 
be connected to the system 
board or the PCI card.

1 Turn off the workstation.

2 Connect the cables correctly. 

Table 5-10 Keyboard and Mouse Problems

Problem Cause Solution
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A device in the IEEE-1394 port is 
not responsive.

Cables of new external device 
are loose or power cables are 
unplugged.

Be sure that all cables are properly and securely 
connected.

The power switch on the 
device is not turned on. 

Turn off the workstation, turn on the external device, then 
turn on the workstation to integrate the device with the 
workstation system.

The IEEE-1394 port is not active. The port is not there because it 
was not purchased with the 
system. 

You can buy an IEEE1394 PCI adapter card. Contact an 
HP seller. 

The IEEE-1394 cable might 
not be connected to the 
adapter cable.

1 Turn off the workstation.

2 Remove the access panel (page 74).

3 Be sure the power cable is connected to the card 
(page 92).

4 Be sure to connect the IEEE-1394 cable to the card 
(page 92).

Table 5-11 Front Panel Component Problems (Continued)

Problem Cause Solution
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Solving Hardware Installation Problems
You might need to reconfigure the workstation when you add or remove hardware, such as an additional 
diskette drive. If you install a PnP device, Windows 2000 and Windows XP automatically recognize the 
device and configure the workstation. If you install a non-PnP device, you must reconfigure the 
workstation after completing installation of the new hardware. In Windows 2000, select the Add New 
Hardware icon in the Control Panel (for Windows XP, use the Add Hardware Wizard) and follow the on-
screen instructions.

Table 5-12 Hardware Installation Problems

Problem Cause Solution

A new device is not recognized as 
part of the system.

Device is not seated or 
connected properly.

Be sure that the device is properly and securely connected 
and that pins in the connector are not bent down.

Cables of new external device 
are loose or power cables are 
unplugged.

Be sure that all cables are properly and securely 
connected and that pins in the cable or connector are not 
bent down.

Power switch of new external 
device is not turned on.

Turn off the workstation, turn on the external device, then 
turn on the workstation to integrate the device with the 
workstation system.

When the system advised you 
of changes to the 
configuration, you did not 
accept them.

Reboot the workstation and follow the instructions for 
accepting the changes.

A PnP board might not 
automatically configure when 
added if the default 
configuration conflicts with 
other devices.

Use Windows 2000 or Windows XP Device Manager to 
deselect the automatic settings for the board and choose a 
basic configuration that does not cause a resource 
conflict. You can also use Computer Setup to reconfigure 
or disable devices to resolve the resource conflict.

Device hardware is not 
properly jumpered or otherwise 
configured.

Read the device-specific configuration information and 
check for incorrect settings or conflicts with other devices 
already installed in the system.

Workstation will not start. Wrong memory modules were 
used in the upgrade or 
memory modules were 
installed in the wrong location.

1 Review the documentation that came with the system 
to determine if you are using the correct memory 
modules and to verify the proper installation.

2 Observe the beeps and LED lights on the front of the 
workstation. Refer to “Power On Self Test (POST) and 
Error Messages” on page 143 to determine possible 
causes.

PCI Express power cable 
might be plugged into the 
wrong connector on the 
system board. 

Connect the auxiliary PCI Express power cable to the PCI 
Express card.

Power LED flashes Red five times, 
once every second, followed by a 
two second pause, and the 
workstation beeps five times.

Memory is installed incorrectly 
or is bad.

1 Reseat DIMMs.

2 Replace DIMMs one at a time to isolate the faulty 
module.

3 Replace third-party memory with HP memory.

4 Replace the system board.
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Solving Network Problems
These guidelines do not discuss the process of debugging the network cabling.

Power LED flashes Red six times, 
once every second, followed by a 
two second pause, and the 
workstation beeps six times.

Video card is not seated 
properly or is bad, or system 
board is bad.

For systems with a graphics card:

1 Reseat the graphics card. Power on the system.

2 Replace the graphics card.

3 Replace the system board.

Table 5-13 Network Problems

Problem Cause Solution

Wake-on-LAN feature is not 
functioning.

Wake-on-LAN is not enabled. Use the Network control application to enable Wake-on-
LAN.

Network driver does not detect 
network controller.

Network controller is disabled. Run Computer Setup and enable network controller.

Incorrect network driver. Check the network controller documentation for the 
correct driver or obtain the latest driver from the 
manufacturer’s website.

Network status link light does not 
turn on or it never flashes.
The network status light should 
flash when there is network 
activity.

No active network is detected. Check cabling and network equipment for proper 
connection.

Network controller is not set up 
properly.

Use the Network control application to verify that the 
device is working properly.

Network driver is not properly 
loaded.

Reinstall network drivers.

System cannot autosense the 
network.

Disable auto-sensing capabilities and force the system 
into the correct operating mode.

Diagnostics reports a failure. The cable is not securely 
connected.

Be sure that both ends of the data cable are securely 
connected. 

The cable is attached to the 
incorrect connector.

Be sure that the cable is attached to the correct 
connector.

There is a problem with the cable 
or a device at the other end of the 
cable.

Be sure that the cable and device at the other end are 
operating correctly.

Network controller interrupt is 
shared with an expansion board.

Under the Computer Setup Advanced menu, change the 
resource settings for the board.

The network controller 
is defective.

Replace the NIC.

Table 5-12 Hardware Installation Problems (Continued)

Problem Cause Solution
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Diagnostics passes, but the 
workstation does not 
communicate with the network.

Network drivers are not loaded, or 
driver parameters do not match 
current configuration.

1 Be sure the network drivers are loaded and that the 
driver parameters match the configuration of the 
network controller.

2 Be sure the correct network client and protocol is 
installed.

The network controller is not 
configured for this workstation.

Select the Network icon in the Control Panel and 
configure the network controller.

Network controller stopped 
working when an expansion 
board was added to the 
workstation.

Network controller interrupt is 
shared with an expansion board.

Under the Computer Setup Advanced menu, change the 
resource settings for the board.

The network controller requires 
drivers.

Verify that the drivers were not accidentally deleted when 
the drivers for a new expansion board were installed.

The expansion board installed is a 
network card (NIC) and conflicts 
with the embedded NIC.

Under the Computer Setup Advanced menu, change the 
resource settings for the board.

Network controller stops working 
without apparent cause.

The files containing the network 
drivers are corrupted.

Reinstall the network drivers, using the Restore Plus! CD.

The cable is not securely 
connected.

Be sure that both ends of the cable are securely attached 
to the correct devices.

The network controller is 
defective.

Replace the NIC.

New network card will not boot. New network card might be 
defective or might not meet 
industry-standard specifications.

Install a working, industry-standard NIC, or change the 
boot sequence to boot from another source.

Cannot connect to network 
server when attempting Remote 
System Installation.

The network controller is not 
configured properly.

Verify Network Connectivity, that a DHCP Server is 
present, and that the Remote System Installation Server 
contains the NIC drivers for your NIC.

System setup utility reports 
unprogrammed EEPROM.

Unprogrammed EEPROM. Flash the ROM.

Table 5-13 Network Problems (Continued)

Problem Cause Solution
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Solving Memory Problems

CAUTION For those systems that support ECC memory, HP does not support mixing ECC and non-
ECC memory. Otherwise, the system will not boot the operating system.

Solving Processor Problems
.

Table 5-14 Memory Problems

Problem Cause Solution

System will not boot or does not 
function properly after installing 
additional memory modules.

Memory module is not the 
correct type or speed or the 
new memory module is not 
seated properly.

Replace module with the correct industry-standard device 
for the workstation.

On some models, ECC and non-ECC memory modules 
cannot be mixed.

Out of memory error. Memory configuration might 
not be set up correctly.

Use the Device Manager to check memory configuration.

You have run out of memory to 
run the application.

Check the application documentation to determine the 
memory requirements.

Memory count during POST is 
wrong.

The memory modules might 
not be installed correctly.

Check that the memory modules have been installed 
correctly and that proper modules are used.

Insufficient memory error during 
operation.

Too many Terminate and Stay 
Resident programs (TSRs) are 
installed.

Delete any TSRs that you do not need.

You have run out of memory 
for the application.

Check the memory requirements for the application or add 
more memory to the workstation.

Power LED flashes Red five times, 
once every second, followed by a 
two-second pause, and the 
workstation beeps five times.

Memory is installed incorrectly 
or is bad.

1 Reseat DIMMs. 

2 Replace DIMMs one at a time to isolate the faulty 
module.

3 Replace third-party memory with HP memory.

4 Replace the system board.

Table 5-15 Processor Problems

Problem Cause Solution

Poor performance is experienced. Processor is hot. 1 Be sure the airflow to the workstation is not blocked.

2 Be sure the fans are connected and working properly 
(some fans only operate when needed).

3 Be sure the CPU heatsink is installed properly.

Power LED is Red and stays on. Processor is not seated 
properly or not installed.

1 Check to see that the processor is present.

2 Reseat the processor.
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Solving CD-ROM and DVD Problems

Table 5-16 CD-ROM and DVD Problems

Problem Cause Solution

System will not boot from CD-ROM 
or DVD drive.

The CD-ROM or DVD boot is 
not enabled through the 
Computer Setup utility.

Run the Computer Setup utility and enable booting to 
removable media and verify boot order settings.

Non-bootable CD in drive. Try a bootable CD in the drive.

CD-ROM or DVD devices are not 
detected or driver is not loaded.

Drive is not connected properly 
or not properly configured.

1 Reconnect power and data cables to the drive.

2 Install correct device driver.

Movie will not play in the DVD 
drive.

Movie might be regionalized 
for a different country.

See the documentation that came with the DVD drive.

Decoder software is not 
installed.

Install decoder software.

Cannot eject compact disc (tray-
load unit).

Disc not properly seated in the 
drive.

1 Turn off the workstation and insert a thin metal rod 
into the emergency eject hole and push firmly. 

2 Slowly pull the tray out from the drive until the tray is 
fully extended, then remove the disc.

CD-ROM, CD-RW, DVD-ROM, or 
DVD-R/RW drive cannot read a 
disc or takes too long to start.

CD has been inserted upside 
down.

Re-insert the CD with the label facing up.

The DVD-ROM drive takes 
longer to start because it has 
to determine the type of media 
played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive 
determine the type of media being played. If the disc still 
does not start, read the other solutions listed for this topic.

CD or DVD disc is dirty. Clean CD or DVD with a CD cleaning kit.

Windows does not detect the 
CD-ROM or DVD-ROM drive.

1 Use Device Manager to remove or uninstall the device 
in question.

1 Restart the workstation and let Windows detect the 
device.

Recording audio CDs is difficult or 
impossible.

Wrong or poor quality media 
type.

1 Try using a slower recording speed.

2 Verify that you are using the correct media for the 
drive.

3 Try a different brand of media. Quality varies widely 
between manufacturers.
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Solving Internet Access Problems

Table 5-17 Internet Access Problems

Problem Cause Solution

Unable to connect to the Internet. Internet Service Provider (ISP) 
account is not set up properly.

Verify Internet settings or contact the ISP for assistance.

Modem is not set up properly. Reconnect the modem. Verify the connections are correct 
using the quick setup documentation.

Web browser is not set up 
properly.

Verify that the Web browser is installed and set up to work 
with your ISP.

Cable/ DSL modem is not 
plugged in.

Plug in cable/DSL modem. You should see a “power” LED 
light on the front of the cable/DSL modem.

Cable/DSL service is not 
available or has been 
interrupted due to bad 
weather.

Try connecting to the Internet at a later time or contact 
your ISP. (If the cable/DSL service is connected, the 
“cable” LED light on the front of the cable/DSL modem will 
be on.)

The CAT5 10/100/1000 cable 
is disconnected.

Connect the CAT5 10/100 cable between the cable 
modem and the workstations’s RJ-45 connector. (If the 
connection is good, the “PC” LED light on the front of the 
cable/DSL modem will be on.)

IP address is not configured 
properly.

Contact the ISP for the correct IP address.

Cookies are corrupted. Windows 2000

1 Select Start>Settings>Control Panel.

2 Double-click Internet Options.

3 On the General tab, click the Delete Cookies button.

Windows XP

1 Select Start>Control Panel.

2 Double-click Internet Options.

3 On the General tab, click the Delete Cookies button.

Cannot automatically launch 
Internet programs.

You must log on to the ISP 
before some programs will 
start.

Log on to the ISP and launch the desired program.
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Internet takes too long to download 
websites.

Modem is not set up properly. Verify that the correct modem speed and COM port are 
selected.
For Windows 2000

1 Select Start>Settings>Control Panel.

2 Continue with step #2.

For Windows XP

1 Select Start>Control Panel.

Continue with step #2.
2 Double-click System.

3 Click the Hardware tab.

4 In the Device Manager area, click the Device 
Manager button.

5 Double-click Ports (COM & LPT).

6 Right-click the COM port your modem uses, then 
click Properties.

7 Under Device status, verify that the modem is working 
properly.

8 Under Device usage, verify the modem is enabled.

9 If there are further problems, click the Troubleshoot 
button and follow the on-screen instructions.

Table 5-17 Internet Access Problems (Continued)

Problem Cause Solution
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Power On Self Test (POST) and Error Messages
POST is a series of diagnostic tests that runs automatically when the system is turned on. An audible 
and/or visual message occurs if the POST encounters a problem. POST checks the following items to 
ensure that the workstation system is functioning properly:

Keyboard

Memory modules

Diskette drives

All SATA, IDE. and SCSI mass storage devices 

Processors

Controllers

NOTE If the Power-On Password is set, a key icon appears on the screen while POST is running. You 
must enter the password before continuing.

Table 5-18 POST Error Messages

Screen Message Probable Cause Recommended Action

101—Option ROM Error System ROM checksum. Verify the correct ROM.

1 Flash the ROM if needed.

2 If an expansion card was recently added, remove it 
and see if the problem remains. 

3 Clear CMOS.

4 If the message disappears, there might be 
a problem with the expansion card.

5 Replace the system board.

102—System Board Failure DMA, timers, etc. 1 Clear CMOS.

2 Remove expansion boards.

3 Replace the system board.

103—System Board Failure DMA, timers, etc. 1 Clear CMOS.

2 Remove expansion boards.

3 Replace the system board.

110—Out of Memory for 
Option ROMs

Option ROM for a device was unable 
to run due to memory constraints.

Run Computer Setup and enable the ACPO/USB 
Buffers at Top of Memory under the Advanced>Power-
On option.

150—SafePost Active A PCI expansion card is not 
responding.

1 Restart the workstation.

2 Disable SafePost.

3 If the expansion card does not respond, replace 
the card.
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162—System Options Not Set Configuration incorrect. RTC battery 
might need to be replaced.

1 Run Computer Setup (F10 Setup).

2 Set the date and time under Control Panel or in 
F10 Setup depending on the operating system.

3 If the problem persists, replace the RTC battery.

163—Time and Date Not Set Invalid time or date in configuration 
memory.
RTC (real-time clock) battery might 
need to be replaced.
CMOS jumper might not be properly 
installed.

1 Set the date and time under Control Panel or in 
F10 Setup depending on the operating system.

2 If the problem persists, replace the RTC battery.

164—Memory Size Error Memory configuration is incorrect. 1 Run Computer Setup (F10 Setup) or Windows 
utilities.

2 Be sure memory module(s) (if any) are installed 
properly.

3 If third-party memory has been added, test using 
HP-only memory.

4 Verify proper memory module type.

183—Invalid Processor 
Jumper Setting

System board jumper improperly set. Reset system board jumpers to match processor and 
bus speeds (select models).

201—Memory Error RAM failure. 1 Run Computer Setup (F10 Setup) or Windows 
utilities.

2 Be sure that memory and continuity modules are 
installed correctly.

3 Verify proper memory module type.

4 Remove and replace memory module(s) one at a 
time to isolate faulty module.

5 Replace the faulty memory module(s).

6 If error persists after replacing memory modules, 
replace the system board.

202—Memory Type Mismatch Memory modules do not match each 
other.

Replace memory modules with matched sets.

207—ECC Corrected Single 
Bit Errors in Memory Socket(s) 
y,y

Single Bit ECC error. 1 Verify proper memory module type.

2 Try another memory socket.

3 Replace memory module if problem persists.

212—Failed Processor Processor has failed to initialize. 1 Reseat the processor in its socket.

2 If the processor does not respond, replace it.

213—Incompatible memory 
Module in memory Socket(s) 
X,X, X

A memory module in memory socket 
identified in the error message is 
missing critical SPD information, or is 
incompatible with the chipset.

1 Verify proper memory module type.

2 Try another memory socket.

3 Replace memory with a module conforming to the 
SPD standard.

Table 5-18 POST Error Messages (Continued)

Screen Message Probable Cause Recommended Action
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214—DIMM Configuration 
Warning

DIMMs not installed correctly (not 
paired correctly).

Refer to “Memory” on page 82 for the correct memory 
configurations and reseat the DIMMs accordingly.

215—Memory Mismatch 
Warning

There are one or more mismatched 
pairs of DIMMs between channel A 
and channel B. Some memory has 
been disabled. Install matching pairs 
or remove the mismatched DIMMs 
from channel B.

Refer to “Memory” on page 82 for the correct memory 
configurations and reseat the DIMMs accordingly.

216—Memory Size Exceeds 
Maximum Supported

The amount of memory installed 
exceeds that supported by the 
hardware. 

1 Verify how much memory your system can 
support.

2 Remove the excessive memory.

219—ECC Memory Module 
Detected.

ECC modules not supported on this 
platform.

Remove the EDD module.

301—Keyboard Error Keyboard failure. 1 Reconnect keyboard with workstation turned off.

2 Check connector for bent or missing pins.

3 Be sure that none of the keys are pressed.

4 Replace keyboard.

303—Keyboard Controller 
Error

I/O board keyboard controller. 1 Reconnect keyboard with workstation turned off.

2 Replace the system board.

304—Keyboard or System 
Unit Error

Keyboard failure. 1 Reconnect the keyboard with workstation turned 
off.

2 Be sure that none of the keys are pressed.

3 Replace keyboard.

4 Replace system board. 

401—Parallel Port 1 Address 
Assignment Conflict

IRQ address conflicts with another 
device.

Reset the IRQ.

402—Parallel Port 2 Address 
Assignment Conflict

IRQ address conflicts with another 
device.

Reset the IRQ.

403—Parallel Port 3 Address 
Assignment Conflict

IRQ address conflicts with another 
device.

Reset the IRQ.

404—Parallel Port Address 
Conflict Detected

Both external and internal ports are 
assigned to parallel port X.

1 Remove any parallel expansion cards.

2 Clear CMOS.

3 Reconfigure card resources and run Computer 
Setup (F10 Setup).

410—Audio Interrupt Conflict IRQ address conflicts with another 
device.

Reset the IRQ.

411—Network Interface Card 
Interrupt Conflict

IRQ address conflicts with another 
device.

Reset the IRQ.

Table 5-18 POST Error Messages (Continued)

Screen Message Probable Cause Recommended Action
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501—Display Adapter Failure Graphics display controller. 1 Reseat the graphics card (if applicable).

2 Clear CMOS.

3 Verify that the monitor is attached and turned on.

4 Replace the graphics controller.

510—Splash Screen image 
corrupted

Splash Screen image has errors. Install latest version of ROMPaq to restore image.

511—CPU, CPUA, or CPUB 
Fan not detected

Fan is not connected or might have 
malfunctioned.

1 Reseat fan cable.

2 Reseat the fan.

3 Replace the fan.

512—Chassis, rear chassis, or 
front chassis fan not detected

Fan is not connected, might have 
malfunctioned.

1 Reseat chassis, rear chassis, or front chassis fan 
cable.

2 Reseat chassis, rear chassis, or front chassis fan.

3 Replace chassis, rear chassis, or front chassis fan.

514—CPU or Chassis Fan not 
detected

CPU fan is not connected or might 
have malfunctioned.

1 Reseat CPU or chassis fan.

2 Replace CPU or chassis fan.

601—Diskette Controller Error Diskette controller circuitry or diskette 
drive circuitry incorrect.

1 Run Computer Setup (F10 Setup).

2 Check and replace cables.

3 Clear CMOS.

4 Replace diskette drive.

5 Replace the system board.

605—Diskette Drive Type 
Error

Mismatch in drive type. 1 Run Computer Setup (F10 Setup).

2 Disconnect any other diskette controller devices 
(tape drives).

3 Clear CMOS.

610—External Storage Device 
Failure

External tape drive not connected. Reinstall tape drive or press F1 and allow system to 
reconfigure without the drive.

611—Primary Diskette Port 
Address Assignment Conflict

Configuration error. 1 Run Computer Setup (F10 Setup).

2 Remove expansion cards.

3 Clear CMOS.

912—Computer Cover Has 
Been Removed Since Last 
System Start Up

No action required.

914—Hood Lock Coil is not 
Connected

Hood lock mechanism is missing or 
not connected.

1 Reconnect or replace hood locking mechanism.

2 Reseat or replace hood locking mechanism cable.

916—Power Button Not 
Connected

The power button is not connected. Connect power button.

Table 5-18 POST Error Messages (Continued)

Screen Message Probable Cause Recommended Action
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917—Front Audio Not 
Connected

The front audio cable is not connected. Connect front audio cable. 

918—Front USB Not 
Connected

Front USB is not connected. Connect front USB cable.

919—Multi-Bay Riser Not 
Connected

Multi-Bay riser is not connected. Connect Multi-Bay riser.

920—Fan Command 2 Pin 
Connector from Power Supply 
Not Connected

The 2-pin fan connector from the 
power supply is not connected.

Connect 2-pin fan connector.

940—Extended ROM 
signature not found

The signature at the start of the ROM 
flash is missing. Your firmware (BIOS) 
is incomplete. 

Run ROMPaq again.

960—CPU Overtemp occurred The ambient temperature could 
exceed operating limits 
(maximum=95°F), or there are 
obstructions to airflow, including dust 
build up. 

1 Be sure you are not operating the system in an 
environment that exceeds 95°F.

2 Disconnect power and open the access panel. 

3 Check that cables are not blocking CPU heatsink 
fans or front fan, if installed.

4 Check that there is not excessive dust on major 
components. 

5 If airflow is acceptable and there is not excessive 
dust, the thermal sensing circuitry has failed on the 
processors or on the system board. You must 
replace the processors and/or the system board.

1151—Serial Port 1 Address 
Conflict Detected

Both external and internal serial ports 
are assigned to COM1.

1 Remove any Comm port expansion cards.

2 Clear CMOS.

3 Reconfigure card resources and run Computer 
Setup (F10 Setup). Run Computer Setup or 
Windows utilities.

1152—Serial Port 2 Address 
Conflict Detected

Both external and internal serial ports 
are assigned to COM2.

1 Remove any Comm port expansion cards.

2 Clear CMOS.

3 Reconfigure card resources and run Computer 
Setup (F10 Setup). Run Computer Setup or 
Windows utilities.

1155—Serial Port Address 
Conflict Detected

Both external and internal serial ports 
are assigned to same IRQ.

1 Remove any Comm port expansion cards.

2 Clear CMOS.

3 Reconfigure card resources and run Computer 
Setup (F10 Setup). Run Computer Setup or 
Windows utilities.

1201—System Audio Address 
Conflict Detected

Device IRQ address conflicts with 
another device.

Reset the IRQ.

1202—MIDI Port Address 
Conflict Detected

Device IRQ address conflicts with 
another device.

Reset the IRQ.

Table 5-18 POST Error Messages (Continued)

Screen Message Probable Cause Recommended Action
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1203—Game Port Address 
Conflict Detected

Device IRQ address conflicts with 
another device.

Reset the IRQ

1720 SMART Hard Drive 
Detect Imminent Failure

Hard drive is about to fail. (Some hard 
drives have a firmware patch that will 
fix an erroneous error message.)

1 Determine if hard drive is giving correct error 
message. Run the Drive Protection System test if 
applicable.

2 Apply firmware patch if applicable (see http://
www.hp.com/support).

3 Back up contents and replace hard drive.

1721—SMART SCSI Hard 
Drive detects imminent failure

Hard drive is about to fail. (Some hard 
drives have a firmware patch that will 
fix an erroneous error message.)

1 Determine if hard drive is giving correct error 
message. Run the Drive Protection System test if 
applicable.

2 Apply firmware patch if applicable (see http://
www.hp.com/support).

3 Back up contents and replace hard drive.

1780—Disk 0 Failure The drive is not installed correctly or 
has failed. 

1 Make sure that any jumpers are set correctly, and 
that power and drive cables are connected, both to 
the drive and the system board. 

2 Verify that the cables are the correct cables for 
your computer model. 

If this message persists, you may need service for your 
workstation.

1781—Disk 1 Failure The drive is not installed correctly or 
has failed. 

1 Make sure that any jumpers are set correctly, and 
that power and drive cables are connected, both to 
the drive and the system board. 

2 Verify that the cables are the correct cables for 
your computer model. 

If this message persists, you may need service for your 
workstation.

1782—Disk Controller Failure Hard drive circuitry error. 1 Run Computer Setup (F10 Setup).

2 Clear CMOS.

3 Check cable seating/jumper settings.

4 Run hard drive diagnostics.

5 Disconnect additional drives.

6 Run the Drive Protection System test if available.

7 Check http://www.hp.com\support\ 
techpubs\customer_advisories for possible changes 
when using Windows NT 4.0 Service Pack 4.

8 Replace the hard drive.

9 Replace the system board.

1785—Multibay incorrectly 
installed

No other IDE device may be attached 
to the same IDE controller.

Attach the Multibay as device 0 on the secondary IDE 
controller.

Table 5-18 POST Error Messages (Continued)

Screen Message Probable Cause Recommended Action
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1790—Disk 0 Error The drive is not installed correctly or 
has failed. 

1 Make sure that any jumpers are set correctly, and 
that power and drive cables are connected, both to 
the drive and the system board. 

2 Verify that the cables are the correct cables for 
your computer model. 

If this message persists, you may need service for your 
workstation.

1791—Disk 1 Error The drive is not installed correctly or 
has failed. 

1 Make sure that any jumpers are set correctly, and 
that power and drive cables are connected, both to 
the drive and the system board. 

2 Verify that the cables are the correct cables for 
your computer model. 

If this message persists, you may need service for your 
workstation.

1792—Secondary Disk 
Controller Failure

Hard drive circuitry error. 1 Run Computer Setup (F10 Setup).

2 Clear CMOS.

3 Check cable seating/jumper settings.

4 Run hard drive diagnostics.

5 Disconnect additional drives.

6 Run the Drive Protection System test if available.

7 Replace the hard drive.

1793—Secondary Controller 
or Disk Failure

Hard drive circuitry error. 1 Run Computer Setup (F10 Setup).

2 Clear CMOS.

3 Check cable seating/jumper settings.

4 Run hard drive diagnostics.

5 Disconnect additional drives.

6 Run the Drive Protection System test if available.

7 Replace the hard drive.

1794—Inaccessible devices 
attached to primary IDE 
controller

Devices attached to the primary IDE 
controller are inaccessible while the 
SATA controller is set to “Replace 
Primary IDE Controller” in Setup.

1 Run Computer Setup (F10 Setup).

2 Select Storage > Storage Options and set SATA 
controller to Add as Separate Controller.

1800—Temperature Alert Internal temperature exceeds 
specification.

1 Check that workstation air vents are not blocked 
and cooling fan is running.

2 Verify processor speed selection.

3 Replace the processor.

4 Replace the system board.

1801—Microcode Patch Error Processor not supported by ROM 
BIOS.

Upgrade BIOS to proper version.

Table 5-18 POST Error Messages (Continued)

Screen Message Probable Cause Recommended Action
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1802—Processor Not 
Supported

The system board does not support 
the processor.

Replace the processor with a compatible one.

1803-BIOS Update Needed for 
Processor

This BIOS revision does not support 
the installed processor. 

Install the latest BIOS located at www.hp.com.

1998—Master Boot Record 
has been lost

The previously saved copy of the MBR 
has been corrupted.

Run Computer Setup and save the MBR of the current 
bootable disk.

1998—Master Boot Record 
has been changed

The current MBR does not match the 
previously saved copy of the MBR.

Use extreme caution. The MBR might have been 
updated due to normal disk maintenance activities 
(disk manager, fdisk, or format). Replacing the 
previously saved MBR in such situations can cause 
data loss. If certain that the MBR change is 
unintentional and undesired (for example, due to a 
virus), run Computer Setup and restore the previously 
saved MBR copy. Otherwise, run Computer Setup and 
either disable MBR security or save the MBR of the 
current bootable disk.

Invalid Electronic Serial 
Number

Electronic serial number has become 
corrupted.

Run Computer Setup. If Setup already has data in the 
field or will not allow the serial number to be entered, 
download from http://www.hp.com and run 
SP5572.EXE (SNZERO.EXE).
Run Computer Setup and try to enter serial number 
under Security, System ID, then save changes.

ECC Multiple Bit Error 
Detected in Memory Module

Chipset has detected more than one 
bad bit in a 64-bit quadword of the 
memory array.

Replace the memory module.

Parity Check 2 Parity RAM failure. Run Computer Setup and Diagnostic utilities.

Table 5-18 POST Error Messages (Continued)
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Appendix A SCSI Devices

SCSI Guidelines

NOTE These systems support a mixed configuration of UATA/IDE and SCSI hard drives. In a mixed 
configuration the UATA/IDE drive must be specified as the boot drive.

When installing and operating SCSI devices, you must follow these guidelines:

A narrow (50-pin) SCSI controller enables you to daisy-chain up to seven additional SCSI devices. Counting the 
controller, that amounts to eight total SCSI devices.

A wide (68-pin) SCSI controller enables you to daisy-chain up to 15 additional SCSI devices. Counting the 
controller, that amounts to 16 total SCSI devices.

If two narrow (50-pin) SCSI controllers are each connected to separate system board SCSI connectors, each 
controller can have seven SCSI devices attached. Counting the controller, this gives a total of 16 SCSI devices 
on the system.

HP does not recommend mixing different width SCSI devices on the same SCSI chain or on the same SCSI 
channel. Mixing devices of different widths on the same chain or channel will always result in a data transfer 
rate of the slowest machine in that chain. The only exception to this is that Ultra Wide SCSI devices will cause a 
speed degradation when mixed with other 68-pin devices.

If multiple SCSI devices are used, split the devices between Channels A and B for optimum performance. Cable 
length for the second channel should not be longer than 18 inches.

If two controllers are used, each can use SCSI devices having widths and speeds different from the other. If a 
68-pin data cable is used on a controller having 50-pin SCSI devices, use an internal cable adapter or an 
external cable adapter. 

CAUTION Do not route data cables near the air intake to the power supply. Cables routed in this manner 
can block the airflow and cause the workstation to overheat.

All SCSI controllers require a unique SCSI ID (0–15) for each SCSI device installed. Refer to the “Jumpers” 
section on page 153 for more information. 

68-pin SCSI controllers require a 53 inch maximum length-twisted pair, LVD cable with built-in terminator, 
maximum of five drives with a minimum driving spacing of 5.25 inches.

Every SCSI chain or circuit must be terminated (closed) at both ends. Some system boards have both ends of 
the SCSI cable connected to, and terminated by, the system board. Termination can be accomplished in one of 
several ways:

Use a cable with a built-in terminator.
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Use a cable with a terminating resistor plug in the last connector.

Connect a SCSI device with its termination enabled into the last connector.

Connect an external SCSI device with its termination enabled to the external SCSI connector on the rear 
panel of the workstation.

Turn on all external SCSI devices before turning on the power to the workstation. This enables the SCSI 
controller to recognize the external devices.

Using SCSISelect with SCSI Devices
The Ultra160 and faster SCSI host adapters include the SCSISelect utility to configure the host adapter and to run 
the SCSI disk utilities. To run the SCSISelect utility:

In POST Messages Enabled mode: Press Ctrl+A when the “Press<Ctrl><A> for SCSISelect Utility” message 
appears during POST.

In POST Messages Disabled mode: When the HP logo screen appears, press any key to exit the logo screen. 
Immediately after exiting the logo screen, press Ctrl+A to access the SCSISelect utility.

A menu appears with the following options:

Configure/View Host Adapter Settings

SCSI Bus Interface Definitions

Host Adapter SCSI ID

SCSI Parity Checking

Host Adapter SCSI Termination

Additional Options

Boot Device Options

SCSI Device Configuration

Advanced Configuration Options

SCSI Disk Utilities

Lists all SCSI devices and SCSI ID numbers

NOTE For additional information about configuring POST message display status, refer to “Computer 
Setup Menu” on page 37.

SMART
The SMART IDE and SCSI hard drives for HP workstations have built-in drive failure prediction that warns the user 
or the network administrator of an impending failure or crash of the hard drive. SMART drives track fault prediction 
and failure indication parameters, such as re-allocated sector count, spin retry count, and calibration retry count. If 
the drive determines that a failure is imminent, it generates a fault alert.
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Jumpers
All SCSI controllers require a unique SCSI ID (0–15) for each SCSI device installed.

The controller identifies a SCSI device by its SCSI ID number rather than its location. Moving a SCSI device from 
one position to another on the SCSI chain does not affect communication between the controller and the device. 
The reserved and available SCSI ID numbers are displayed in the following list:

0 is reserved for the primary hard drive (not reserved for the primary hard drive on Linux).

7 is reserved for the SCSI controller.

1 through 6 and 8 through 15 are available for all other SCSI devices.

When 0 is used for the primary hard drive, set the second hard drive to 1, the third to 2, and so on.

To set the SCSI ID on a drive, see the instructions on top/back of the hard drive for the correct jumper settings. The 
drive probably displays a diagram of the jumper block. This diagram shows you which blocks to cover with your 
jumper to get the desired ID.

For example, if the drive needs to be set to 3, the drive might show that the 3 ID bits are at the far left of the 
connector (ID0, ID1, ID2, and ID3), then using the jumpers provided, cover each block to set the SCSI ID.

NOTE After changing the jumper settings, reboot the workstation to recognize the new 
address.
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Appendix B SATA Devices

SATA Guidelines

NOTE These systems support a mixed configuration of UATA/IDE, SCSI, and SATA hard drives. While 
HP supports the presence of IDE drives, it does not ship any configurations using those drives.

NOTE The HP Workstation xw6200 has two SATA ports on the system board to cover all the internal hard 
drive mounting points. Connect the first SATA drive (boot drive if booting from SATA) to the port labeled 
SATA0. If installing a second drive, connect it to SATA1. 

When installing and operating SATA devices:

If the hard drive is installed in the hard drive cage, connect the 90-degree connector on the SATA cable 
(326965-006) to the hard drive and the straight connector to the system board. 

If the hard drive is installed in a 5.25-inch bay, connect the straight connector on the SATA cable (326965-006) 
to the hard drive and the 90-degree connector to the system board.

If using a SATA controller card, connect the 4-4 pin LED cable (included with SATA controller board) from the 
card header “JP1” (4-pin header) to the system board header labeled “SCSI LED” (4-pin header).

For complete and current information on supported accessories and components, visit http://partsurfer.hp.com.
SATA GUIDELINES 155

http://partsurfer.hp.com


Boot Order 
The following flow diagram shows the boot order of hard drives (C:) connected to the different controllers in the 
workstation system.

You can modify the boot order in the Computer Setup Utility by arranging the Controller Order on the Storage tab. 

For more information on accessing Computer Setup Utility, refer to the Computer Setup section in Chapter 3 on 
page 34.

The diagram does not show other bootable device options such as a diskette, CD-ROM, USB, network, and so on. 
In the Computer Setup Utility, you can arrange the boot order on the Storage tab.

NOTE The first hard drive bay is the recommended position for the drive containing the 
bootable OS. 

Boot volume on 
SATA disk

SATA disk connected 
to system board

PCI plug-in disk controllers 
with boot volume
(SATA, IDE, SCSI)

Boot volume on IDE disk

Boot volume on SCSI diskSCSI disk connected 
to system board

IDE disk connected 
to system board

YES

YES

YES

YES

NO

NO

NO

Boot from plug-in card

YES
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SATA Raid Configurations
This workstation supports an embedded SATA RAID. RAID (Redundant Array of Inexpensive Disks) combines 
multiple physical drives together to provide either increased performance or increased redundancy.

For an embedded SATA RAID, there are two primary configurations.

RAID 0 is a striping configuration. For example, this combines two 80 GB drives into one 160 GB drive. Both 
physical drives can be accessed simultaneously for better performance. This is faster than using two 80 GB 
drives separately.

RAID 1 is a mirroring configuration. For example, this uses two 80 GB drives, but one drive is a complete mirror 
of the other drive. The system remains functional and no data is lost if one of the drives should fail.

There are other RAID configurations, but they are not supported on an embedded SATA RAID.

NOTE For information on the integrated SATA RAID, visit http://www.hp.com/go/workstationsupport and 
review the supplier’s documentation. For information on supported SATA RAID configurations, visit
 http://www.hp.com/go/productbulletin. 
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Appendix C Ultra ATA Devices 

NOTE This system supports a mixed configuration of UATA/IDE, SCSI, and SATA hard drives. While HP 
supports the presence of IDE drives, it does not ship any configurations using those drives.

Ultra ATA Jumpers
Ultra ATA drives are configured with jumper settings. Factory-installed drives ship with the jumpers preset to the 
cable-select mode; therefore, no jumper setting changes are required on factory preinstalled, replacement, or 
option drives. With cable-select, the drive is configured as either Master (Drive/Device 0) or Slave (Drive/Device 1) 
by its physical attachment to the cable. 

If you purchase a third-party hard drive, refer to the documentation included with the drive kit to ensure proper 
cable installation and configuration.

NOTE All drives on a controller channel must have their jumpers either in the cable-select mode or have 
the individual drive jumper installed on the appropriate Master (Drive/Device 0) or Slave (Drive/Device 1) 
position.

Ultra ATA Cables
When installing a second device on either the primary or secondary controller, you must use an industry standard 
80-conductor Ultra ATA cable for optimal performance. These cables have a maximum length of 18 inches and a 
maximum distance of six inches between the two devices for a two-drive cable.

Drives operating at speeds faster than those of the Ultra ATA-33 devices require industry-standard 40-pin, 80-
conductor cables to maintain the higher data transfer rates possible with the improved technology.

When using Ultra ATA-133, -100, -66, and slower -33 drives in the same system, each drive will operate at its 
appropriate data transfer rate.

Drive Installation Guidelines
Most workstation system boards have two ATA (IDE) controller channels with a dedicated connector for each 
controller. One controller is designated as the primary and the other as the secondary controller.

Each of the two controllers can have up to two devices attached to it. Each workstation system might therefore 
have a maximum of four ATA/ATAPI drives. All drives are connected to these controllers using an industry-
standard, 80-conductor cable.
ULTRA ATA JUMPERS 159



NOTE The industry standard, 1.44-MB diskette drive has its own separate channel and is not included as 
a part of the maximum four drives.

Any drive attached to a controller must have a drive designation. If only a single drive is connected to a controller 
and its jumper is in the cable-select position, it is designated as the Master Drive (Drive/Device 0) by its attachment 
to the Drive/Device 0 cable position. If two cable-selected drives are connected to a single controller, one will be 
designated by its attachment to the cable as the Master (Drive/Device 0) and the other as Slave (Drive/Device 1).

For optimal performance of a workstation system, all drives must be attached to the ATA controllers in a specified 
sequence. This sequence is determined by the device class of the drives and by specific attach sequence rules.

Device Classes
To determine the best drive attach sequence, ATA/ATAPI drives are segregated into four different classes based on 
the bandwidth demands they place on an ATA controller. The most demanding devices are in Class 1 and the least 
demanding are in Class 4.

General Attach Guidelines

The lower the device class number, the faster the device and the more bandwidth required.

Drives installed in the Device 0 positions on both the primary and secondary controllers receive the greatest 
possible bandwidth.

The bootable ATA hard drive should always be installed on the primary controller in the Device 0 position.

Attach Sequence Rules by Class Priority
Drives should be attached in the sequence shown for optimum performance starting at position 1.

Figure C–1 Installing Drive Order

Table C-1 Device Classes

Class 1
Hard 
Drives

Class 2 High Speed 
Optical Drives

Class 3 Optical Storage
Drives

Class 4
Magnetic Storage Drives

ATA-100
ATA-66
ATA-33

DVD
DVD-CD R/W

R/W CD-ROM
CD-ROM 

LS-120
Tape
Zip 

1

2

4

3

Primary 
Controller*

4 1

Secondary 
Controller

3 2

Device 1 Device 0
160 ULTRA ATA DEVICES



 A
pp

en
di

x 
C

*If there are three or more devices, two or more of which are hard drives, two hard drives should be attached to the 
primary controller first before following the General Attach Sequence Rule.

The attach sequence rule can also be stated in table format:

The rules allow for:

Keeping the hard drive on a separate controller channel maximizes drive performance until a fourth device is 
added.

Keeping the hard drives and removable media drives on separate controller channels maximizes compatibility.

Keeping the hard drive and the writable optical drive on separate controller channels maximizes optical drive 
reliability.

Attach Sequence Worksheet
Use the worksheet below for obtaining optimum system performance when setting up a workstation with multiple 
drives. Use the General Attach Sequence Rule to determine the best drive installation sequence.

Two examples of how to use the worksheet are:

Three device installation

Four device installation

Example 1: Three Device Installation Sample

Table C-2 General Attach Sequence Rule*

Sequence Description

1 The lowest class drive—bootable hard drive recommended.

2 If only two drives, the last drive goes here; otherwise, the lowest class of the remaining drives.

3 If only three drives, attach the final drive here. If a fourth drive exists, attach the lowest class drive 
here.

4 If there is a fourth drive, attach the final drive here—the drive with the highest class number of all 
devices.

*If there are three or more devices, two or more of which are hard drives, two hard drives should be attached to the 
primary controller first before following the General Attach Sequence Rule.

Table C-3 Attach Sequence Worksheet

Device Name Device Class Position 
Number

Controller Name Device 
Number
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A system has three devices: Ultra ATA-100 hard drive, CD-ROM drive, and a DVD drive. Using the Device Class 
Table, the devices can be identified as:

Ultra ATA-100 hard drive = Class 1

DVD drive = Class 2

CD-ROM drive = Class 3

Figure C–2 Installing Drive Order (2)

Example 2: Four Device Installation Sample

A system has four devices: Ultra ATA-100 hard drive, Ultra ATA-100 hard drive, DVD-CDR/W drive, and a ZIP-250 
drive. 

Ultra ATA-100 hard drive = Class 1

Ultra ATA-100 hard drive = Class 1

DVD-CDR/W drive = Class 2

ZIP-250 drive = Class 4

Table C-4 Attach Sequence Worksheet—Three Device Installation (Sample)

Device Name Device Class Position 
Number

Controller Name Device 
Number

Ultra ATA-100 hard drive 1 1 Primary 0

DVD drive 2 2 Secondary 0

CD-ROM drive 3 3 Secondary 1

Table C-5 Attach Sequence Worksheet—Four Device Installation (Sample)

Device Name Device 
Class

Position 
Number

Controller Name Device 
Number

Ultra ATA-100 hard drive 1 1 Primary 0

1

2

4

3

Primary 
Controller*

4 1

Secondary 
Controller

3 2

Device 1 Device 0
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*If there are three or more devices, two or more of which are hard drives, two hard drives should be attached to the 
primary controller first before following the General Attach Sequence Rule.

Figure C–3 Installing Drive Order (3)

Additional Drive Application Notes
When replacing a hard drive, the replacement should be of the same type (Ultra ATA-33, -66, or -100) as that 
being removed to retain the same level of performance.

When Ultra ATA and SCSI hard drives are mixed in the same system, the Ultra ATA drive will become the boot 
drive unless the boot order is changed in Computer Setup (F10).

SMART
The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for HP workstations have built-in 
drive failure prediction that warns the user or network administrator of an impending failure or crash of the hard 
drive. The SMART drive tracks fault prediction and failure indication parameters, such as reallocated sector count, 
spin retry count, and calibration retry count. If the drive determines that a failure is imminent, it generates a fault 
alert.

DVD-CDR/W drive 2 2 Secondary 0

ZIP-250 drive 4 3 Secondary 1

Ultra ATA-100 hard drive* 1 4 Primary 1

Table C-5 Attach Sequence Worksheet—Four Device Installation (Sample)

Device Name Device 
Class

Position 
Number

Controller Name Device 
Number

1

2

4

3

Primary 
Controller*

4 1

Secondary 
Controller

3 2

Device 1 Device 0
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Jumpers
The following specification is are the standard drive configurations.

CD-ROM or DVD-ROM Drive

Figure C–4 CD-ROM or DVD-ROM drive jumpers

C S M
S L A

C S M
S L A

C S M
S L A

Use CSEL Slave Master
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Appendix D Connector Pins

Enhanced Keyboard

Mouse

Ethernet RJ-45

Keyboard Connector Pin Signal

1
2
3

Data
Unused
Ground

4
5
6

+5 VDC
Clock
Unused

Mouse Connector Pin Signal

1
2
3

Data
Unused
Ground

4
5
6

+5 VDC
Clock
Unused

Ethernet Connector Pin Signal

1
2
3
4

(+) Transmit Data
(-) Transmit Data
(+) Receive Data
Unused

5
6
7
8

Unused
(-) Receive Data
Unused
Unused
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Parallel Interface

Serial Interface

USB

Parallel Connector

Pin Signal Pin Signal Pin Signal

1
2
3

Strobe
Data Bit 0
Data Bit 1

7
8
9

Data Bit 5
Data Bit 6
Data Bit 7

13
14
15

Select
Auto Linefeed
Error

4
5
6

Data Bit 2
Data Bit 3
Data Bit 4

10
11
12

Acknowledge
Busy
Paper End

16
17
18-25

Initialize Printer
Select IN
Signal Ground

Serial Connector Pin Signal

1
2
3

Carrier Detect
Receive Data
Transmit Data

4
5
6

Data Terminal Ready
Signal Ground
Data Set Ready

7
8
9

Request to Send
Clear to Send
Ring Indicator

USB Connector Pin Signal

1
2
3
4

+5 VDC
- Data
+ Data
Ground
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IEEE 1394

Microphone

Headphone

Line-in Audio

IEEE 1394 Connector Pin Signal

1  power

2 gnd

3  tpb-

4  tpb+

5  tpa-

6  tpa+

Microphone Connector (1/8 inch) Pin Signal

1 (Tip)
2 (Ring)
3 (Shield)

Audio
Power
Ground

Headphone Connector (1/8 inch) Pin Signal

1 (Tip)
2 (Ring)
3 (Shield)

Audio_Left
Audio_Right
Ground

Line-in Audio Connector (1/8 inch) Pin Signal

1 (Tip)
2 (Ring)
3 (Shield)

Audio_In_Left
Audio_In_Right
Ground
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Line-out Audio

Ultra SCSI

Line-out Audio Connector (1/8 inch) Pin Signal

1 (Tip)
2 (Ring)
3 (Shield)

Audio_Out_Left
Audio_Out_Right
Ground

Ultra SCSI connector

Pin Signal Pin Signal

1 +DB12 35 -DB12 

2 +DB13 36 -DB13 

3 +DB14 37 -DB14 

4 +DB15 38 -DB15 

5 +DPB1 39 -DPB1 

6 GND 40 GND 

7 +DB0 41 -DB0 

8 +DB1 42 -DB1 

9 +DB2 43 -DB2 

10 +DB3 44 -DB3 

11 +DB4 45 -DB4 

12 +DB5 46 -DB5 

13 +DB6 47 -DB6 

14 +DB7 48 -DB7 

15 +DPB 49 -DPB 

16 DIFFSENSE 50 GND 

17 TERMPWR 51 TERMPWR 

18 TERMPWR 52 TERMPWR 
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SATA

19 RES 53 RES 

20 +ATN 54 -ATN 

21 GND 55 GND 

22 +BSY 56 -BSY 

23 +ACK 57 -ACK 

24 +RST 58 -RST 

25 +MSG 59 -MSG 

26 +SEL 60 -SEL 

27 +C/D 61 -C/D 

28 +REQ 62 -REQ 

29 +I/O 63 -I/O 

30 GND 64 GND 

31 +DB8 65 -DB8 

32 +DB9 66 -DB9 

33 +DB10 67 -DB10 

34 +DB11 68 -DB11 

SATA Connector

Pin Signal Pin Signal Pin Signal

Data Cable Power Cable Power Cable

S-1 Ground P-1 3.3-V power P-8 5-V power

S-2* A+ P-2 3.3-V power P-9 5-V power

S-3* A- P-3 3.3-V power P-10 Ground

S-4 Ground P-4 Ground P-11 Reserved

S-5** B- P-5 Ground P-12 Ground

S-6** B+ P-6 Ground P-13 12-V power
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Monitor (VGA)

NOTE: Monitor connectors can vary depending on your configuration.

Monitor (DVI)

S-7 Ground P-7 5-V power P-14 12-V power

* S2 and S3 differential signal pair
**S5 and S6 differential signal pair

P-15 12-V power

VGA Connector 

Pin Signal Pin Signal Pin Signal

1
2
3

Red Analog
Green Analog
Blue Analog

6
7
8

Ground
Ground
Ground

11
12
13

Monitor ID
DDC Serial Data
Horizontal Sync

4
5

Monitor ID
Ground

9
10

+5V DC
Ground

14
15

Vertical Sync
DDC Serial Clock

DVI Connector

Pin Signal Pin Signal

1 T.M.D.S DATA 2- 16  HOT PLUG DETECT 

2 T.M.D.S DATA 2+ 17  T.M.D.S DATA 0- 

SATA Connector

Pin Signal Pin Signal Pin Signal

Data Cable Power Cable Power Cable
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ATA/ATAPI (IDE) Standard Drive Cable

3 T.M.D.S DATA 2/4 SHIELD 18  T.M.D.S DATA 0+ 

4 T.M.D.S DATA 4- 19 T.M.D.S DATA 0/5 SHIELD 

5 T.M.D.S DATA 4+ 2 0 T.M.D.S DATA 5- 

6 DDC CLOCK 21  T.M.D.S DATA 5+ 

7  DDC DATA 22  T.M.D.S CLOCK SHIELD 

8 ANALOG VERT. SYNC 23  T.M.D.S CLOCK+ 

9 T.M.D.S DATA 1- 24 T.M.D.S CLOCK- 

10  T.M.D.S DATA 1+     

11  T.M.D.S DATA 1/3 SHIELD C1 ANALOG RED

12  T.M.D.S DATA 3- C2 ANALOG GREEN

13 T.M.D.S DATA 3+ C3 ANALOG BLUE 

14  +5V POWER C4 ANALOG HORZ SYNC

15  GND C5 ANALOG GROUND 

ATA/ATAPI (IDE) Connector

Pin Signal Pin Signal Pin Signal

1
2
3
4
5

Reset
Ground
DD7
DD8
DD6

15
16
17
18
19

DD1
DD14
DD0
DD15
Ground

29
30
31
32
33

DMAK
Ground
INTRQ
IOCS16
DA1

6
7
8
9
10

DD9
DD5
DD10
DD4
DD11

20
21
22
23
24

(Key)
DMARQ
Ground
DIOW
Ground

34
35
36
37
38

PDIAG (cable detect)
DA0
DA2
CS1FX
CS3FX

11
12
13
14

DD3
DD12
DD2
DD13

25
26
27
28

DIOR
Ground
IORDY
CSEL

39
40

DASP
Ground
ATA/ATAPI (IDE) STANDARD DRIVE CABLE 171



24-Pin Power (Main)

6-Pin Power (Auxiliary System Board)

CAUTION Be sure you can differentiate which power cable connects to the PCI Express x16 graphics card 
and which power cable connects to the system board. These two cables look very similar. The PCI Express 
power cable has a black connector and the power cable has a white connector. When power is present, you 
must NEVER connect the PCI Express power cable to the system board. If you do so, the system board may 
be damaged and your warranty voided. To see a picture of the PCI Express cable and where it must be 
connected, refer to the “PCI or PCI Express Installation” section on page 91.

24-Pin Main Power Connector

1
2
3
4
5
6
7

+3.3 V
+3.3 V
GND
+5 V
GND
+5 V
GND

8
9
10
11
12
13

POK
+5 Vaux
+12 V-A
+12 V-A
+3.3 V
+3.3 V and 
+3.3V-Rsense

14
15
16
17
18
19
20

-12 V
GND
PS_ON_L
GND
GND
GND

21
22

23
24

+5 V
+5 V and
+5 V-Rsense
+5 V
GND

6-Pin Power (Auxiliary System Board) Connector Pin Color Signal

1 ORG +3.3V

2 ORG +3.3V

3 YEL +12V-A

4 BLK GND

5 BLK GND

6 YEL -12 V

1 12

13 24

4 6

31
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8-Pin Power (for Processors)
1

6-Pin Power (Auxiliary PCI Express)

CAUTION Be sure you can differentiate which power cable connects to the PCI Express x16 graphics card 
and which power cable connects to the system board. These two cables look very similar. The PCI Express 
power cable has a black connector and the power cable has a white connector. When power is present, you 
must NEVER connect the PCI Express power cable to the system board. If you do so, the system board may 
be damaged and your warranty voided. To see a picture of the PCI Express cable and where it must be 
connected, refer to the “PCI or PCI Express Installation” section on page 91.

NOTE The 6-pin power (auxiliary PCI Express) is only required with high-powered 
graphics cards.

8-Pin Power (for CPUs) Pin Color Signal

1 BLK GND

2 BLK GND

3 BLK GND

4 BLK GND

5 WHT +12VCPU0

WHT +12VCPU0 RSENSE

6 WHT +12VCPU0

7 WHT 
with 
stripe

+12VCPU1

8 WHT 
with 
stripe

+12VCPU1

6-Pin Power (Auxiliary PCI Express) Pin Color Signal

1 YEL +12V-B

2 YEL +12V-B

3 YEL +12V-B

4 BLK GND

5 8

41

4 6

31
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5 BLK GND

6 BLK GND

6-Pin Power (Auxiliary PCI Express) Pin Color Signal
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Appendix E System Board Designators

This appendix lists the system board designators for this system.

Table E-1 System Board Designators

Designators Silkscreen Component

N/A N/A Mounting holes

N/A N/A LED: 5V_AUX power indicator

D13 N/A Power LED

E14 N/A Boot block header/jumper

E49 N/A Clear password header/jumper

J20 SLOT3 PCI PCI slot

J21 SLOT4 PCI PCI slot

J22 SLOT5 PCI PCI slot

J23 SLOT2 PCI PCI slot

J31 SLOT6 PCI-E X8 PCI Express slot

J41 SLOT1 PCI-E X16 PCI Express x16 slot for graphics

J50 N/A Parallel port

J68 N/A Stacked keyboard/mouse connector

J9 N/A Stacked RJ45/Dual USB

J10 N/A Quad stacked USB

J83 N/A Triple stacked audio jack

J87 N/A Reset header

P1 N/A Power supply connector (24 pin)

P2 N/A Second power supply connector

P3 N/A Processor 12V header

P10 FDD Diskette drive connector
175



P101 SEC Security board connector

P7 CD CD analog audio connector

P11 AUX Auxiliary audio connector

P124 SLND Hood lock header

P20 IDEP Primary IDE connector

P21 IDES Secondary IDE connector/Multi-bay 
Connector

P23 AUDFRNT Front panel audio header

P24 FRNT USB Front panel USB connector

P27 MBAY Multi-bay header

P29, J90 N/A HDD LED connector

P60 SATA0 Primary serial ATA (SATA) connector

P61 SATA1 Second serial ATA (SATA) connector

P5 FRNT-P Main power/HDD LED connector

P53 N/A Serial port

P70 CPU1FAN Primary CPU fan header 

P71 CPU2FAN Secondary CPU fan header

P8 RCHFAN1 Primary chassis fan header

P9 RCHFAN2 Secondary chassis fan header

SW50 N/A Clear CMOS switch/push button

XBT BAT Battery retainer

MMX1 DIMM1 Memory slot

MMX2 DIMM2 Memory slot

MMX3 DIMM3 Memory slot

MMX4 DIMM4 Memory slot

XU1 CPU1 Primary processor socket

XU2 CPU2 Secondary processor socket

XU15 N/A ROM socket

Table E-1 System Board Designators

Designators Silkscreen Component
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Appendix F Power Cord Set Requirements

The power cord set (flexible cord or wall plug) received with this product meets the requirements for use in the 
country where you purchased the equipment.

If you must obtain a power cord for a different country, you should purchase a power cord that is approved for use 
in that country.

The power cord must be rated for the product and for the voltage and current marked on the product’s electrical 
ratings label. The voltage and current rating of the cord should be greater than the voltage and current rating 
marked on the product. In addition, the diameter of the wire must be a minimum of 0.75 mm2 or 18 AWG, and the 
length of the cord must be between 6 feet (1.8 m) and 12 feet (3.6 m). If you have questions about the type of 
power cord to use, contact the HP authorized service provider.

A power cord should be routed so that it is not likely to be walked on or pinched by items placed on it or against it. 
Particular attention should be paid to the plug, electrical outlet, and the point where the cord exits from the product.
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Appendix G Routine Care

General Cleaning Safety Precautions
1 Never use solvents or flammable solutions to clean the workstation.

2 Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and then use the cloth 
on the component.

3 Always unplug the workstation when cleaning with liquids or damp cloths.

4 Always unplug the workstation before cleaning the keyboard, mouse, or air vents.

5 Disconnect the keyboard before cleaning it.

6 Wear safety glasses equipped with side shields when cleaning the keyboard.

Maximizing the Airflow
Keep your workstation in an area where the airflow to the front and rear of the system is not obstructed.

If possible, keep the unit off of surfaces where dust can gather.

Keep the back of the unit at least 6 inches away from a wall or other obstruction.

Keep the front of the unit clear of any obstruction that keeps air from entering the front of the system.

Remove any dust on the front panel (vent area) and the rear fans with a small vacuum, compressed 
air, dust rag.

Cleaning the Workstation Case
Follow previously stated safety precautions before cleaning the workstation.

To clean the workstation case:

To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

For stronger stains, use a mild dish-washing liquid diluted with water. Rinse well by wiping it with a cloth or swab 
dampened with clear water.

For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will evaporate quickly 
and not leave a residue.

After cleaning, always wipe the unit with a clean, lint-free cloth.

Occasionally clean the air vents on the workstation. Lint and other foreign matter can block the vents and limit 
the airflow.
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Cleaning the Keyboard
Follow all safety precautions stated earlier before cleaning the keyboard.

CAUTION Use safety glasses equipped with side shields before attempting to clean debris from under 
the keys. 

Visible debris underneath or between the keys can be removed by vacuuming or shaking.

Canned, pressurized air can be used to clean debris from under the keys. Caution should be used as too much 
air pressure can dislodge lubricants applied under the wide keys.

If you remove a key, use a specially designed key puller to prevent damage to the keys. This tool is available 
through many electronic supply outlets.

CAUTION Never remove a wide leveled key (like the space bar) from the keyboard. If these keys are 
improperly removed or installed, the keyboard might not function properly.

Cleaning under a key can be done with a swab moistened with isopropyl alcohol and squeezed out. Be careful 
not to wipe away lubricants necessary for proper key functions. Use tweezers to remove any fibers or dirt in 
confined areas. Allow the parts to air dry before reassembly.

Cleaning the Monitor
Follow all safety precautions stated earlier before cleaning the monitor.

To clean the monitor, wipe the monitor screen with a clean cloth moistened with water or with a towelette designed 
for cleaning monitors. Do not use sprays or aerosols directly on the screen; the liquid might seep into the housing 
and damage a component. Never use solvents or flammable liquids on the monitor.

Cleaning the Mouse
Follow all safety precautions stated earlier before cleaning the mouse.

To clean the mouse:

Clean the mouse ball by first removing the retaining plate and the ball from the housing. 

Pull out any debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.
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Appendix H Additional Password Security 
and Resetting CMOS

This workstation supports security password features, which can be established through the Computer Setup 
Utilities menu. These features are:

setup password

power-on password

When you establish only a setup password, the power-on password is required to access Computer Setup and any 
other information on the workstation. When you establish both passwords, only the setup password will give you 
access to Computer Setup.

When both passwords are set, the setup password can also be used in place of the power-on password as an 
override to log in to the workstation. This is a useful feature for a network administrator.

If you forget the password for the computer, there are two method for clearing that password so you can gain 
access to the information on the workstation.

resetting the password jumper

using the Clear CMOS button

CAUTION Pushing the CMOS button resets CMOS values to factory defaults and erases any customized 
information including passwords, asset numbers, and special settings. It is important to back up the 
workstation CMOS settings before resetting them in case they are needed later. To back up the CMOS 
settings, use Computer Setup and run the Save to Diskette option from the File menu.

Resetting the Password Jumper
To disable the power-on or setup password features and clear the power-on and setup passwords:

1 Shut down the operating system and then turn off the workstation and any external devices. Disconnect the 
power cord of the workstation and any external devices from the power outlets.

2 Disconnect the keyboard, monitor, and any other external devices that are connected to the workstation.

WARNING! To reduce the risk of personal injury from electrical shock and hot surfaces, be sure to 
disconnect the power cord from the wall outlet and allow the internal system components to cool before 
touching.
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CAUTION When the workstation is plugged in, the power supply always has voltage applied to the 
system board even when the unit is turned off. Failure to disconnect the power cord can result in damage 
to the system.

CAUTION Static electricity can damage the electronic components of the workstation or optional 
equipment. Before beginning these procedures, be sure that you are discharged of static electricity by 
briefly touching a grounded metal object.

3 Remove the access panel.

4 Locate the password header and jumper. The password header is E49.

NOTE The password jumper is green so that it can be easily identified. For assistance locating the 
password jumper and other system board components, refer to “System Board Components” on page 69.

5 Remove the jumper from either pin 1 or 2. Place the jumper on pins 1 and 2 (connecting both pins together).

6 Replace the access panel.

7 Reconnect the external equipment.

8 Plug in the workstation and turn on the power. Allow the operating system to start. This clears the current 
passwords and disables the password features.

9 To establish new passwords, repeat steps 1 through 4, replace the password jumper on either pin 1 or pin 2 (but 
not both), then repeat steps 6 through 8. Establish the new passwords in Computer Setup.

Clearing and Resetting the CMOS
The CMOS of the workstation stores password information and information about the workstation configuration. 
This section describes the steps to successfully clear and reset the CMOS.

Using the CMOS Button
1 Shut down the operating system and then turn off the workstation and any external devices. Disconnect the 

power cord of the workstation and any external devices from the power outlets.

2 Disconnect the keyboard, monitor, and any other external devices that are connected to the workstation.

WARNING! To reduce the risk of personal injury from electrical shock and hot surfaces, be sure to 
disconnect the power cord from the wall outlet and allow the internal system components to cool before 
touching.

CAUTION When the workstation is plugged in, the power supply always has voltage applied to the 
system board even when the unit is turned off. Failure to disconnect the power cord can result in damage 
to the system.
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CAUTION Static electricity can damage the electronic components of the workstation or optional 
equipment. Before beginning these procedures, be sure that you are discharged of static electricity by 
briefly touching a grounded metal object.

3 Remove the access panel.

CAUTION Pushing the CMOS button resets CMOS values to factory defaults and erases any customized 
information including passwords, asset numbers, and special settings. It is important to back up the 
workstation CMOS settings before resetting them in case they are needed later. To back up the CMOS 
settings, use Computer Setup and run the Save to Diskette option from the File menu.

4 Locate, press, and hold the CMOS button in for five seconds.

NOTE Be sure that the AC power cord is disconnected from the power outlet. The CMOS button does not 
clear CMOS if the power cord is connected.

NOTE For assistance locating the CMOS button and other system board components, refer to “System 
Board Components” on page 69.

5 Replace the access panel.

6 Reconnect any external devices.

7 Plug in the workstation power and turn the power back on.

NOTE The workstation passwords and any special configurations along with the system date and time will 
have to be reset.

Using Computer Setup to Reset CMOS
To reset CMOS using Computer Setup, access the Computer Setup Utilities menu. When the Computer Setup 
message appears in the lower-right corner of the screen, press the F10 key. Press Enter to bypass the title screen, 
if necessary.

NOTE If you do not press the F10 key while the message is displayed, the workstation must be turned off, 
then on again, to access the utility.

From the Computer Setup menu, select File>Set Defaults and Exit. This restores the soft settings that include 
boot sequence order and other factory settings. It does not, however, force hardware rediscovery.

NOTE The workstation passwords and any special configurations along with the system date and time will 
have to be reset.
USING THE CMOS BUTTON 183



184 ADDITIONAL PASSWORD SECURITY AND RESETTING CMOS



 A
pp

en
di

x 
I

Appendix I Quick Troubleshooting Flows

This appendix presents some quick troubleshooting flowcharts for some common issues.

NOTE The flowcharts presented here are for general troubleshooting purposes only and they might not 
apply to your specific workstation.

“Initial Troubleshooting”

“No Power”

“No Video”

“Error Messages”

“No OS Loading”

“No OS Loading from Hard Drive”

“No OS Loading from Diskette Drive”

“No OS Loading from CD-ROM Drive”

“No OS Loading from Network”

“Non-functioning Device”
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No Power

No Power, Part 1
NO POWER 187



No Power, Part 2
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No Power, Part 3
NO POWER 189



No Video

No Video, Part 1
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No Video, Part 2
NO VIDEO 191



No Video, Part 3
192 QUICK TROUBLESHOOTING FLOWS



 A
pp

en
di

x 
I

Error Messages

Error Messages, Part 1 
ERROR MESSAGES 193



Error Messages, Part 2
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Error Messages, Part 3
ERROR MESSAGES 195



No OS Loading
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No OS Loading from Hard Drive

No OS Loading from Hard Drive, Part 1
NO OS LOADING FROM HARD DRIVE 197



No OS Loading from Hard Drive, Part 2
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No OS Loading from Hard Drive, Part 3
NO OS LOADING FROM HARD DRIVE 199



No OS Loading from Diskette Drive
200 QUICK TROUBLESHOOTING FLOWS



 A
pp

en
di

x 
I

No OS Loading from CD-ROM Drive
NO OS LOADING FROM CD-ROM DRIVE 201



No OS Loading from Network
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Non-functioning Device
NON-FUNCTIONING DEVICE 203
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